HIGHER SECONDARY SECOND YEAR

COMPUTER APPLICATIONS
Theory & Practical

A Publication Under Free Textbook Programme of Government of Tamil Nadu

DEPARTMENT OF SCHOOL EDUCATION

UNTOUCHABILITY IS INHUMAN AND A CRIME
Human civilization achieved the highest peak with the development of computer known as “Computer era”. Literate are those who have the knowledge in using the computer whereas others are considered illiterate inspite of the other degrees obtained. The growth of the nation at present lies in the hands of the youth, hence the content of this book is prepared in such a way so as to attain utmost knowledge considering the future needs of the youth.
HOW TO USE THE BOOK

- Learning Objectives: Learning objectives briefly describe the contents of the unit. It also outlines the knowledge gained by the students.
- Infographics: Visual representations of the unit for better understanding.
- Concept Figures: Conceptual diagrams that portray the technique of drafting and sewing.
- Activity: Skill oriented activities based on the units for better understanding.
- Evaluation: Access students under the category of understanding, reproducing and application oriented.
- Glossary: Explanation of significant terms.
- Model Question Paper: A model question paper to help students to face examinations.
- References: List of related books for further reading.
- Career Guidance: List of job opportunities on successful completion of course.

Interesting facts to motivate students to gain more information regarding the unit.
## **CAREER GUIDANCE**

### **COURSES**

<table>
<thead>
<tr>
<th>Courses</th>
<th>Colleges/Universities</th>
<th>Profession</th>
</tr>
</thead>
<tbody>
<tr>
<td>B.E / B.Tech</td>
<td>All University and their affiliated Colleges and Self financing Colleges in India and Abroad.</td>
<td>Software Engineer, Hardware Engineer, Software Development, Healthcare Section, IT &amp; ITes</td>
</tr>
<tr>
<td><strong>Science and Humanities</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B.Sc (Computer Science) BCA B.Sc ( Maths, Physics, Chemistry, Bio-Chemistry, Geography, journalism, Library Sciences, Political Science, Travel and Tourism)</td>
<td>All University and their affiliated Colleges and Self financing Colleges in India and Abroad.</td>
<td>Government Job and Private Company BPO, Geologist, Journalist</td>
</tr>
<tr>
<td><strong>Law</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LLB B.A+LLB B.Com BBM+LLB BBA+LLB</td>
<td>All University and their affiliated Colleges and Self financing Colleges in India and Abroad.</td>
<td>Lawyer, Legal Officer, Govt Job</td>
</tr>
<tr>
<td>CA CA-Chartered Accountant CMA-Cost Management Accountant. CS-Company Secretary (Foundation)</td>
<td>The Institute of Chartered Accountant of India (ICAI)</td>
<td>CA, Private Organization, Government, Banking sectors and prospects for self – employment.</td>
</tr>
<tr>
<td>Diploma</td>
<td>Government Polytechnic and Selffinancing colleges</td>
<td>Junior Engineer (Government and Private)</td>
</tr>
<tr>
<td><strong>Business Courses</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>COURSES</td>
<td>COLLEGES/ UNIVERSITIES</td>
<td>PROFESSION</td>
</tr>
<tr>
<td>-------------------------</td>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Commerce Courses (Con’t)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Certified Financial Analyst, Certified Financial Planner, Certified Investment Banker</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Management Courses</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Business Management</td>
<td>All University and their affiliated Colleges and Self financing Colleges in India and Abroad.</td>
<td>Private Organization, Government, Banking sectors and prospects for self – employment.</td>
</tr>
<tr>
<td>Bank Management</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Event Management</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hospital Management</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Human Resource Management</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Logistics Management</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Science and Humanities</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B.Sc. Botany</td>
<td>All University and their affiliated Colleges and Self financing Colleges in India and Abroad.</td>
<td>Government Job and Private Company BPO, Geologist, Journalist</td>
</tr>
<tr>
<td>B.Sc. Zoology</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B.Sc. Dietician &amp; Nutritionist</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B.Sc. Home Science</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B.Sc. Food Technology</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B.Sc. Dairy Technology</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B.Sc. Hotel Management</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B.Sc. Fashion Design</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B.Sc. Mass Communication</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B.Sc. Multimedia</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B.Sc. - 3D Animation</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1.1 Introduction to Multimedia

Multimedia allows the users to combine and change data from various sources like image, text, graphics, video, audio and video to a single platform. Multimedia has become the latest enriching experience in the field of information sector. The fast growing of multimedia technology over the last decade has brought a lot of changes to computing, entertainment and education.

The phenomenal growth of multimedia technologies and applications has presented the computerized field with great challenges and opportunities. Multimedia is becoming more popular among the user in the terms of its uses and applications. Multimedia application plays vital role in terms of presenting information to the users.

1.2 Multimedia Definition

The word multimedia consists of two words “multi” and “media” which means that multiple forms of media are combined to gather and provide services like storage,
communication, presentation and Input/Output interactions of text, video, image, graphics and audio.

The term multimedia comprises of two words, “multi” and “medium”. Multi refers to many i.e. at least two. Media is the plural of medium. Therefore multimedia is an integration of many types of media like text, graphics, images, audio, animation, video etc on a single medium in the same information unit.

### 1.3 Components of Multimedia

Multimedia has five major components like text, images, sound, video and animation. They are explained in detail below:

#### 1.3.1 Text

Text is the basic components of multimedia and most common ways of communicating information to other person. Even though multimedia includes images, video, audio and graphics, Text is the basic components used in multimedia.

**Static Text**

Static text, the text or the words will remain static as a heading or in a line, or in a paragraph. The words are given along with the images to explain about the images. In static text the words will either give information or support an image or a video.

**Hypertext**

A hypertext is a system which consists of nodes, the text and the links between the nodes, which defines the paths the user need to follow for the text access in non-sequential ways. The author of the working system created this structure. The user is permitted to define their own paths in more sophisticated hypertext systems. The user is provided with the flexibility and choice to navigate in hypertext. In a multimedia product Text is used to convey the information and must be placed at appropriate position in order to obtain the well-formatted sentences and paragraphs. The readability of the text depends on the spacing and punctuation. The message communication is more appropriate with improved Fonts and styles.
1.3.2 Image

Images act as a vital component in multimedia. These images are generated by the computer in two ways, as bitmap or raster images and as vector images.

Raster or Bitmap Images

The common and comprehensive form of storing images in a computer is raster or bitmap image. Bitmap is a simple matrix of the tiny dots called pixel that forms a raster or bitmap image. Each pixel consists of two or more colors. Based on how much data, in bits is used to determine the number of colors, the color depth is determined. E.g. one bit is two colors, four bits means sixteen colors, eight bits indicates 256 colors, and so on.

Vector Images

Drawing elements or objects such as lines, rectangles, circles and so on to create an image are based on Vector images. The advantage of vector image is relatively small amount of data is required to represent the image and thereby only less memory is needed to store. Compression techniques are used to reduce the file size of images that is useful for storing large number of images and speeding transmission for networked application. Various Compression formats used for this purpose are GIF, TIFF and JPEG.

1.3.3 Animation

Animation is the process displaying still images so quickly so that they give the impression of continuous movement. In animation the screen object is a vector image in animation. Using numerical transformations the movement of that image along its paths is calculated for their defining coordinates. The least frame rate of at least 16 frames per second gives the impression of smoothness and for natural looking it should be at least 25 frames per second. Animations may be in two or three dimensional. The two dimensional animation, bring an image alive, that occurs.
on the flat X and Y axis of the screen. While in three-dimensional animation it occurs along the three axes X, Y and Z. Animation tools are very powerful and effective. The two basic types of animations are Path animation and Frame animation.

**Path Animation**
Path animation involves moving an object on a screen that has a constant background e.g. a cartoon character may move across the screen regardless of any change in the background or the character.

**Frame Animation**
In frame animations, multiple objects are allowed to travel simultaneously and the background or the objects also changes.

### 1.3.4 Sound
Sound is a meaningful speech in any language and is the most serious element in multimedia, providing the pleasure of music, special effects and so on. Decibels is the measurement of volume, the pressure level of sound.

**Musical Instrument Digital Identifier (MIDI)**
Musical Instrument Digital Identifier (MIDI) is a standard communication tool developed for computers and electronic instruments. This tool is flexible and easy for composing the projects in multimedia. Tools for synthesizing the sound and software for sequencing are necessary for MIDI.

**Digital Audio**
Sampled sound is a Digitized sound. A sample of sound is taken and stored every n\textsuperscript{th} fraction of a second as digital information in bits and bytes. The quality of this recording depends on the sampling rate. Sampling rate is defined as how often the samples are taken and how many numbers are used to represent the value of each sample (bit depth, resolution and sample size). The finer the quality of the captured sound and the resolution is achieved while played back, when more often the sample is taken and the more data is stored about that sample.

### 1.3.5 Video
Video is defined as the display of recorded event, scene etc. The powerful way to convey information in multimedia applications are embedding of video. The video can be categorized in two types as Analog video and Digital video.

**Analog Video**
In Analog video, the video data’s are stored in any non-computer media like video tape, laserdisc, film etc. It is divided further in two types as Composite and Component Analogue Video. Composite Analog Video has all the video components...
like brightness, color, and synchronization combined into one signal. Due to the combining of the video components, the quality of the composite video resulted in color blending, low clarity and high generational loss. This recording format was used for customer analog video recording tape formats such as Betamax and VHS.

1.4 File Formats for Multimedia

The following is an outline of current file formats used for the production and delivery of multimedia data.

1.4.1 Text Formats

RTF
Rich Text Format is the primary file format introduced in 1987 by Microsoft with the specification of their published products and for cross-platform documents interchange.

Plain text
Plain text files can be opened, read, and edited with most text editors. commonly used are Notepad (Windows), Gedit or nano (Unix, Linux), TextEdit (Mac OS X) and so on. Other computer programs are also capable of reading and importing plain text. Plain text is the original and popular way of conveying an e-mail.

1.4.2 Image Formats

TIFF (Tagged Image File Format)
This format is common in desktop publishing world (high quality output), and is supported by almost all software packages. Recent versions of TIFF allows image compression, and the format is comfortable for moving large files between computers.

BMP (Bitmap)
Initially this format is in use with Windows 3.1. It is quite large and uncompressed and hence BMP is used for the high-resolution or large images.

DIB (Device Independent Bitmap)
This format which is similar to BMP, allows the files to be displayed on a variety of devices.

GIF (Graphics Interchange Format)
GIF is a compressed image format. Most of the computer color images and backgrounds are GIF files. This file format is best suitable for graphics that uses only limited colors, and it is the most popular format used for online color photos. 13-bit Color look up table is used by the GIF format to identify its color values. This format is supported widely.

JPEG (Joint Photographic Experts Group)
JPEG was designed to attain maximum image compression. It uses lossy compression technique, where a compression method is referred that loses some of the data required for the image reconstruction. It works good with photographs, naturalistic artwork, and similar material but functions less on lettering, live drawings or simple cartoons.

TGA (Tagra)
It is the first popular format for high-resolution images. TGA is supported by Most of the video-capture boards.
PNG (Portable Network Graphics)
An extensible file format for the less loss, portable and well compressed storage of raster images. PNG acts as replacement for GIF and also replaces multiple common uses of TIFF. PNG works good with online viewing applications like worldwide web. so it is fully streamable with a best display option.

WAV (Waveform Audio File Format)
It is the most popular audio file format in windows for storing uncompressed sound files. In order to attain the reduced file size it can also be converted to other file formats like MP3.

MP3 (MPEG Layer-3 Format)
MPEG Layer-3 format is the most popular format for storing and downloading music. The MP3 files are roughly compressed to one-tenth the size of an equivalent WAV file.

OGG
A free, open source container format that is designed for obtaining better streaming and evolving at high end quality digital multimedia. It can be compared to MP3 files in terms of quality.

AIFF (Audio Interchange File Format)
A standard audio file format used by Apple which is like a WAV file for the Mac.

WMA (Windows Media Audio)
It is a popular windows media audio format owned by Microsoft and designed with Digital Right Management (DRM) abilities for copyright protection.

RA (Real Audio Format)
Real Audio format is designed for streaming audio over the Internet. The digital audio resources are usually stored as a computer file in computer’s hard drive or CD/DVD. Besides the variety of audio file formats available, the most common formats are wave files (.WAV) and MPEG Layer-3 files (.MP3), WMA and RA.

AVI (Audio/Video Interleave)
AVI is the video file format for Windows. Here sound and picture elements are stored in alternate interleaved chunks in the file.

MPEG (Moving Picture Experts Group)
MPEG is a standard for generating digital video and audio compression under the
International Standards Organization (ISO) by the group of people. The group has developed MPEG-1, the standard on which Video CD and MP3 are based, MPEG-2, the standard that supports products as Digital Television set top boxes and DVD, MPEG-4, the standard for multimedia and mobile web. MPEG-7, the standard for search of audio and visual content. Research on MPEG-21 “Multimedia Framework” has started in 2000. Simply MPEG is the standards for digital video and audio compression.

1. **Conceptual Analysis and Planning**
   The process of multimedia making begins with a conceptual ignition point. Conceptual analysis identifies a appropriate theme, budget and content availability on that selected theme. Additional criteria like copyright issues also are considered in this phase.

2. **Project design**
   Once the theme is finalized objectives, goals, and activities are drawn for the multimedia project. General statements are termed as goals. The specific statements in the project is known as the objectives. Activities are series of actions performed to implement an objective. These activities contribute to the Project design phase.

3. **Pre-production**
   Based on the planning and design, it is necessary to develop the project. The following are the steps involved in pre-production:

4. **Budgeting**
   Budgeting for each phases like consultants, hardware, software, travel, communication and publishing is estimated for all the multimedia projects.

5. **Multimedia Production Team**
   The production team for a high-end multimedia project requires a team efforts. The team comprises of members playing various roles and responsibilities like Script writer, Production manager, Editor, Graphics Architect, Multimedia Architect and Web Master.

---

**Figure: 1.11 Digital Video File Formats**

### 1.5 Multimedia Production

#### 1.5.1 Steps in Multimedia Production

Adequate time and efficient planning is required for multimedia production, which assures that the project will be proceed smoothly and certainly ensures that the information reaches the target audience. Following are the phases for development of complex multimedia projects.
6. **Hardware/Software Selection**
All multimedia Application requires appropriate tools to develop and playback the application. Hardware includes the selection of fastest CPU, RAM and huge monitors, sufficient disc for storing the records. Selection of the suitable software and file formats depends on the funds available for the project being developed.

7. **Defining the Content**
Content is the “stuff” provided by content specialist to the multimedia architect with which the application is developed, who prepares the narration, bullets, charts and tables etc.

8. **Preparing the structure**
A detailed structure must have information about all the steps along with the timeline of the future action. This structure defines the activities, responsible person for each activity and the start/end time for each activity.

9. **Production**
In the multimedia application, after the pre-production activities, the production phase starts. This phase includes the activities like background music selection, sound recording and so on. Text is incorporated using OCR software, Pictures shot by digital camera, Video clips are shot, edited and compressed. A pilot project is ready by this time.

10. **Testing**
The complete testing of the pilot product is done before the mass production to ensure that everything is in place, thereby avoiding the failure after launch. If it’s an web based product,
its functioning is tested with different browsers like Internet Explorer, Chrome, Mozilla and Netscape Navigator. If it is a local multimedia application on a LAN it must be deployed in the server for testing purpose. After the testing process are over, the product is incorporated with valid suggested changes.

11. Documentation
User documentation is a mandatory feature of all multimedia projects. The documentation has all the valuable information's starting from the system requirement till the completion of testing. Contact details, e-mail address and phone numbers are provided for technical support and sending suggestions and comments.

12. Delivering the Multimedia Product
Multimedia applications are best delivered on CD/DVD or in the website. In reality various challenges are faced while delivering through internet, like bandwidth problems, huge number of plug-ins required to play audio and video and long downloading time. Finally, a multimedia application is delivered in a more effective way by the integration of two mediums CD-ROM/DVD and Internet.

1.5.2 Multimedia Production Team
Managing team members in a way to get maximum outcome with high degree of efficiency is mandatory in multimedia production. The fine quality high-end multimedia production application requires a specialize team comprises of the following members:

1. **Production Manager**
   In a multimedia production, the role of production manager is to define, and coordinate, the production of the multimedia project in time and with full quality. The production manager should be an expertise in the technology expert, good at proposal writing, good communication skills and budget management skills. Also must have experience in human resource management and act as an efficient team leader.

2. **Content Specialist**
   Content specialist is responsible for performing all research activities concerned with the proposed application's content. Program content refers to projects information, graphics, data or facts presented through the multimedia production.

3. **Script Writer**
   Video and film scripts represents a linear sequence of events. The script writer visualizes the concepts in three dimensional environments and if needed uses the virtual reality integration into the program.

4. **Text Editor**
   The content of a multimedia production always must flow logically and the text should always be structured and correct grammatically. Text and narration is an integrated part of the application.
5. **Multimedia Architect**

The multimedia architect integrates all the multimedia building blocks like graphics, text, audio, music, video, photos and animation by using an authoring software.

6. **Computer Graphic Artist**

The role of Computer Graphic Artist is to deal with the graphic elements of the programs like backgrounds, bullets, buttons, pictures editing, 3-D objects, animation, and logos etc.

7. **Audio and Video Specialist**

The roles of these specialists are needed for dealing with narration and digitized videos to be added in a multimedia presentation. They are responsible for recording, editing sound effects and digitizing.

8. **Computer Programmer**

The computer programmer writes the lines of code or scripts in the appropriate language. These scripts usually develops special functions like developing the software to give the size and shape of video windows, controlling peripherals and so on.

9. **Web Master**

The responsibility of the web master is to create and maintain an Internet web page. They converts a multimedia presentation into a web page. Final multimedia product is ready for consultation is a joint effort of the entire team. Initially, the production manager identifies the project content, while the web master provides access to a wide range of community through web-services.

1.6 **Multimedia on Internet**

Major applications have been developed with the integration of internet and multimedia like maps, media rich blogs etc. A comprehensive study on use of internet and multimedia in USA says that an estimated 55 million consumers use Internet radio and video services each month. Image is the most widely used multimedia resource on internet. Social networking sites like Facebook (www.facebook.com) also enables multimedia rich contents to be exchanged online.
1.7 Applications of Multimedia

Multimedia is the most fast growing area in the field of information technology. A Multimedia is an application which has in its use collection of multiple media sources like text, images, sound/audio, animation and video on a single platform. Predominantly, Entertainment and Education are the fields where multimedia is used in majority.

1. Education

Multimedia plays an vital role in offering an excellent alternative method to traditional teaching by allowing the students to explore and learn various concepts through animation. Students, teachers and the parents enjoy this multimedia mode of learning and multimedia learning materials. Many educators accepts multimedia introduces new ways of thinking in the classroom. Multimedia based teaching and learning system named as MODULO at GMU in Germany developed is a web-based environment that aims to provide students with flexible and decentralized learning environment based on their educational background.

In India, multimedia is used in different ways for teaching and learning like e-learning, distance learning, virtual learning and so on. EDUSAT (Education Satellite) is launched in India for serving the educational sector of the country for emulating virtual classroom in an effective manner.

2. Entertainment

The remarkable advancement in the entertainment industry is due to the Multimedia Technology mainly. This technology is needed in all mode of entertainment like radio, TV, online gaming, video on demand etc.

Video on demand or movies on demand is a service that provides movies to television sets on an individual basis at homes. Movies are stored in a central server and transmitted through a communication network. A
set-top box connected to the communication network converts the digital information to analog signals and inputs it to the television set.

3. **Business Systems**
Business applications for multimedia include presentations, training, internet protocols and so on. The marketing and advertising agencies are using animation techniques for sales promotion. Multimedia is used very commonly for building employee ID. High resolution projectors are common for multimedia presentations on the road. Cell phones and personal digital assistants with Bluetooth and Wi-Fi communication technology makes multimedia communication for business more efficiently.

4. **Medical Services**
Medical services are grown drastically with the development of multimedia. Medical Students practices surgery methods via simulation prior to actual surgery. Tiny digital cameras are inserted in human body and it displays the inner scene of the body. In this way the medical practitioners were able to see the inner part without dissecting it.

5. **Public Places**
Multimedia is available in many public places like trade shows, libraries, railway stations, museums, malls, airports, banks, hotels and exhibitions in the form of kiosks. It provides information to the customers and helps them. The information presented in kiosk are enriched with animation, video, still pictures, graphics, diagrams, maps, audio and text. Banks uses kiosks in the form of ATM machines.

6. **Multimedia Conferencing**
Multimedia conferencing or video-conferencing is a system that performs face-to-face interactions among participating users, located far from each other, as if they were sitting and discussing in a single room.

1.8 **Libraries, Information Centers and Archives**
The primary function of library is to organize, collect, preserve, and disseminate information to users. Several techniques and technologies are in use for handling the information more effectively. Multimedia technology is adopted by the libraries in various functions like multimedia kiosks, user orientation programs etc. Following is the brief account of multimedia technology applications in libraries.

1. **Multimedia Kiosk**
Kiosk is a free-standing furnished equipped multimedia computer that allow users to retrieve information via a touch screen. It is commonly used in airports and other public locations to provide directions and few mandatory information’s. In an library, Kiosk is usually located near the entrance of the library, used for displaying announcements, reading lists, comments and suggestions from library users and other information’s about operations and programs of the library.
2. **Webcasting and Video Conferencing**

The live telecast of real time programs through internet is known as Webcasting. Video conferencing is the process of conducting conference between more than two participants at different sites by using computer networks to transmit audio and video data.

3. **User Orientation Program**

The role of multimedia plays an vital role in training the librarians in schools, colleges and universities due to its interactivity. Hence, it is used in depth subject training to their faculties.

4. **In-house Production of Multimedia Resources and E-publishing**

Many libraries produce multimedia resources in-house, to serve the parent organization. Introduction of CD/DVD and their writers has solved few of the problems of libraries in storing or achieving the materials. Multimedia tools along with CD-writers is made possible to publish information from different sources in a most easy to use and acceptable form to library users.

5. **Digital Multimedia Libraries**

Information's are available in digital formats that include digital books, scanned images, graphics and digitized audio-visual clips etc. Initially digital library projects were based only on textual data, later it was on all other media elements like images, audio and video recordings were also integrated under the collection of digital library.

---

**POINTS TO REMEMBER**

- Multimedia allows the users to combine and change data from various sources like image, text, graphics, video, audio and video to a single platform.
- Multimedia has five major components like text, images, sound, video and animation.
- Static text, the text or the words will remain static as a heading or in a line, or in a paragraph.
- A hypertext is a system which consists of nodes, the text and the links between the nodes, which defines the paths the user need to follow for the text access in non-sequential ways.
- Images acts as an vital component in multimedia. These images are generated by the computer in two ways, as bitmap or raster images and as vector images.
- Animation is the process displaying still images so quickly so that they give the impression of continuous movement. In animation the screen object is a vector image in animation.
- Sound is a meaningful speech in any language and is the most serious element in multimedia, providing the pleasure of music, special effects and so on.
- Musical Instrument Digital Identifier (MIDI) is a standard communication tool developed for computers and electronic instruments.
- Video can be categorized in two types as Analog video and Digital video.
Multimedia | Multimedia allows the users to combine and change data from various sources like image, text, graphics, video, audio and video to a single platform.

Raster or Bitmap Images | The common and comprehensive form of storing images in a computer is raster or bitmap image.

Vector Images | I is relatively small amount of data is required to represent the image and thereby only less memory is needed to store.

Animation | Animation is the process displaying still images so quickly so that they give the impression of continuous movement. In animation the screen object is a vector image in animation.

Path Animation | Path animation involves moving an object on a screen that has a constant background e.g. a cartoon character may move across the screen regardless of any change in the background or the character.

Musical Instrument Digital Identifier (MIDI) | Musical Instrument Digital Identifier (MIDI) is a standard communication tool developed for computers and electronic instruments.
Part - I
Choose the correct answer

1. ________ refers to any type of application that involves more than one type of media such as text, graphics video animation and sound
   a) an executable file
   b) desktop publishing
   c) multimedia
   d) hypertext

2. one of the disadvantages of the multimedia is its __
   a) cost
   b) adaptability
   c) usability
   d) relativity

3. expand JPEG
   a) joint photo experts gross
   b) joint photographic experts group
   c) joint processor experts group
   d) joint photographic expression group

4. you need hardware, software and __ to make multimedia
   a) network
   b) compact disk drive
   c) good idea
   d) programming knowledge

5. match the following by choosing the right one
   1. Text – TGA
   2. Image – MIDI
   3. Sound – MPEG
   4. Video – RTF
   a. 1, 2, 3, 4       b. 2, 3, 4, 1
   c. 4, 1, 2, 3       d. 3, 4, 1, 2

6. find the odd one on the following which is not an image format
   a) TIFF  b) BMP
   c) RTF  d) JPEG

7. ___ is the process displaying still images they give continuous movement
   a) Text formats
   b) Sound
   c) MP3
   d) Animation

8. The live telecasting of real time program through Internet is known as ____
   a) web casting
   b) web hosting
   c) data manipulation
   d) none of the above

9. GIF use _______ color look up table
   a) 8 bit
   b) 8 KB
   c) 8 MB
   d) 8 GB

10. RTF file format was introduced by _____
    a) TCS
    b) Microsoft
    c) Apple
    d) IBM
Part - II

Short Answers
1. Define Multimedia and their features
2. List out Multimedia Components
3. Classify the TEXT component in multimedia
4. Classify the IMAGE component in multimedia
5. Define Animation and their features
6. List out image file formats
7. List out audio file formats
8. List out video file formats
9. Define Multimedia Production
10. List out Multimedia Production team members

Part - III

Explain in Brief Answer
1. Briefly explain about Multimedia Components
2. Describe the features and techniques of animation
3. Write roles and responsibilities of Production team members
4. Describe the various file formats in multimedia
5. Explain animation industry and their scope

Part - IV

Explain in detail
1. Explain in detail Process of Multimedia
2. Explain in detail Techniques of Animation
3. Explore the opportunities Animation filed movie industry
4. Explain in detail about production team Roles and Responsibilities
5. Explain about different file formats in multimedia files
2.1 Desktop Publishing

We hear and see the term ‘Desktop publishing’ a lot these days. What exactly is it? What does it mean? Desktop publishing (abbreviated DTP) is the creation of page layouts for documents using DTP software.

Today, there are several Desktop Publishing (DTP) software available in the market. Some of the popular DTP software are Adobe PageMaker, Adobe InDesign, QuarkXPress, etc.

2.2 Introduction to Adobe PageMaker

Adobe PageMaker is a page layout software. It is used to design and produce documents that can be printed. You can create anything from a simple business card to a large book.

Page layout software includes tools that allow you to easily position text and graphics on document pages. For example, using PageMaker, you could create a newsletter that includes articles and pictures on each page. You can place
2.4 Creating a New Document

To create a new document,

1. Choose File > New in the menu bar. (or) Press Ctrl + N in the keyboard. Now Document Setup dialog box appears. (Figure 2.3)

2. Enter the appropriate settings for your new document in the Document Setup dialog box.

3. Click on OK.
Now a new document called **Untitled - 1** opens on the screen as shown in Figure 2.4.

A document page is displayed within a dark border. The area outside of the dark border is referred to as the pasteboard. Anything that is placed completely in the pasteboard is not visible when you print the document. You can use the pasteboard to temporarily hold elements while designing your document.

![Figure 2.3 Creating a New Document](image1)

![Figure 2.4 Workspace](image2)
The main components of the above window are Title bar, Menu bar, Toolbar, Ruler, Scroll bars and Text area. Let us have a look at these components.

**Title bar**

![Figure 2.5 Title bar](image)

It is the topmost part of the window. It shows the name of the software and the name of the document at the left, and the control buttons (Minimize, Maximize and Close) at the right.

In Figure 2.5 we can see the name of the software (Adobe PageMaker 7.0) at the left. It is followed by the default name of the document (Untitled-1) which can be changed when we save the document with a user-supplied name.

We know that on clicking the Minimize button the document window is minimised to a small icon and kept in the task bar, Maximise button is used for maximising the current document window to fit the whole screen area, and the Close button closes the software itself.

**Menu bar**

![Figure 2.6 Menu bar](image)

It contains the following menus File, Edit, Layout, Type, Element, Utilities, View, Window, Help. When you click on a menu item, a pulldown menu appears. There may be sub-menus under certain options in the pull-down menus. Refer Figure 2.6

**Toolbar**

If you place the mouse pointer on a button in the Toolbar, a short text will appear as its description called ‘**Tool Tip**’. Refer Figure 2.7

![Figure 2.7 Toolbar](image)

**Toolbox**

The Figure 2.8 shows the PageMaker toolbox.

To move the toolbox, drag the toolbox by its **title bar**. Select a tool from the default toolbox by clicking it.

If the toolbox is not available on the screen, you can perform these steps to show the toolbox. The Keyboard shortcuts and Toolbox usages are shown in Table 2.1 & Table 2.2
1. Click on **Window**. The Window menu will appear.

2. Click on **Show tools**.

   The toolbox appears in front of your document window. If you want to hide the toolbar, you can perform these steps to hide the toolbox.

1. Click on **Window**. The Window menu will appear.

2. Click on **Hide tools** to hide the toolbox.

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Tools</th>
<th>Keyboard Short Cut</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Pointer Tool</td>
<td>F9</td>
</tr>
<tr>
<td>2</td>
<td>Rotating Tool</td>
<td>Shift + F2</td>
</tr>
<tr>
<td>3</td>
<td>Line Tool</td>
<td>Shift + F3</td>
</tr>
<tr>
<td>4</td>
<td>Rectangle Tool</td>
<td>Shift + F4</td>
</tr>
<tr>
<td>5</td>
<td>Ellipse Tool</td>
<td>Shift + F5</td>
</tr>
<tr>
<td>6</td>
<td>Polygon Tool</td>
<td>Shift + F6</td>
</tr>
<tr>
<td>7</td>
<td>Hand Tool</td>
<td>Shift + Alt + Drag Left mouse button</td>
</tr>
<tr>
<td>8</td>
<td>Text Tool</td>
<td>Shift + Alt + F1</td>
</tr>
<tr>
<td>9</td>
<td>Cropping Tool</td>
<td>Shift + Alt + F2</td>
</tr>
<tr>
<td>10</td>
<td>Constrained Line Tool</td>
<td>Shift + Alt + F3</td>
</tr>
<tr>
<td>11</td>
<td>Rectangle Frame Tool</td>
<td>Shift + Alt + F4</td>
</tr>
<tr>
<td>Tool</td>
<td>Toolbox</td>
<td>Cursor</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------</td>
<td>--------</td>
</tr>
<tr>
<td>Pointer Tool</td>
<td><img src="image" alt="Pointer Tool" /></td>
<td><img src="image" alt="Pointer Tool Cursor" /></td>
</tr>
<tr>
<td>Text tool</td>
<td><img src="image" alt="Text Tool" /></td>
<td><img src="image" alt="Text Tool Cursor" /></td>
</tr>
<tr>
<td>Rotating tool</td>
<td><img src="image" alt="Rotating Tool" /></td>
<td><img src="image" alt="Rotating Tool Cursor" /></td>
</tr>
<tr>
<td>Cropping tool</td>
<td><img src="image" alt="Cropping Tool" /></td>
<td><img src="image" alt="Cropping Tool Cursor" /></td>
</tr>
<tr>
<td>Line tool</td>
<td><img src="image" alt="Line Tool" /></td>
<td><img src="image" alt="Line Tool Cursor" /></td>
</tr>
<tr>
<td>Constrained line tool</td>
<td><img src="image" alt="Constrained Line Tool" /></td>
<td><img src="image" alt="Constrained Line Tool Cursor" /></td>
</tr>
<tr>
<td>Rectangle tool</td>
<td><img src="image" alt="Rectangle Tool" /></td>
<td><img src="image" alt="Rectangle Tool Cursor" /></td>
</tr>
<tr>
<td>Rectangle frame tool</td>
<td><img src="image" alt="Rectangle Frame Tool" /></td>
<td><img src="image" alt="Rectangle Frame Tool Cursor" /></td>
</tr>
<tr>
<td>Ellipse tool</td>
<td><img src="image" alt="Ellipse Tool" /></td>
<td><img src="image" alt="Ellipse Tool Cursor" /></td>
</tr>
<tr>
<td>Ellipse frame tool</td>
<td><img src="image" alt="Ellipse Frame Tool" /></td>
<td><img src="image" alt="Ellipse Frame Tool Cursor" /></td>
</tr>
<tr>
<td>Polygon tool</td>
<td><img src="image" alt="Polygon Tool" /></td>
<td><img src="image" alt="Polygon Tool Cursor" /></td>
</tr>
<tr>
<td>Polygon frame tool</td>
<td><img src="image" alt="Polygon Frame Tool" /></td>
<td><img src="image" alt="Polygon Frame Tool Cursor" /></td>
</tr>
<tr>
<td>Hand tool</td>
<td><img src="image" alt="Hand Tool" /></td>
<td><img src="image" alt="Hand Tool Cursor" /></td>
</tr>
<tr>
<td>Zoom tool</td>
<td><img src="image" alt="Zoom Tool" /></td>
<td><img src="image" alt="Zoom Tool Cursor" /></td>
</tr>
</tbody>
</table>
Scroll bars
Scrolling is the process of moving up and down or left and right through the document window. There are two scrollbars namely Vertical and Horizontal scroll bars for scrolling the document vertically or horizontally.

Rulers
There are two ruler bars. One is at the top and the other is at the left side.

To show the ruler
1. Click on View. The View menu will appear.
2. Click on Show Rulers. Rulers appear along the top and left sides of the document window.

To hide the ruler
1. Click on View. The View menu will appear.
2. Click on Hide Rulers to hide the rulers.

2.5 Entering Text in the Document
In PageMaker the text of the document can be typed inside a text block. So, you must use the Text tool to create those text blocks. After creating a Text block, you can type the text directly into the text block. As the characters are typed, the flashing vertical bar called the insertion point, moves to the right. When the text being typed reaches the end of the text block, PageMaker will automatically wrap the text to the next line. The Enter key must not be pressed at the end of the each line in text block. The Enter key should be pressed only at the end of a paragraph or when a blank line is to be inserted.

2.6 Editing Text in the Document
Editing means making changes to the text. When you edit a document, you revise its text. Editing encompasses many tasks, such as inserting and deleting words and phrases, correcting errors, and moving and copying text to different places in the document.

2.6.1 Selecting Text
Text can be selected using the mouse or the keyboard.

Selecting Text using the mouse
To select text using a mouse, follow these steps:
1. Place the Insertion point to the left of the first character to be selected.
2. Press the left mouse button and drag the mouse to a position where you want to stop selecting.
3. Release the mouse button.
4. The selected text gets highlighted.

<table>
<thead>
<tr>
<th>To Select</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>A Word</td>
<td>Double-click with I-beam</td>
</tr>
<tr>
<td>A Paragraph</td>
<td>Triple-click with I-beam</td>
</tr>
</tbody>
</table>

Selecting Text using the Keyboard
To select text using a keyboard, follow these steps:
1. Place the Insertion point to the left of the first character you wish to select.
2. The Shift key is pressed down and the movement keys are used to highlight the required text.
3. When the Shift key is released, the text is selected.
2.6.2 Deleting Text
You can easily delete a character, or word, or block of text.

To delete a character, do the following:
1. Position the insertion point to the left of the character to be deleted.
2. Press Delete key on the keyboard.
   (or)
3. Position the insertion point to the right of the character to be deleted.
4. Press Backspace key on the keyboard.

To delete a block of text, do the following:
1. Select the text to be deleted.
2. Press Delete or Backspace in the keyboard (or) Edit > Clear command.

2.6.3 Undo Command
The Undo command is used to reverse the action of the last command. To reverse the last command, click on Edit>Undo in the menu bar (or) press Ctrl + Z in the keyboard.

2.6.4 Copying and Moving Text
The Copy and Paste commands of PageMaker can be used to copy text from one location in a document and paste it at another location. The Copy command creates a duplicate of the selected text, leaving the original text unchanged. The Paste command pastes the copied text at the position where the insertion point is placed.

The Cut and Paste commands can be used to move text from one position in a document to the other. The Cut command deletes the selected text from its original position. The Paste command then places this text at the position where the insertion point is placed.

Moving the Text
The selected text can be easily cut and pasted in the required location.

To cut and paste text:
1. Select the text to be moved.
2. Choose Edit > Cut in the menu bar.
   (or) Press Ctrl + X in the keyboard.
   (or) Click the right mouse button and choose cut from the pop-up menu.
3. Insertion point is moved to the place where the text is to be pasted.
   (or) Press Ctrl + V in the keyboard.
   (or) Click the right mouse button and choose Paste from the pop-up menu.

The text can also be pasted in this way to another or another type of document.

The following keyboard shortcuts can be used to move text
Ctrl + X \rightarrow to Cut
Ctrl + V \rightarrow to Paste
Copying the Text

The selected text can be easily copied and pasted in the required location.

To copy and paste text:

1. Select the text to be copied.

2. Choose **Edit > Copy** in the menu bar (or) Press **Ctrl + C** in the keyboard (or) Click the right mouse button and choose **Copy** from the pop-up menu.

3. Insertion point is moved to the place where the text is to be pasted.

4. Choose **Edit > Paste** in the menu bar (or) **Press Ctrl + V** in the keyboard (or) Click the right mouse button and choose **Paste** from the pop-up menu.

The text can also be pasted in this way to another location.

---

2.7 **Text Block**

A text block contains text you type, paste, or import. You can’t see the borders of a text block until you select it with the pointer tool.

You create text blocks in two ways:

1. Click or drag the text tool on the page or pasteboard, and then type.
2. Click a loaded text icon in an empty column or page.

2.7.1 **Creating a Text Block with the Text tool**

To create a text block with the text tool:

1. Select the text tool (T) from the toolbox. The pointer turns into an I-beam. Refer Figure 2.9
2. On an empty area of the page or pasteboard, do one of the following:
   Click the I-beam where you want to insert text. (Refer Figure 2.10) This creates a text block the width of the column or page. By default, the insertion point jumps to the left side of the text block.

![Figure 2.10](image)

3. Type the text you want.
   Unlike with a text frame, you do not see the borders of a text block until you click the text with the pointer tool. Refer 2.11

![Figure 2.11](image)
2.7.2 **Moving a Text Block**

To move a block without changing its shape, place the cursor anywhere inside the block, and click and drag it to the required position. Refer 2.12

![Figure 2.12 Moving a text block](image1)

2.7.3 **Resizing a Text Block**

When you select a text block with the Pointer tool, the block's boundaries become visible. Two handles are seen above and below the text block. These handles are called **Windowshades**. There is a dark square on both ends of the handle. These are used to change the size of the text block. Refer Figure 2.13 to Figure 2.15

![Figure 2.13 Resizing text block-Step 1](image2)
To resize a Text block

1. Click on the **Pointer tool**.
2. Click either the left or right corner handle on the bottom of the text block and drag. When you release the mouse button, the text in the text block will reflow to fit the new size of the text block.

![Figure 2.14 Resizing text block-Step 2](image1)

3. A red triangle in the bottom windowshade means there is more text in the text block than is visible on the page. Drag the windowshade handle down to show more text.

![Figure 2.15 Resizing text block-Step 3](image2)
2.7.4 **Splitting a Text Block into two**

To split a text block into two

1. Place the cursor on the bottom handle, click and drag upwards. When you release the bottom handle will contain a red triangle. Refer Figure 2.17-18

![Figure 2.16 Splitting a Text block–Step 1](image1)

2. Click once on this, and the cursor changes to a loaded text icon.

![Figure 2.17 Splitting a Text block–Step 2](image2)
3. Position this where the second part of the text is to be, and click.

![Figure 2.18 Splitting a Text block–Step 3](image)

### 2.7.5 Rejoining split blocks

To rejoin the two text blocks

1. Place the cursor on the bottom handle of the second text block, click and drag the bottom handle up to the top.

2. Then place the cursor on the bottom handle of the first text block, and click and drag the bottom handle down if necessary.

### 2.7.6 Placing (Importing) Text

You can insert text from other software program like MS-Word in the PageMaker documents. Refer Figure 2.19 to Figure 2.22

1. Choose **File > Place**. The **Place dialog box** will appear.

![Figure 2.19 Importing Text](image)
2. Locate the document that contains the text you want to place and select it.

3. Click on Open in the Place dialog box. The pointer changes to the loaded text icon ( ).

4. Make a text block to place the text. (Or) Click in the page to place the text. The text will be placed in the page.

If the text to be placed is too big to fit on one page, PageMaker allows you to place it on several pages. This can be done manually or automatically. 

**Manual text flow**

- Position the loaded text icon at a corner of the area where you want to place text, hold down the mouse button, and drag to define the text block. Release the mouse button.

- Text flows into the defined area. If there is more text than fits in the text block you defined, a red triangle appears in the bottom windowshade handle.
Figure 2.21  Load Text

- Click once on this and the loaded text icon reappears. Now generate a new text block and click. Repeat this process until there is no more text to place.

Figure 2.22  Continue loading text
Similarly if you want to place the text in a page, position the loaded text icon at the top of the page and click. Text flows into the page. If there is more text than fits in the page, a red triangle appears in the bottom windowshade handle.

Click once on this and the loaded text icon reappears. Now generate a new page (or pages) by selecting Layout > Insert Pages in the menu bar. Place the loaded text icon at the top of the next page and click. Repeat this process until there is no more text to place.

**Automatic text flow**

Before importing the text, first select Layout > Autoflow in the menu bar. Then you should import the text. Now the loaded text icon looks different - it contains a squiggly arrow(\[\text{\textarrowleft}\]).

Place the loaded text icon at the top of the page and click. But now the text will automatically flow on to the succeeding pages, creating new ones, if necessary.

### 2.8 Understanding story

A PageMaker story is similar to a newspaper article. The front page of a newspaper may contain several independent articles, some of which continue on other pages. In PageMaker, several stories may appear on the same publication page and continue elsewhere in the publication.

### 2.9 Threading text blocks

All text in PageMaker resides inside containers called text blocks.

A Text block can be connected to other text block so that the text in one text block can flow into another text block. Text blocks that are connected in this way are **threaded**. The process of connecting text among Text blocks is called **threading text**. Text that flows through one or more threaded blocks is called a **story**.

Once you have a loaded text icon, you can use one of three text-flow options to place text in text blocks.

To cancel a loaded text icon, click the pointer tool in the toolbox; no text is deleted.

A threaded text block can be identified by a plus sign in its top and/or bottom handles. Refer Figure 2.23-Fig 2.25

Unthreaded text is where a text block stands alone, without being connected to any other block. These blocks have nothing in their top and bottom handles.
2.9.1 **To unthread a threaded block**

**Method - 1:**
Select the block that you wish to unthread with the pointer tool. Click on Edit \> Cut in the menu bar. (the block disappear). Now click on the Edit \> Paste in the menu bar. The block will reappear in the same position, but it is now an unthreaded block.

**BEWARE:** if the block is in the middle of a story, say the second of the three, the first block is now threaded directly to the third.

**Method - 2:**
Select the block that you wish to unthread with the pointer tool. Then choose the Text tool and select all the text in the block. Then click on Edit \> Cut in the menu bar. (the block disappear). Now click the insertion point within an existing threaded block. Then click on Edit \> Paste in the menu bar. The text will be added in this block.

### 2.10 Placing Text in a Frame

You can also use frames to hold text in place of using text blocks. Refer Figure 2.26
To place text in a Frame

1. Click on one of a Frame tool from the Toolbox.
2. Draw a frame with one of PageMaker’s Frame tools (Rectangle frame tool or Ellipse Frame Tool or Polygon frame Tool). Make sure the object remains selected.
3. Click on File. The File menu will appear.
4. Click on Place. The Place dialog box will appear.
5. Locate the document that contains the text you want to place, select it.
6. Click on Open.
7. Click in a frame to place the text in it.
   The text will be placed in the frame.

---

**Figure 2.26 Place text in a Frame**

- In PageMaker, text and graphics that you draw or import are called objects.
- An object can be on a page or on the pasteboard.
- Text can be contained either in text blocks or text frames.
2.10.1 Linking Frames containing Text

A single frame may not be large enough to hold an entire story when you are using a large amount of text, you can link frames together so that an entire story is visible.

To link Frames containing text

1. Draw a second frame with the Frame tool of your choice.
2. Click the first frame to select it.
3. Click on the red triangle to load the text icon.
4. Click the second frame. PageMaker flows the text into the second frame.

Figure 2.27 To link Frames containing text

2.10.2 Converting text in a Text block to a Frame

After created text in a text block, if you want to convert it to a frame. You can do this by using these steps.

1. Draw the frame of your choice using one of the PageMaker’s Frame tool.
2. Select the text block you want to insert in the frame.
3. Click the frame while pressing the Shift key. Now both elements will be selected.
4. Choose Element > Frame > Attach Content on the Menu bar.
5. Now the text appears in the frame. Refer Figure 2.28
2.10.3 **Separating Text from the Frame**

Once text has been attached to a frame or flowed inside it, you can separate the text and frame.

To separate text from a frame

1. Click the frame with the **Pointer** tool.
2. Choose **Element > Frame > Delete Content** in the menu bar. The text will not appear in the frame.

2.11 **Saving, Closing and Opening Documents**

The below section explains about various operations with the documents.

2.11.1 **Saving a Document**

You can save your document for future use. Saving a document allows you to review later and edit the document. Saved file can be used on other computer also.

To save a document for a first time following steps are used:

1. (a) Choose **File > Save** in the menu bar. (or)
2. The file name is given in the **File name** list box.
3. Then click on the **Save** button to save the document. The document is now saved and a file name appears in the title bar.
Once a file is saved under a name, to save it again the name need not be entered again. The file can be saved simply by selecting the **File > Save** command or by clicking the **Save** button (or) clicking **Ctrl + S** in the keyboard.

### 2.11.2 Saving a Document with a new name or in a different location

You can save a document with a new name or in a different location using **Save As** command. **Save AS** command creates a new copy of the document. So, two versions of the document exist. The versions are completely separate, and the work you do on one document has no effect on the other.

To save a document with a new name or in a different location:

1. Choose **File > Save As** in the menu bar. (or) Press **Shift + Ctrl + S** in the keyboard.
2. Type a new name or specify a new location.
3. Click the **Save** button.

![Figure 2.30 Saving a Document with a new name or in a different location](image)

### 2.12 Closing a Document

After a document is saved, it is not closed. It remains open so that the user can continue working. When the work is finished, the user should save and close the document.

After saving, the document can be closed using the **File > Close** command in the menu bar (or) **Ctrl + W** in the keyboard.

### 2.13 Opening an existing Document

To open a document that has been saved and closed the following steps are used:

1. (a) Choose **File > Open** in the menu bar (or) Click on the **Open icon** in the Tool bar (or)
Press Ctrl + O in the Keyboard.

A **Open Publication** dialog box as shown in the figure 2.31 appears on the screen.

![Figure 2.31 Opening an existing Document](image)

**2.** The file name is given in the **File name** list box.

The name of the file to be opened can be chosen from the list, which is displayed.

**3.** Then click on the **Open** button.

Now the required file is opened.

### 2.14 Moving Around the Document

We can move the insertion point to anywhere in the document by using the mouse or the Keyboard.

To move the insertion point with the mouse, the mouse pointer is moved to the required spot and the mouse button is clicked. The insertion point jumps to that spot. It is to note that mouse pointer is different from the insertion point.

To move the insertion point with the keyboard the arrow keys and other key combination can be used.

The below Table 1.1 lists the common movement keys. If the key combination is joined with a plus sign, the first key must be pressed and held down and the second key is to be pressed.

<table>
<thead>
<tr>
<th>Move</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>One character to the left</td>
<td>Left Arrow</td>
</tr>
<tr>
<td>One character to the right</td>
<td>Right Arrow</td>
</tr>
<tr>
<td>One word to the left</td>
<td>Ctrl + Left Arrow</td>
</tr>
<tr>
<td>One word to the right</td>
<td>Ctrl + Right Arrow</td>
</tr>
<tr>
<td>Up one line</td>
<td>Up Arrow</td>
</tr>
<tr>
<td>Down one line</td>
<td>Down Arrow</td>
</tr>
<tr>
<td>To the end of a line</td>
<td>End</td>
</tr>
<tr>
<td>To the beginning of a line</td>
<td>Home</td>
</tr>
<tr>
<td>Up one paragraph</td>
<td>Ctrl + Up Arrow</td>
</tr>
<tr>
<td>Down one paragraph</td>
<td>Ctrl + Down Arrow</td>
</tr>
</tbody>
</table>

### 2.15 Scrolling the Document

In PageMaker, there are two sets of scroll bars; one for **up and down movement** and the other for the **left and right movement** of the document.

PageMaker's scroll bars work differently than those in a word processor. Note that they are set to the center of each bar. Also, they scroll only the page you are currently on. Use the scroll bar on the right side to move up and down. Use the scroll bar at the bottom to move left and right.

The scrolling procedure is as follows:

1. To scroll left and right the left and right arrow respectively should be clicked.
2. To scroll up and down the up and down arrow respectively should be clicked.
3. To scroll a relative distance in the document the scroll box should be drawn up or down.

### 2.16 Magnifying and reducing with the zoom tool

Use the zoom tool to magnify or reduce the display of any area in your publication. You can also double-click the zoom tool to jump to Actual Size, or press Alt as you double-click the tool to go to Fit in Window view. Refer Figure 2.32

To magnify or reduce with the zoom tool:

1. Select the zoom tool.
   The pointer becomes a magnifying glass with a plus sign in its center, indicating that the zoom tool will magnify your view of the image. (The magnifying glass shows a minus sign in its center when in reduction mode.) To toggle between magnification and reduction, press the Ctrl key.
2. Position the magnifying glass at the center of the area you want to magnify or reduce, and then click to zoom in or out.
   Continue clicking until the publication is at the magnification level you want. When the publication has reached its maximum magnification or reduction level, the center of the magnifying glass appears blank.

To magnify part of a page by dragging:

1. Select the zoom tool.
2. Drag to draw a marquee around the area you want to magnify.

To zoom in or out while using another tool:
Press Ctrl+Spacebar to zoom in. Press Ctrl+Alt+Spacebar to zoom out.

![Image](image.png)

Figure 2.32 To magnify or reduce with the zoom tool

### 2.17 Formatting a Document

Formatting is the process of changing the general arrangement of text, i.e., improving the appearance of the text by using various fonts, fonts colors, and font styles. A font is a set of letters, numbers or symbols in a certain style. Each font looks different from other fonts.
2.17.1 **Character Formatting using Character Specifications Dialog Box**

Character formatting means displaying text in a certain way. Character formatting consists of text properties - bold, italic, underline, font type, font size, font colour, etc. Refer Figure 2.33, 2.34 and 2.35.

The steps to apply character formatting to text are as follows:

1. Select the text to be formatted.
2. Choose **Type > Character** in menu bar (or) Press **Ctrl + T** on the keyboard.
   
The **Character Specifications** dialog box appears.

   ![Character Specifications Dialog Box](image)

   *Figure 2.33 Character Formatting using Character Specifications Dialog Box*

3. Make the appropriate changes in the dialog box.
   - Click the drop-down menu arrow of the **Font** box and select the desired font.
   - Click the drop-down menu arrow of the Font **Size** box and select the font size.
   - Click the drop-down menu arrow of the Font **Color** box and select the desired colour.
   - Click the **Bold**, **Italic**, or **Underline** buttons to make the text bold, italic, or underlined respectively.
4. Click on OK.

2.17.2 **Character Formatting using the Control Palette**

The Control Palette is especially useful when you are doing lot of formatting.

Its features change based on the object that is selected on your layout.

If the Control palette is not showing then use the following steps:

1. Click on **Window > Show Control Palette** sequence in the menu bar. (or)
2. Press **Ctrl + 4** in the keyboard.
   
Now the Control Palette appears on the window.
To modify character attributes using the Character Control Palette:

1. Select the text you want to modify.
2. Make the appropriate changes in the Control palette. Refer Figure 2.34

![Character Control Palette Diagram](image)

**Figure 2.34** Character Control Palette

![Example of character attributes](image)

**Figure 2.35** Modify character attributes using the Character Control Palette
2.17.3 Changing Text Colour

You can change the colour of the text. Your design may look beautiful if you choose a text colour other than black.

To color characters

1. Select the text you want to colour.
2. Choose Window > Show Colors in Menu bar. The Colors palette appears. Refer Figure 2.36
   Click the color you want to apply to the selected text.
   The characters change to the colour you selected in the palette.

2.18 Drawing

There are so many drawing tools in PageMaker. Line tool, Rectangle tool, Ellipse tool and Polygon tool are four main drawing tools.

2.18.1 Drawing Lines

PageMaker has two Line tools. The first one creates a straight line at any orientation. The second is a constrained Line tool that draws only at increments of 45 degrees. You can change the property of tools by double-clicking on them. Refer Figure 2.37 to Figure 2.40

To draw a line

1. Select the Line tool from the toolbox. The cursor changes to a crosshair.
2. Click and drag on the screen to draw your line. As you drag, a line appears.
3. Release the mouse button and the line will be drawn and selected, with sizing handles on either end.

Resize the line by clicking and dragging the handles, if necessary.

3. Then click OK button. Now the cursor changes to a crosshair.
4. Click and drag on the screen to draw your dotted line. As you drag, the line appears.
5. Release the mouse button and the line will be drawn and selected, with sizing handles on either end.

Resize the line by clicking and dragging the handles, if necessary.

To draw a Dotted line

1. Double click the Line tool from the toolbox. A Custom Stroke dialogue box appears.

2. Select the required Stroke style in the drop-down list box.

2.18.2 Drawing Rectangles or Ellipses

You can also draw rectangles and ellipses shapes by using the same technique as used in line drawing. Refer Figure 2.41 and 2.42

1. To draw a rectangle or ellipse:
   - Click on the Rectangle or Ellipse tool from the toolbox.
   - The cursor changes to a crosshair.
2. Click and drag anywhere on the screen. As you drag, a rectangle or ellipse appears.
3. Release the mouse button when the rectangle or ellipse is of the desired size.

Press the Shift key while you’re drawing to constrain the shape to a square or circle.
Drawing a Rounded Corner Rectangle

To draw a rounded-corner rectangle:

1. Double-click the Rectangle tool in the toolbox.
   The Rounded Corners dialog box appears.
2. Choose a corner setting from the preset shapes.
3. Click on OK. The cursor changes to a crosshair.
4. Click and drag anywhere on the screen.
5. Release the mouse button when the rectangle is the desired size.
   Press the Shift key as you draw to constrain the shape to a rounded-corner square.

2.18.3 Drawing Polygon

To draw a Polygon

1. Click on the Polygon tool from the toolbox.
   The cursor changes to a crosshair.
2. Click and drag anywhere on the screen. As you drag, a Polygon appears.
3. Release the mouse button when the Polygon is of the desired size. Refer Figure 2.43
2.18.4 **Drawing a Star using Polygon tool**

**To draw a Star**

1. Click on the **Polygon tool** from the toolbox.
   
   The cursor changes to a **crosshair**.

2. Click and drag anywhere on the screen. As you drag, a Polygon appears.

3. Release the mouse button when the Polygon is of the desired size.

4. Choose Element > Polygon Settings in the menu bar.
   
   Now Polygon Settings dialogue box appears.

5. Type 5 in the Number of sides text box.

6. Type 50% in Star inset textbox.

7. Click OK. Now the required star appears on the screen. Refer Figure 2.44 - 2.46

---

**Figure 2.45** Polygon tool setting

**Figure 2.46** Polygon

---

**Star Inset percentage** bends the polygon lines inwards to form a star-shaped object.

---

**Drawing a star with given number of sides and required inset**

1. The value of ‘Star inset’ is 50%

   The number of sides is 15

   The result of the star shape is shown Figure 2.47.
2. The value of ‘Star inset’ is 25%
The number of sides is 25
The result of the star shape is shown Figure 2.48.

![Figure 2.48 Drawing a star-2](image)

3. The value of ‘Star inset’ is 35%
The number of sides is 70
The result of the star shape is shown Figure 2.49.

![Figure 2.49 Drawing a star-3](image)

### 2.18.5 Filling Shapes with Colors and Patterns

#### Filling Rectangle with colour

1. Draw a rectangle using Rectangle tool.
2. Select the rectangle.
3. Choose **Window > Show colors** in the menu bar. (or) Press Ctrl + J
   
   Now **Colors palette** appears.
4. Click on the required colour from the Colors Palette.
5. The rectangle has been filled with the colour. Refer Figure 2.50 and 2.51

![Figure 2.50 Show colors](image)

![Figure 2.51 Filling Shapes with Colors and Patterns](image)

### 2.19 Working with pages

The main purpose of PageMaker is composing pages. You can insert new pages into a document, remove existing pages, move between pages, and sort pages in a large document.

#### 2.19.1 Going to a specific Page

Pagemaker provides several methods for navigating the pages in your publication.
Method 1:
You can move from one page to another by using the Page up and Page down keys on your keyboard. This is probably the navigation methods you will use most often.

Method 2:
You can move from one page to another by using the page icons at the left bottom of the screen. Click on the page icon that corresponds to the page that you want to view. The page is displayed.

Method 3:
Using the Go to Page dialog box. Refer Figure 2.52 and 2.53
To go to a specific page in a document
1. Choose Layout > Go to Page in the menu bar (or) Press Alt + Ctrl + G in the keyboard. Now the Go to Page dialog box appears.

2. In the dialogue box, type the page number that you want to view.

3. Then click on OK. The required page is displayed on the screen.

2.19.2 Inserting Pages
You can add more pages to a document. You can insert pages before, after, or between the pages you’re currently viewing. When you insert pages, PageMaker automatically renumbers the pages in your publication. Refer Figure 2.54 and 2.55

To insert pages
1. Go to the page immediately before the page you want to insert.
2. Choose Layout > Insert Pages in the menu bar. The Insert Pages dialog box appears.

3. Type the number of pages you want to insert.
4. To insert pages after the current page, choose ‘after’ from the pop-up menu.
5. Click on Insert.
6. The new pages are inserted in your publication.
2.19.3 **Removing Pages**

You can remove the unused pages from your document with a Remove Pages dialog box.

1. Choose **Layout > Remove Pages** in the menu bar. The **Remove Pages** dialog box appears. Refer Figure 2.56 and 2.57

![Figure 2.56 Remove pages](image)

2. Type the page range you want to remove.

![Figure 2.57 Remove pages settings](image)

3. Click on OK button.

2.20 **Master Pages**

Any text or object that you place on the master page will appear on the entire document pages to which the master is applied. It shortens the amount of time because you don’t have to create the same objects repeatedly on subsequent pages.

![Figure 2.58 Master Pages](image)

Master Pages commonly contain repeating logos, page numbers, headers, and footers. They also contain nonprinting layout guides, such as column guides, ruler guides, and margin guides.

A master item cannot be selected on a document page.

You can create, modify, and delete objects on master pages just like any other objects, but you must do so from the master pages themselves.

At the lower left corner of a document (publication) window you can find an icon which represents the master pages. The letters L and R (L denotes left and R denotes right) mark the master page icon for facing pages. A single-sided publication icon is marked by an R alone. Refer Figure 2.58

![Figure 2.58 Master Pages](image)

2.20.1 **Inserting Page Numbers in Master Pages**

To make page numbers appear on every page

1. Click on Master Pages icon.
2. Then click on Text Tool. Now the cursor changes to I - beam.
3. Then Click on the left Master page where you want to put the page number.
4. Press Ctrl + Alt + P.
5. The page number displays as ‘LM’ on the left master page.
6. Similarly click on the right Master page where you want to put the page number.
7. Press Ctrl + Alt + P.
8. The page number displays as ‘RM’ on the right master page, but will appear correctly on the actual pages. Refer Figure 2.59

2.20.2 Hiding Master Items
To make the master items invisible on a particular page, switch to the appropriate page, then choose View > Display Master items (which is usually ticked). Refer Fig 2.60

2.20.3 Showing Master Page Palette
Master Pages palette organize all the command you will need to work with Master Pages. Refer Figure 2.61 and 2.62
To show Master Page Palette
1. Choose Windows> Show Master Pages in the menu bar. The Master Pages Palette appears.
2.20.4 Creating Master Pages

By default, all Pagemaker documents have a Master Page already created ‘Document Master’. But sometimes you will require more than one Master Page.

You can set up multiple master pages for any publication, each page containing a specific combination of headers, footers, page numbers, frames, and other elements that you want to use over and over.

When you create a new Master Page, you will be asked to name the new Master page and set its margins and column guides.

To create a new Master Page

1. Click the New Master Page icon in the Master Pages palette. The New Master Page dialog box appears.
2. Enter the name of the new master page in the Name field.
3. Make the appropriate changes in the Margins and Column Guides fields.
4. Click on OK. A new Master Page appears in the Master Pages palette. Refer Figure 2.63 and 2.64.
2.21 **Print a document**

1. Choose **File > Print** in the menu bar (or) Press **Ctrl + P** in the keyboard. The **Print Document dialog box** appears.
2. Choose the settings in the Print Document dialog box as
   - Select the printer from the **Printer** drop-down list box.
   - Choose the pages to be printed in the **Pages** group box by selecting one of the following available options:
     - **All**: This option prints the whole document.
     - **Ranges**: This option prints individual pages by the page number or a range of pages.
   You can use commas to separate the page numbers (e.g., 5, 7, 19).
   Use a hyphen to print page ranges (e.g., 10-17; this will print all pages from page numbers 10 to 17).
   To print from a particular page to the end of the document, enter the starting page number followed by a hyphen (e.g., 5 - ).
   You may also combine individual page numbers and a range of pages (e.g., 5, 9, 15-26).
   **Print**: You can also print only odd-numbered or even-numbered pages. Select the Odd pages or Even pages option from the Print drop-down list box. Refer Figure 2.65

![Print Document dialog box](image-url)

*Figure 2.65 Print Document setting*
Type the number of copies you want in the **Copies** text box.

You can choose whether to **collate** the pages or not. Suppose you want to print 4 copies of a 5 pages document.

If the **Collate** option is not selected, PageMaker will first print 4 copies of page 1, then 4 copies of page 2, and so on.

If the **Collate** option is selected, PageMaker will print a complete set of pages 1 to 5, then a second set, and so on.

4. After choosing from the options in the **Print Document** dialog box, click **Print** button to print the document. Make sure the printer is switched on.

---

**POINTS TO REMEMBER**

- Desktop publishing (abbreviated DTP) is the creation of page layouts for documents using DTP software.
- Some of the popular DTP software are **Adobe PageMaker**, **Adobe InDesign**, **QuarkXPress**, etc.
- Adobe PageMaker is a **page layout software**. It is used to design and produce documents that can be printed.
- The area outside of the dark border is referred to as the pasteboard.
- Editing means making changes to the text. When you edit a document, you revise its text.
- A text block contains text you type, paste, or import. You cannot see the borders of a text block until you select it with the pointer tool.
- A Text block can be connected to other text block so that the text in one text block can flow into another text block. Text blocks that are connected in this way are **threaded**.
- The process of connecting text among Text blocks is called **threading text**.
- Text that flows through one or more threaded blocks is called a **story**.
- Any text or object that you place on the master page will appear on the entire document pages to which the master is applied.
- Master Pages commonly contain repeating logos, page numbers, headers, and footers.
- A master item cannot be selected on a document page.
**Glossary**

<table>
<thead>
<tr>
<th>Header</th>
<th>Text that is repeated at the top of each page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Footer</td>
<td>Text that is repeated at the bottom of each page</td>
</tr>
<tr>
<td>Symbol</td>
<td>A sign or a special character that can be inserted in a PageMaker document</td>
</tr>
<tr>
<td>Margins</td>
<td>The amount of space between the text and the edge of the page on all four sides</td>
</tr>
<tr>
<td>Orientation</td>
<td>The direction (along the height or along the width) in which the page is being printed</td>
</tr>
<tr>
<td>Menu</td>
<td>A list of commands</td>
</tr>
<tr>
<td>Editing</td>
<td>Making changes to the text</td>
</tr>
<tr>
<td>Undo</td>
<td>Reversing the last command</td>
</tr>
<tr>
<td>Redo</td>
<td>Reversing the Undo command</td>
</tr>
</tbody>
</table>

**EVALUATION**

**Part I**

**Choose the correct answer**

1. DTP stands for ____________
   (a) Desktop Publishing  
   (b) Desktop Publication  
   (c) Doctor To Patient  
   (d) Desktop Printer

2. ____________ is a DTP software.
   (a) Lotus 1-2-3  
   (b) PageMaker  
   (c) Maya  
   (d) Flash

3. Which menu contains the New option?
   (a) File menu  
   (b) Edit menu  
   (c) Layout menu  
   (d) Type menu

4. In PageMaker Window, the area outside of the dark border is referred to as ____________.
   (a) page  
   (b) pasteboard  
   (c) blackboard  
   (d) dashboard

5. Shortcut to close a document in PageMaker is ____________
   (a) Ctrl + A  
   (b) Ctrl + B  
   (c) Ctrl + C  
   (d) Ctrl + W

6. A ____________ tool is used for magnifying the particular portion of the area.
   (a) Text tool  
   (b) Line tool  
   (c) Zoom tool  
   (d) Hand tool
7. _________ tool is used for drawing boxes.
   (a) Line  
   (b) Ellipse 
   (c) Rectangle 
   (d) Text

8. Place option is present in ______________ menu.
   (a) File  
   (b) Edit 
   (c) Layout 
   (d) Window

9. To select an entire document using the keyboard, press __________
   (a) Ctrl + A  
   (b) Ctrl + B 
   (c) Ctrl + C 
   (d) Ctrl + D

10. Character formatting consists of which of the following text properties?
    (a) Bold  
    (b) Italic 
    (c) Underline 
    (d) All of these

11. Which tool lets you edit text?
    (a) Text tool  
    (b) Type tool 
    (c) Crop tool 
    (d) Hand tool

12. Shortcut to print a document in Pagemaker is ____________
    (a) Ctrl + A  
    (b) Ctrl + P 
    (c) Ctrl + C 
    (d) Ctrl + V

13. Adobe PageMaker is a __________ software.

14. _________ Bar is the topmost part of the PageMaker window.

15. _________ is the process of moving up and down or left and right through the document window.

16. _________ tool is used to draw a circle.

17. The Insert pages option is available on clicking the __________ menu.

18. Match the following.
    Cut -   (i) Ctrl + Z 
    Copy -  (ii) Ctrl + V 
    Paste - (iii) Ctrl + X 
    Undo  - (v) Ctrl + C

19. Choose the odd man out.
    i. Adobe PageMaker, QuarkXPress, Adobe InDesign, Audacity 
    ii. File, Edit, Layout, Type, Zip 
    iii. Pointer Tool, Line tool, Hide Tool, Hand Tool 
    iv. Bold, Italic, Portrait, Underline

20. Choose the correct statement.
    i. (a) Text can be selected using mouse only. 
    (b) Text can be selected using mouse or the keyboard. 
    ii. (a) DTP is an abbreviation for Desktop publishing. 
    (b) DTP is an abbreviation for Desktop publication.

21. Choose the correct pair
    (a) Edit and Cut  
    (b) Edit and New 
    (c) Undo and Copy  
    (d) Undo and Redo
Part - II

Short Answers

1. What is desktop publishing?
2. Give some examples of DTP software.
3. Write the steps to open PageMaker.
4. How do you create a New document in PageMaker?
5. What is a Pasteboard in PageMaker?
6. Write about the Menu bar of PageMaker.
7. Differentiate Ellipse tool from Ellipse frame tool.
8. What is text editing?
9. What is text block?
10. What is threading text blocks?
11. What is threading text?
12. How do you insert a page in PageMaker?

Part - III

Explain in Brief Answer

2. Mention three tools in PageMaker and write their keyboard shortcuts.
3. Write the use of any three tools in PageMaker along with symbols.
4. How do you rejoin split blocks?
5. How do you link frames containing text?
6. What is the use of Master Page?
7. How to you insert page numbers in Master pages?

Part - IV

Explain in detail

1. Explain the tools in PageMaker toolbox.
2. Write the steps to place the text in a frame.
3. How can you convert text in a text block to a frame?
4. Write the steps to draw a star using polygon tool?
3.1 Introduction to Database Management System

DBMS stands for Database Management System, so let us break down the words what they really mean. A database is a place where we store, retrieve and manage data. So what’s a data then? Meaningful information like your name, your favorite color etc to complex data like astronomical data that scientist handle, everything comes under database. The management system refers to a set of programs to manage the data, we have with various actions like storing, retrieving, filtering etc. Some of the popular Database Management System is MySQL, Oracle etc. Giving protection to data, user-friendly for users etc, are some of the notable features of good DBMS.

3.1.1 Introduction to DBMS

Definition: “A database management system (DBMS) is system software for creating and managing databases. The DBMS provides users and programmers with a systematic way to create, retrieve, update and manage data.”

What type of data is stored in a database?

In a database, we would be grouping only related data together and storing them under one group name called table. This helps in identifying which data is stored where and under what name.

3.1.2 Evolution of DBMS

The concept of storing the data started before 40 years in various formats. In earlier days they have used punched card technology to store the data. Then files were used. The file systems were known as predecessor of database system. Various access methods in file system were indexed, random and sequential access. The file system had more limitations like
Data Duplication – Same data is used by multiple resources for processing, thus created multiple copies of same data wasting the spaces.

High Maintenance – Access control and verifying data consistency needs high maintenance cost.

Security – less security provided to the data.

So database systems became popular to overcome the above limitations of file system.

3.1.3 DBMS Concepts

There exist few standards that are applicable to all forms of database management Systems like Relational Database Management System (RDBMS) and Object Database Management System (ODBMS). All DBMS adheres to the following two basic concepts.

ACID Properties – The acronym stands for Atomicity, Consistency, Isolation and Durability. Atomicity follows the thumb rule “All or Nothing”, while updating the data in database for the user performing the update operation. This update operation is called as transaction and it either commits (successful updating) or aborts (updating failure). Consistency ensures that the changes in data value to be constant at any given instance. This property helps in the successful transaction. Isolation property is needed during concurrent transaction. When multiple users do the transactions by accessing same object at the same time, the transaction is known as concurrent transaction. To prevent the conflict in database update, the transactions are isolated from other user and serialized. This is also known as Degree of Consistency. Durability is defined as the system’s ability to recover all committed transactions during the failure of storage or the system.

Concurrency Control and Locking – It is the DBMSs mechanism used for data sharing. When the same data is shared among multiple users, proper access control is needed and privilege of changing the applications data item is controlled through Locking.

3.2 DBMS Database Models

The database technology came into existence in terms of models with relational and object-relational behavior. The major database models are listed below:

3.2.1 Hierarchical Database Model

The famous Hierarchical database model was IMS (Information Management System).
System), IBM’s first DBMS. In this model each record has information in parent/child relationship like a tree structure. The collection of records was called as record types, which are equivalent to tables in relational model. The individual records are equal to rows. See Figure 3.1

In the above model we have many advantages like less redundant data, efficient search, data integrity and security. This model also has few limitations like complex to implement and difficulty in handling many to many relationships.

3.2.2 Network model

The first developed network data model was IDS (Integrated Data Store) at Honeywell. Network model is similar to Hierarchical model except that in this model each member can have more than one owner. The many to many relationships are handled in a better way. This model identified the three database components Network schema, Sub schema and Language for data management. See Figure 3.2

Network schema – schema defines all about the structure of the database.

Sub schema – controls on views of the database for the user

Language – basic procedural for accessing the database.

The major advantage of this model is the ability to handle more relationship types, easy data access, data integrity and independence. The limitation of network model is difficulty in design and maintenance.

3.2.3 Relational model

Oracle and DB2 are few commercial relational models in use. Relational model is defined with two terminologies Instance and Schema. See Figure 3.3

Instance – A table consisting of rows and columns

Schema – Specifies the structure including name and type of each column.

A relation (table) consists of unique attributes (columns) and tuples (rows).

3.2.4 Object-oriented database model

This model incorporates the combination of Object Oriented Programming(OOP’s) concepts and database technologies. Practically, this model serves as the base of Relational model. Object oriented model
uses small, reusable software known as Objects. These are stored in object-oriented database. This model efficiently manages large number of different data types. Moreover complex behaviors are handled efficiently using OOP’s concepts. See Figure 3.4

### 3.3 Relational Database Management System

**Basic RDBMS concepts**

Any database whose logical organization is based on relational data model is known as Relational Database. A DBMS that manages the relational database is known as Relational Data Base Management System. RDBMS is basis for SQL and for all modern database systems like MySQL, oracle and Microsoft Access. The basic RDBMS concept includes Database, Tables, Tuple, Attribute, Schema and Key which are discussed in RDBMS Jargons.

### 3.4 RDBMS Jargons

#### 3.4.1 Database

The most popular Relational Database is MySQL. It is an open source SQL database supporting different platforms like Windows, Linux and MAC Operating Systems. The other relational databases available are Oracle, MS SQL Server and MS Access. The features of RDBMS are

- High Availability
- High Performance
- Robust Transactions and support
- Ease of management
- Less cost

#### 3.4.2 Table

In relational database model, table is defined as the collection of data organized in terms of rows and columns. Table is the simple representation of relations. The true relations cannot have duplicate rows.

![Object-oriented database model](image-url)
3.4.3 Column

The table consists of several rows and columns. Table can be divided into smaller parts, in terms of columns. Each column is known as attributes. In the Employee table four attributes are available namely Id, Name, Age and Salary. The attribute is defined in a table to hold values of same type. This is known as Attribute Domain. In the Employee table, the Name field will hold only characters not the numbers in it. The vertical entity in a table is known as Attribute or Column.

3.4.4 Row

A single entry in a table is called as Row or Record or Tuple. Set of related data’s are represented in a row or tuple. The horizontal entity in a table is known as Record or row. See Table 3.2

<table>
<thead>
<tr>
<th>ID</th>
<th>NAME</th>
<th>AGE</th>
<th>SALARY</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Alex</td>
<td>26</td>
<td>22,000</td>
</tr>
<tr>
<td>2</td>
<td>Divya</td>
<td>25</td>
<td>20,000</td>
</tr>
<tr>
<td>3</td>
<td>Tulsi</td>
<td>28</td>
<td>30,000</td>
</tr>
</tbody>
</table>

3.4.5 Primary Key

The candidate key that is chosen to perform the identification task is called the primary key and any others are Alternate keys. Every tuple must have, by definition, a unique value for its primary key. A primary key which is a combination of more than one attribute is called a composite primary key.

3.4.6 Foreign Key

A foreign key is a “copy” of a primary key that has been exported from one relation into another to represent the existence of a relationship between them. A foreign key is a copy of the whole of its parent primary key i.e if the primary key is composite, then so is the foreign key. Foreign key values do not (usually) have to be unique. Foreign keys can also be null. A composite foreign key cannot have some attribute(s) null and others non-null.

3.4.7 Super Key

An attribute or group of attributes, which is sufficient to distinguish every tuple in the relation from every other one is known as Super Key. Each super key is called a candidate key. A candidate key is selected from the set of Super Key. While selecting candidate key, redundant attributes should not be taken. The candidate key is also known as minimal super keys.

3.4.8 Composite Key

A key with more than one attribute to identify rows uniquely in a table is called Composite key. This is also known as Compound Key.

3.5 ER Model

Generally we use an ER model to know the concept of database design and this model consists of a collection of entities(real world objects)where each of these entities will be interconnected with each other with conditions and dependencies(i.e. one entity is dependent on another).
3.5.1 **ER Modeling basic concepts**
The basic concepts of ER model consists of

1. Entity or Entity type
2. Attributes
3. Relationship

These are the general concepts which help to create an ER diagram and produce an ER model. With the help of these any database design can be created and viewed to know the concept in that database design.

3.5.2 **Entity or Entity type**
An Entity can be anything a real-world object or animation which is easily identifiable by anyone even by a common man.

Eg: In a company’s database Employee, HR, Manager are considered as entities, where each of these entity will be having their own attributes. An entity is represented by a rectangular box. See Figure 3.5.

![Figure 3.5 Entity](image)

**Types of Entity:**
1. Strong Entity
2. Weak Entity
3. Entity Instance

**Strong Entity**
A Strong entity is the one which doesn’t depend on any other entity on the schema or database and a strong entity will have a primary key with it (i.e. a unique id which other entities will not have in their attributes). It is represented by one rectangle. In the above example it is a strong entity because it has a primary key (a unique id) as the roll no because for every one roll no varies and it will not be same.

**Weak Entity**
A weak entity is dependent on other entities and it doesn’t have any primary key like the Strong entity. It is represented by double rectangle.

**For Example:**
Here the marks is the weak entity and there are no unique id or primary key for that entity. So they are dependent on the existence of the other entity. See Table 3.3

![Figure: 3.6 Weak Entity](image)

3.5.3 **Entity Instance**
Instances are the values for the entity if we consider animals as the entity their instances will be dog, cat, cow... Etc. So an Entity Instance denotes the category values for the given entity.

<table>
<thead>
<tr>
<th>Table: 3.3 Entity Instances</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Entities</strong></td>
</tr>
<tr>
<td>Human</td>
</tr>
<tr>
<td>Animals</td>
</tr>
<tr>
<td>Jobs</td>
</tr>
<tr>
<td>Actors</td>
</tr>
<tr>
<td>Electronics</td>
</tr>
</tbody>
</table>
3.5.4 Attributes
An attribute is the information about that entity and it will describe, quantify, qualify, classify, and specify an entity. An attribute will always have a single value, that value can be a number or character or string.

**Types of attributes:**
1. Key Attribute
2. Simple Attributes
3. Composite Attributes
4. Single Valued Attribute
5. Multi Valued Attribute

3.5.4.1 Key Attribute
Generally a key attribute describes a unique characteristic of an entity.

3.5.4.2 Simple Attribute

![Figure 3.7 Simple Attribute](image)

The simple attributes cannot be separated it will be having a single value for their entity. For Example: Let us consider the name as the attribute for the entity employee and here the value for that attribute is a single value. See Figure 3.7

3.5.4.3 Composite Attributes

The composite attributes can be sub-divided into simple attributes without change in the meaning of that attribute. For Example: In the above diagram the employee is the entity with the composite attribute Name which are sub-divided into two simple attributes first and last name.

3.5.4.4 Single Valued Attributes:
A single valued attribute contains only one value for the attribute and they don’t have multiple numbers of values. For Example: Age - It is a single value for a person as we cannot give n number of ages for a single person, therefore it is a single valued attribute. See Table 3.4

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Age</td>
<td>3</td>
</tr>
<tr>
<td>Roll no</td>
<td>85</td>
</tr>
</tbody>
</table>

In the above table are the some examples for single valued attributes. See Figure 3.8

3.5.4.5 Multi Valued Attributes:
A multi valued attribute has more than one value for that particular attribute. For Example: Degree - A person can hold n number of degrees so it is a multi-valued attribute.

In Table 3.5 are some examples for Multi valued attributes.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Degree</td>
<td>B.Tech, MBA</td>
</tr>
<tr>
<td>Bank_Account</td>
<td>SBI, HDFC</td>
</tr>
</tbody>
</table>
3.5.5 **Relationship Type**

In ER Model, relationship exists between two entities. Three types of relationships are available and the Entity-Relationship(ER) diagram is based on the three types listed below.

**One-to-One relationship**: Consider two entities A and B. one-to-one (1:1) relationship is said to exist in a relational database design, if 0 or 1 instance of entity A is associated with 0 or 1 instance of entity B, and 0 or 1 instance of entity B is associated with 0 or 1 instance of entity A.

**One-to-Many relationship**: Consider two entities A and B. one-to-many (1:N) relationship is said to exist in a relational database design, for 1 instance of entity A there exists 0 or 1 or many instances of entity B, but for 1 instance of entity B there exists 0 or 1 instance of entity A.

**Many-to-Many relationship**: Consider two entities A and B. many-to-many (M:N) relationship is said to exist in a relational database design, for 1 instance of entity A there exists 0 or 1 or many instances of entity B, and for 1 instance of entity B there exists 0 or 1 or many instance of entity A.

In reality one-to-one are in less usage, whereas one-to-many and many-to-many are commonly used. However in relational databases, many-to-many are converted into one-to-many relationships.

3.5.5.1 **Relationship instance**

Each instance of the relationship between members of these entity types is called a relationship instance. E.g if **Works-for** is the relationship between the Employee entity and the department entity, then Ram works for Comp.sc department, shyam works for electrical department..etc are relationship instances of the relationship, works for.

3.5.5.2 **Degree of a relationship**

The number of entity types involved is known as Degree of relationship. One – Unary, Two – Binary, Three – Ternary. E.g An employee of an organization acts as manager of few other employees. It also connects one entity to itself as a loop. so **manager-of** is unary. Similarly employee **works-for** department, connects two entities and is binary. If customer **purchase** item, it involves shop keeper also and is a ternary relationship.

3.5.5.3 **Cardinality**

It is defined as the number of items that must be included in a relationship. i.e) number of entities in one set mapped with the number of entities of another set via the relationship. Three classifications in Cardinality are one-to-one, one-to-many and Many-to-Many. See Figure 3.9

![Figure 3.9 Cardinality](image)

In the above example we have two entities Person and Vehicle. If we consider the current vehicle, the driver is operating, then we have one-to-one relationship between Person and Vehicle. See Figure 3.10

![Figure 3.10 CardinalityRelation 1 to n](image)

In the above example, Customer places the Order is a one-to-many relationship.
Here the customer can place multiple orders and the order is related to only one customer. See Figure 3.11

The example of many-to-many relationship is Students registering the Courses. A student can register more than one courses and A course can be registered by many students. Hence it is many-to-many.

### 3.6 ER-Diagram

ER Diagram presents data visually on how they are related to each other. This model follows separate notations for representing data into entities, attributes and relationship between the entities.

#### 3.6.1 ER-Modeling Diagram Notations

Entities, Attributes and Relationship forms the components of ER Diagram and the defined symbols and shapes are summarized below in Table 3.6.

<table>
<thead>
<tr>
<th>Table 3.6 ER diagram Notations</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ER Component</strong></td>
</tr>
<tr>
<td>Entity - Strong</td>
</tr>
<tr>
<td>Entity – Weak</td>
</tr>
<tr>
<td>Relationships</td>
</tr>
<tr>
<td>between Entities</td>
</tr>
<tr>
<td>Attributes</td>
</tr>
<tr>
<td>Key Attribute for Entity</td>
</tr>
<tr>
<td>Derived Attribute for Entity</td>
</tr>
<tr>
<td>Multivalued Attribute for Entity</td>
</tr>
</tbody>
</table>
3.6.2 Example

Given below is an example of ER Diagram for the scenario of School Management System. We have many entities like Parent, student, Admin, Teacher, class and subjects. The attributes of few entity is given below:

- Parent – Name, Id, Fname, Lname.
- Student – Id, Name, Fname, Lname.
- Teacher – Name, Id, Phone#, Address.

The relationships that exist between the entities are as follows:

- Parent HAVE Student
- Admin ENROLLS Student
- Admin HIRES Teacher
- Admin ADDS Subject
- Teacher TEACHES Subject
- Teacher IS ASSIGNED TO Class

Key Attributes are listed with underline.

3.7 Introduction to MYSQL

3.7.1 About MYSQL

MySQL is a database management system founded by Monty Widenius and is named after his daughter name My. Clear definition of database and SQL is mandatory to understand MySQL. In simple, a database is defined as the structured collection of data. Ex. Photo gallery is a database which has collection of photos (data). SQL - structured query language is not a database. It is a standardized language used to access the database and the data’s are processed to turn into efficient information. The SQL standard always refers to the current version and the current version is 2003. MySQL is open source software that allows managing relational databases. It also provides the flexibility of changing the source code as per the needs. It runs on multiple platforms like Windows, Linux and is scalable, reliable and fast.

3.7.2 Overview of Web Database

Many databases are in existence to meet out the needs of the application. These databases are broadly divided into Heavy and Light databases. Heavy databases support all the desktop applications whereas the web applications are
In general there exists a role known as Database Administrators (DBA's) who takes care of configuration, installation, performance, security and data backup. DBA's posses the skills on database design, database queries, RDMS, SQL and networking. The primary task is the creation of new user and providing them with access rights.

Creating New User Account to MySQL

In the MySQL database, there exists a table named `user`. The newly created account must have an entry in this `user` table. Consider the admin creates an account with username and password. The user account is activated with various access rights like INSERT, SELECT and UPDATE. Consider the `user` table has the following fields host, name, password, select_priv, insert_priv and update_priv.

<table>
<thead>
<tr>
<th>Database</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>MySQL</td>
<td>44.3%</td>
</tr>
<tr>
<td>SQL server</td>
<td>30.8%</td>
</tr>
<tr>
<td>SQLite</td>
<td>21.2%</td>
</tr>
<tr>
<td>PostgreSQL</td>
<td>21.2%</td>
</tr>
<tr>
<td>MongoDB</td>
<td>16.8%</td>
</tr>
<tr>
<td>Oracle</td>
<td>13.2%</td>
</tr>
<tr>
<td>Redis</td>
<td>11.2%</td>
</tr>
<tr>
<td>Cassandra</td>
<td>2.5%</td>
</tr>
</tbody>
</table>

Figure: 3.13 Most Popular databases - Statistics
A new user account is added with values to the user table using the following INSERT query in MySQL database. The Syntax for inserting record is INSERT INTO table name (Parameter1,Parameter2, Parameter3..) VALUES (Value1, Value2, Value3..); All the query will terminate with semicolon (;).

```sql
mysql> INSERT INTO user (host, name, password, select_priv, insert_priv, update_priv)
VALUES ('localhost', 'guest', PASSWORD('guest123'), 'Y', 'Y', 'Y');
```

Query OK, 1 row affected (0.20 sec) – This statement implies that the query is executed successfully with the time in seconds.

```sql
mysql> FLUSH PRIVILEGES;
```

The above command is executed after every new account creation. This command is similar to rebooting the server so that newly created account and the access privilege are updated in the server. Manual server rebooting is avoided by this command. The inserted record is retrieved using SELECT query and the structure is shown below Table 3.7 & 3.8:

```sql
mysql> SELECT * FROM user WHERE name = 'guest';
```

Since MySQL is more secured, it provides function to encrypt the password. Thus the password ‘guest123’ is encrypted and stored as ‘j2gd6vxd1bj3k13g4’ using PASSWORD() function. The parameters select_priv, insert_priv and update_priv are few privileges set for the new user. If the flag is set as ‘Y’ then access is granted and if flag set as ‘N’ then access is denied.

### Table 3.8 List of privileges available in MySQL

<table>
<thead>
<tr>
<th>Privileges</th>
<th>Action Performed (If Granted)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select_priv</td>
<td>User can select rows from database tables.</td>
</tr>
<tr>
<td>Insert_priv</td>
<td>User can insert rows into database tables.</td>
</tr>
<tr>
<td>Update_priv</td>
<td>User can update rows of database tables.</td>
</tr>
<tr>
<td>Delete_priv</td>
<td>User can delete rows of database tables.</td>
</tr>
<tr>
<td>Create_priv</td>
<td>User can create new tables in database.</td>
</tr>
<tr>
<td>Alter_priv</td>
<td>User can make changes to the database structure.</td>
</tr>
</tbody>
</table>

### 3.8.2 Administrative MySQL Command

The Database Administrator (DBA) frequently uses few commands to control the entire database. These commands are known as Administrative MySQL Commands. The following are few such important commands used frequently while working with MySQL.

1. **USE Database** – This command is used to select the database in MySQL for working. If there exists a database named test, it is used as working database using the below Syntax.

   ```sql
   mysql> use test;
   Database changed
   ```
2. **SHOW Databases** – Lists all the databases available in the database server. See Table 3.9

Syntax:

```
mysql > show databases;
```

<table>
<thead>
<tr>
<th>Table 3.9 Database List</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database</td>
</tr>
<tr>
<td>test</td>
</tr>
<tr>
<td>mysql</td>
</tr>
<tr>
<td>employee</td>
</tr>
<tr>
<td>students</td>
</tr>
<tr>
<td>parents</td>
</tr>
</tbody>
</table>

3. **SHOW Tables** – Lists all the tables available in the current database we are working in. See Table 3.10

Syntax:

```
mysql > show tables;
```

<table>
<thead>
<tr>
<th>Table 3.10 Table List</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tables_in_test</td>
</tr>
<tr>
<td>school</td>
</tr>
<tr>
<td>salary</td>
</tr>
<tr>
<td>employee</td>
</tr>
<tr>
<td>library</td>
</tr>
<tr>
<td>sports</td>
</tr>
</tbody>
</table>

4. **SHOW COLUMNS FROM tablename** – Lists all the attributes, attribute type, Is Null value permitted, key information, default value and other information for the given table. The show columns for sports table is given below in Table 3.11.

Syntax:

```
mysql > show columns from sports;
```

5. **SHOW INDEX FROM tablename** – The query shows all the indexes for the given table.

Syntax:

```
mysql > show indexes from sports;
```

6. **SHOW TABLE STATUS LIKE tablename\G** – This command provides with detailed report on the performance of the table.

### 3.8.3 MySQL Installation

Download and install XAMPP Server Software from Internet. Refer Figure 3.14 to 3.23.

Click the Welcome Page Next Button

![Figure: 3.14 XAMPP Server executable file](image)
Select the Required component along with MYSQL component and click next button.
Choose The Installation Folder and click Next

![Figure: 3.17 XAMPP Server install path](image1)

Click Next Button in Setup ready page

![Figure: 3.18 XAMPP Server setup completion](image2)
Installation get started

![Figure: 3.19 XAMPP Server setup Progress window](image1)

After installing Click finish button and open the XAMPP Control panel

![Figure: 3.20 XAMPP Server setup completion](image2)

In the Control Panel start the Apache and MySQL Services one by one
The two services get started one by one.
Open the URL http://localhost/phpmyadmin URL in a browser to access MySQL database.

![PHP Myadmin Mysql Database server User interface](image)

Figure: 3.23 PHP Myadmin Mysql Database server User interface

### 3.9 MySQL Administration

#### open source software tools

**Types of software tools**

Many open source tools are available in the market to design the database in a better and efficient manner. PhpMyAdmin is most popular for Web Administration. The popular Desktop Application tools are MySQL Workbench and HeidiSQL.

**PHPMYADMIN (Web Admin)**

This administrative tool of MySQL is a web application written in PHP. They are used predominantly in web hosting. The main feature is providing web interface, importing data from CSV and exporting data to various formats. It generates live charts for monitoring MySQL server activities like connections, processes and memory usage. It also helps in making the complex queries easier.

**MySQL Workbench (Desktop Application)**

It is a database tool used by developers and DBA's mainly for visualization. This tool helps in data modeling, development of SQL, server configuration and backup for MySQL in a better way. Its basic release version is 5.0 and is now in 8.0 supporting all Operating Systems. The SQL editor of this tool is very flexible and comfortable in dealing multiple results set.

**HeidiSQL (Desktop Application)**

This open source tools helps in the administration of better database systems. It supports GUI (Graphical User Interface) features for monitoring server host, server connection, Databases, Tables, Views, Triggers and Events.
3.10 Designing Databases

The process of creating, implementing and maintaining the enterprise data in a system is known as Designing of databases. Better understanding of the application is necessary before designing the database. The performance and success of an application depends on good database design. MySQL provides performance dashboard, reports and statistics regarding the design of database.

Create Conceptual Design

It is the primary phase in database design, where detailed discussion about the creation of databases, tables, columns and data types is discussed based on the requirement of the application. As an end result the model is framed to attain the expectation of the application's end user.

- Create Database

The three major parts that forms a database are Tables, Queries and Views.

Tables - similar to an excel sheet, containing multiple rows and columns. Where each row is a record and each column is an attribute.

Queries – It is a question with multiple conditions posted to the database. The records in the database that satisfies the passed conditions are retrieved.

Views – A set of stored queries.

Example: create a database to store the personaldetails.

```sql
mysql> create database personaldetails;
Query Ok, 1 row affected
mysql> USE personaldetails;
```

- Create Table

In an application, each page reveals some functionality. Each such functions are designed to a table. For example, in an online shopping site like Amazon, multiple pages are maintained like customer profile, products, orders in cart and payment page. All these can be created as tables like Customer, Products, Order and Payment respectively.

- Create Columns

Each table will have many columns related to the functionality of the table. This column determines what values are stored in the table. For example, the Customer table contains the columns like firstname, lastname, phone, email, age, address and pincode. These columns hold the Customers information in the table. Each column is assigned with appropriate value type. The efficiency and performance of the table purely depends on the data types assigned to the columns.

- Insert Rows

Once the database is created, tables and the columns with the appropriate value type are defined. Then records are inserted to the table.
**3.11 SQL**

SQL - Structured Query Language is a standard language used for accessing and manipulating databases. It is declared as standard by American National Standards Institute (ANSI) and International Organization for Standardization (ISO) in 1986 and 1987 respectively.

<table>
<thead>
<tr>
<th>Table: 3.13 SQL DDL COMMANDS List</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Commands</strong></td>
</tr>
<tr>
<td>CREATE</td>
</tr>
<tr>
<td>ALTER</td>
</tr>
<tr>
<td>DROP</td>
</tr>
<tr>
<td>RENAME</td>
</tr>
<tr>
<td>TRUNCATE</td>
</tr>
</tbody>
</table>

**About SQL**
- Though SQL is standard language, different versions are maintained to meet out the requirements. Few major functions performed using SQL are listed below:
  - Executes queries against a database.
  - Retrieves data from database.
  - Inserts and updates records in a database
  - Delete records from database.
  - Creates new databases and new tables in a database.

**Data Manipulation Language (DML)**

These SQL commands deals with the manipulation of data present in the database. Most of SQL commands come under DML. INSERT, UPDATE, and DELETE commands belongs to this category. See Table 3.14

<table>
<thead>
<tr>
<th>Table: 3.14 SQL DML COMMANDS List</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Commands</strong></td>
</tr>
<tr>
<td>INSERT</td>
</tr>
<tr>
<td>UPDATE</td>
</tr>
<tr>
<td>DELETE</td>
</tr>
</tbody>
</table>

**Data Query Language (DQL)**

SELECT is the only SQL command used to fetch or retrieve the data from database tables that come under DQL. See Table 3.15

<table>
<thead>
<tr>
<th>Table: 3.15 SQL DQL COMMANDS List</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Commands</strong></td>
</tr>
<tr>
<td>SELECT</td>
</tr>
</tbody>
</table>
3.12 Basic SQL

Create/Drop /Selecting Database

Create Database – used to create new SQL Database. The Syntax and example to create studentDB is given below.

**Syntax:** `CREATE database databasename;`

**Example:** `mysql>create database studentDB;`

The database created now can be viewed using the following Syntax,

`mysql> Show databases;`

As a result, the newly created studentDB will be listed.

Drop Database – used to remove any of the existing SQL Database. The Syntax and example to delete student DB is given below.

**Syntax:** `DROP database databasename;`

**Example:** `mysql> DROP database studentDB;`

The deleted database will not be viewed when we list all databases using the Syntax, `Show databases;`

Select Database – Many databases are available in the repository, from which the suitable database is selected using the below command.

**Syntax:** `USE databasename;`

**Example:** `mysql>USE studentDB;`

Once the database is selected, multiple operations are performed as per the needs of the application.

### Transaction Control Language (TCL)

These SQL commands manage the transactions in SQL databases. It also helps to save the change into database permanently. COMMIT, ROLLBACK, SET TRANSACTION and SAVEPOINT commands belongs to this category. See Table 3.16

<table>
<thead>
<tr>
<th>Commands</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMMIT</td>
<td>Permanent save into database.</td>
</tr>
<tr>
<td>ROLLBACK</td>
<td>Restore database to original form since the last COMMIT.</td>
</tr>
<tr>
<td>SET TRANSACTION</td>
<td>SET TRANSACTION command set the transaction properties such as read-write or read only access.</td>
</tr>
<tr>
<td>SAVE POINT</td>
<td>used to temporarily save a transaction so that we can rollback to that point whenever required.</td>
</tr>
</tbody>
</table>

### Data Control Language (DCL)

The SQL commands that implement security on database objects like table, view, stored procedure etc. GRANT and REVOKE commands belongs to this category. See Table 3.17

<table>
<thead>
<tr>
<th>Commands</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grant</td>
<td>used to give permission to specific users on specific database objects like table, view etc</td>
</tr>
<tr>
<td>Revoke</td>
<td>used to take out permission from specific users on specific database objects like table, view etc.</td>
</tr>
</tbody>
</table>
Insert Record
Database will have multiple tables. Tables are created using the create command with various fields added to it as per their need. Any table is complete only with the record available in it. So new row are added to the table using the Insert command. The Syntax and example for inserting new record into the table is given below:

**Syntax 1:**
INSERT INTO tablename (column1, column2, column3) VALUES (value1, value2, value3);

**Syntax 2:**
INSERT INTO tablename VALUES (value1, value2, value3);

Consider we have a table named Biodata, which has three columns namely firstname, lastname and age. Now the new record is added to the table using either Syntax1 or Syntax2 as shown below.

```
mysql> INSERT INTO Biodata (firstname, lastname, age)
VALUES (Krishna, Sam, 10);
```

(or)

```
mysql> INSERT INTO Biodata VALUES (Krishna, Sam, 10);
```

Select Record
From the multiple records available in the table, the enquired data are retrieved from the table using the SELECT command with some conditions specified in it. We can retrieve all the fields of a record or specify the necessary fields in a table. The records of any table are retrieved using the

**SELECT Syntax** given below in Table 3.18 and 3.19

**Syntax1:** SELECT * from tablename;

Example: `mysql>SELECT * from Biodata;`

<table>
<thead>
<tr>
<th>Table:3.18 SQL Select Record List</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Firstname</strong></td>
</tr>
<tr>
<td>Krishna</td>
</tr>
<tr>
<td>Sugal</td>
</tr>
<tr>
<td>Arun</td>
</tr>
<tr>
<td>Mani</td>
</tr>
</tbody>
</table>

**Syntax2:** SELECT column1, column2 from tablename;

Example: `mysql>SELECT firstname, age from Biodata;`

<table>
<thead>
<tr>
<th>Table:3.19 SQL Select Record List</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Firstname</strong></td>
</tr>
<tr>
<td>Krishna</td>
</tr>
<tr>
<td>Sugal</td>
</tr>
<tr>
<td>Arun</td>
</tr>
<tr>
<td>Mani</td>
</tr>
</tbody>
</table>

Deleting Record
The existing record in a table is removed from the table using DELETE command. Entire record or specified columns in the table can be deleted. If we want to perform delete operation on specific columns, then that condition is given in the WHERE condition. If the condition is not specified, then the entire data will be deleted. See Table 3.20 and 3.21

**Syntax1:** DELETE from tablename WHERE columnname=“value”;

Example: `mysql>DELETE from Biodata WHERE firstname=“Mani”;`
Using Operators

While forming the SQL query we use major operators like Arithmetic, Comparison and Logical in the WHERE clause. The purpose of each operator is listed below in Table 3.22.

<table>
<thead>
<tr>
<th>Table:3.22 MySQL Operators</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operator Type</td>
</tr>
<tr>
<td>Arithmetic Operator</td>
</tr>
<tr>
<td>Comparison Operator</td>
</tr>
</tbody>
</table>

Sorting Records

The Query results are listed in Ascending or Descending order using the command ORDER BY. In some databases the results are sorted by default in Ascending order and is given in Syntax1. The results are displayed in descending order as per Syntax2. See Table 3.23 and 3.24

| Syntax1: select * from tablename ORDER BY columnname; |
| Example: mysql>select * from Biodata ORDER BY firstname; |

WHERE Clause

In SQL command WHERE clause is used to specify the selection criteria Based on that data's are retrieved or modified as per the query. In the WHERE conditions, operations like =, !=, >, >=, <, <= are used to frame the query statement. WHERE clause is used in SELECT and UPDATE query statement for the condition. The number of records updated in a table depends on the WHERE condition.

<table>
<thead>
<tr>
<th>Table:3.20 SQL Delete Record List</th>
</tr>
</thead>
<tbody>
<tr>
<td>firstname</td>
</tr>
<tr>
<td>Krishna</td>
</tr>
<tr>
<td>Sugal</td>
</tr>
<tr>
<td>Arun</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table:3.21 SQL Delete Record List</th>
</tr>
</thead>
<tbody>
<tr>
<td>firstname</td>
</tr>
<tr>
<td>Krishna</td>
</tr>
<tr>
<td>Sugal</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table:3.23 Select Record List</th>
</tr>
</thead>
<tbody>
<tr>
<td>firstname</td>
</tr>
<tr>
<td>Arun</td>
</tr>
<tr>
<td>Krishna</td>
</tr>
<tr>
<td>Sugal</td>
</tr>
</tbody>
</table>

| Syntax2: DELETE from tablename; |
| Example: mysql>DELETE from Biodata ; |

Modifying Record

SQL provides us with modifying and updating the existing records in a table using UPDATE command. The age of Krishna in Biodata table is changed using the below Syntax.

<table>
<thead>
<tr>
<th>Syntax1: UPDATE tablename</th>
</tr>
</thead>
<tbody>
<tr>
<td>SET column1=&quot;new value&quot;</td>
</tr>
<tr>
<td>WHERE column2=&quot;value2&quot;;</td>
</tr>
<tr>
<td>Example: mysql&gt;UPDATE Biodata SET age=13 WHERE firstname=&quot;Krishna&quot;;</td>
</tr>
</tbody>
</table>

WHERE Clause

In SQL command WHERE clause is used to specify the selection criteria Based on that data's are retrieved or modified as per the query. In the WHERE conditions, operations like =, !=, >, >=, <, <= are used to frame the query statement. WHERE clause is used in SELECT and UPDATE query statement for the condition. The number of records updated in a table depends on the WHERE condition.
Syntax2: select * from tablename ORDER BY columnname DESC;

Example: select * from Biodata ORDER BY firstname DESC;

**Grouping Records, Having Clause**

In SQL we can have identical data in a group. Consider a table named Exams with fields Rollno, Subject and Marks. In the below table multiple rows of records are available for different subjects. Using the GROUP BY command, the rollno's are grouped and marks are added up against the Rollno with SUM(marks). See Table 3.25 and 3.26.

<table>
<thead>
<tr>
<th>Rollno</th>
<th>Subject</th>
<th>Marks</th>
</tr>
</thead>
<tbody>
<tr>
<td>201901</td>
<td>Tamil</td>
<td>81</td>
</tr>
<tr>
<td>201904</td>
<td>English</td>
<td>75</td>
</tr>
<tr>
<td>201901</td>
<td>English</td>
<td>96</td>
</tr>
<tr>
<td>201903</td>
<td>Tamil</td>
<td>92</td>
</tr>
<tr>
<td>201902</td>
<td>Tamil</td>
<td>78</td>
</tr>
<tr>
<td>201904</td>
<td>Tamil</td>
<td>83</td>
</tr>
<tr>
<td>201903</td>
<td>English</td>
<td>81</td>
</tr>
<tr>
<td>201905</td>
<td>Tamil</td>
<td>89</td>
</tr>
<tr>
<td>201902</td>
<td>English</td>
<td>80</td>
</tr>
<tr>
<td>201905</td>
<td>English</td>
<td>90</td>
</tr>
</tbody>
</table>

**Joining Tables**

When we have to select data from more than 2 tables SQL JOIN clause is used. Consider two tables Exams and Profile. The Exams table has the fields Rollno, Subject and Marks. The data of Profile table is shown below in Table 3.27 & 3.28.

<table>
<thead>
<tr>
<th>Rollno</th>
<th>Name</th>
<th>Hobby</th>
</tr>
</thead>
<tbody>
<tr>
<td>201901</td>
<td>Krishna</td>
<td>Gardening</td>
</tr>
<tr>
<td>201902</td>
<td>Sugal</td>
<td>Photography</td>
</tr>
<tr>
<td>201903</td>
<td>Charles</td>
<td>Reading</td>
</tr>
<tr>
<td>201904</td>
<td>Venilla</td>
<td>Singing</td>
</tr>
<tr>
<td>201905</td>
<td>Pragathi</td>
<td>Painting</td>
</tr>
</tbody>
</table>

SELECT Profile.Name, Profile.Hobby, SUM(Exams.Marks)As Total
FROM Profile, Exams
WHERE Profile.Rollno = Exams.Rollno
GROUP BY Profile.Name, Profile.Hobby;
In the Query Statement, the marks are added and listed under the column name Total for each of the Rollno from both the tables.

**Sub queries**

Here the SQL query is written within a main Query. This is called as Nested Inner/SubQuery. The sub query is executed first and the results of sub query are used as the condition for main query. The sub query must follow the below rules:

1. Subqueries are always written within the parentheses.
2. Always place the Subquery on the right side of the comparison operator.
3. ORDER BY clause is not used in sub query, since Subqueries cannot manipulate the results internally.

Consider the Employee table with the fields EmpID, Name, Age and Salary. The sample data is given below in Table 3.29.

<table>
<thead>
<tr>
<th>EmpID</th>
<th>Name</th>
<th>Age</th>
<th>Salary</th>
</tr>
</thead>
<tbody>
<tr>
<td>101</td>
<td>Ram</td>
<td>35</td>
<td>15000</td>
</tr>
<tr>
<td>102</td>
<td>Gopal</td>
<td>41</td>
<td>30000</td>
</tr>
<tr>
<td>103</td>
<td>Priya</td>
<td>32</td>
<td>13000</td>
</tr>
<tr>
<td>104</td>
<td>Hari</td>
<td>37</td>
<td>20000</td>
</tr>
</tbody>
</table>

In the below Query, we use sub query in an SELECT statement.

SELECT * from Employee
where EmpID IN (SELECT EmpID from Employee WHERE Salary < 20000);

First, the inner query is executed. As a result EmpID 101 and 103 are retrieved. Now the external or outer query is executed. Internally the query is SELECT * from Employee where EmpID IN(101,103) and the output is drawn below in Table 3.30.

<table>
<thead>
<tr>
<th>EmpID</th>
<th>Name</th>
<th>Age</th>
<th>Salary</th>
</tr>
</thead>
<tbody>
<tr>
<td>101</td>
<td>Ram</td>
<td>35</td>
<td>15000</td>
</tr>
<tr>
<td>103</td>
<td>Priya</td>
<td>32</td>
<td>13000</td>
</tr>
</tbody>
</table>

Similarly the subqueries are used with INSERT, UPDATE and DELETE.
**Backup**

It is a program or process of copying table contents into a file for future reference. It’s a challenging task for DBAs.

**Primary Key**

This key of relational table identifies each record in the table in a unique way.

**Relationship**

There exists a relationship between two tables when the foreign key of one table references primary key of other table.

**Cardinality**

It is defined as the number of different values in any given table column.

**Open Source**

Open source – refers to the design that is publicly accessible by people for modification and sharing.

**SQL**

It (Structured query Language) is a programming language designed mainly for managing data in RDBMS.

**Record**

Record is referred in a table, which are composed of fields.

**Query**

In SQL, all commands are named as query. The query statement is executed against the databases.

**Join**

Retrieves data from two or more tables, by referencing columns in the tables that hold identical values.

---

**Part - I**

**Choose the correct answer**

1. Which language is used to request information from a Database?
   a) Relational
   b) Structural
   c) Query
   d) Compiler

2. The _________ diagram gives a logical structure of the database graphically?
   a) Entity-Relationship
   b) Entity
   c) Architectural Representation
   d) Database

3. An entity set that does not have enough attributes to form primary key is known as
   a) Strong entity set
   b) Weak entity set
   c) Identity set
   d) Owner set

4. _________ Command is used to delete a database.
   a) Delete database database_name
   b) Delete database_name
   c) drop database database_name
   d) drop database_name
5. Which type of below DBMS is MySQL?
   a) Object Oriented
   b) Hierarchical
   c) Relational
   d) Network

6. MySQL is freely available and is open source.
   a) True
   b) False

7. _________ represents a “tuple” in a relational database?
   a) Table
   b) Row
   c) Column
   d) Object

8. Communication is established with MySQL using
   a) SQL
   b) Network calls
   c) Java
   d) API’s

9. Which is the MySQL instance responsible for data processing?
   a) MySQL Client
   b) MySQL Server
   c) SQL
   d) Server Daemon Program

10. The structure representing the organizational view of entire database is known as _______ in MySQL database.
    a) Schema
    b) View
    c) Instance
    d) Table

Part - II
Short Answers
1. Define Data Model and list the types of data model used.
2. List few disadvantages of file processing system.
4. List any two DDL and DML commands with its Syntax.
5. What are the ACID properties?
6. Which command is used to make permanent changes done by a transaction?
7. What is view in SQL?
8. Write the difference between SQL and MySQL.
9. What is Relationship and List its types.
10. State few advantages of Relational databases.

Part - III
Explain in Brief Answer
1. Explain on Evolution of DBMS.
2. What is relationship in databases? List its types.
3. Discuss on Cardinality in DBMS.
4. List any 5 privileges available in MySQL for the User.
5. Write few commands used by DBA to control the entire database.
Part - IV

Explain in detail

1. Discuss on various database models available in DBMS.
2. List the basic concepts of ER Model with suitable example.
3. Discuss in detail on various types of attributes in DBMS.
4. Write a note on open source software tools available in MySQL Administration.
5. Explain in detail on Sub Queries with suitable examples.
4.1 Introduction to Hypertext Pre-Processor (PHP)

Internet and Web based online applications are performing a very important role in business and entertainment industry. Two decades back, a famous quote “If your business establishment is not on the Internet (online based), then your business will be out of business context.” Founder of Microsoft- Bill Gates

The Web based Internet application ensures the success of critical business in real world competitions. The legacy programing languages didn't meet out the expectations of latest Internet concepts and executions.

In earlier 1990's British scientist Tim Berners-Lee introduced the concept of Internet and World Wide Web (WWW). These concepts required a new set of programming languages over the network communication. These programming languages are recently called as Web scripting languages.

The Web scripting languages has many policies which is easy to handle and solve the critical business problems around the world. In Later 1990's many Web scripting languages was introduced to support the Internet online business.

PHP is one of the most widely used and recognizable technologies in use on the internet. Originally PHP stood for "Personal Home Page", though more recently it has been changed to stand for "PHP: Hypertext Preprocessor". However, no matter what it is called, PHP is a fundamental part of any dynamic web page.

PHP (Hypertext Pre-processor) is a one of the important server side Web
and general purpose scripting language invented by Rasmus Lerdorf in 1994. It is very simple and lightweight open source server side scripting language. It can easily embed with HTML and other client side scripting languages like CSS (Cascading Style Sheets) and Java script. It also creates dynamic and interactive Webpages in the real time Web development projects.

It is a competitor and alternative for other server side scripting languages like Microsoft ASP (Active Server Page) and JSP (Java Server page). Recent statistics of server side scripting language usage depict that 78.9 % of Website are developed by PHP scripting language. PHP is an open source community development initiation. It has many versions to ensure quality and ease of Web development activities. The current version of PHP, 7.3 is released by the official team on 30 November 2017.

### 4.3 Client Server Architecture

In the evolution of network architecture, various critical networks related problems are getting resolved by client server architecture model. The client server architecture introduces application sharing mechanism between two different hardware systems over the network (Internet/intranet). In 1990’s Internet was emerging in the computer network field. The main objective of Internet implies that an application is shared by more than one hardware either it could be a server or client machine.

The server is a high performance hardware machine it could run more than one application concurrently. The client is a separate hardware machine which is connected with server in the network (Internet/intranet). It could send the request and receive the response from the server hardware. The Server and client are also called as service provider and service requester respectively.

<table>
<thead>
<tr>
<th>Language</th>
<th>Global Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>PHP</td>
<td>78.9%</td>
</tr>
<tr>
<td>ASP.NET</td>
<td>12.0%</td>
</tr>
<tr>
<td>Java</td>
<td>3.9%</td>
</tr>
<tr>
<td>Static files</td>
<td>2.2%</td>
</tr>
<tr>
<td>Ruby</td>
<td>2.2%</td>
</tr>
<tr>
<td>Scala</td>
<td>1.2%</td>
</tr>
<tr>
<td>Python</td>
<td>1.2%</td>
</tr>
<tr>
<td>JavaScript</td>
<td>0.6%</td>
</tr>
<tr>
<td>ColdFusion</td>
<td>0.5%</td>
</tr>
<tr>
<td>Perl</td>
<td>0.3%</td>
</tr>
<tr>
<td>Erlang</td>
<td>0.1%</td>
</tr>
</tbody>
</table>

**Figure 4.1 Server side Scripting Language Comparison**

**4.2 Various Server-side Programming Languages Global Usage Statistics**

PHP scripting language can be executed via an interpreter which is installed in the Webservers or CGI (Common Gateway Interface). The most of the Webservers such as Apache Tomcat, Microsoft IIS (Internet Information server) supports the PHP interpreter module. Refer Figure 4.1

PHP is an open source community development initiation. It has many versions to ensure quality and ease of

**Figure 4.2 Client Server Architecture Model**
Client Server Architecture Model

Client server architecture shown above in Figure 4.2 is classified into three types, as follows:

- Single Tier Architecture
- Two Tier Architecture
- N/Multi/Three tire architecture

Single Tier Architecture

This architecture is used for the server, accessed by client. The client application runs inside the server machine itself. This acts as a single layer interaction as in Figure 4.3.

Multi/Three Tier Architecture:

This architecture is used for the server, accessed by client through more than one layer interaction. The programmer could decide the count of business logic layers according to the software requirement that is the reason this model is also known as Multi Three Tire Architecture as shown in Figure 4.5.

![Multi/Three Tier Architecture](image)

Most of the server side scripting languages are working on any one the client server architecture model. Webserver is software which is running in server hardware. It takes the responsibilities for compilation and execution of server side scripting languages.

4.4 Server side scripting language

Web scripting languages are classified into two types, client side and server side scripting language. PHP is completely different from Client side scripting language like Java script. The PHP code entirely executes on Webserver which is installed in the remote machine and it is generating HTML code which is sent to the user. The user receives the HTML code...
and sees the Website contents via Internet browser in their computer or laptop. PHP also supports OOPs (Object Oriented Programming) concepts. It is applicable to implement all OOPs features such as class, object and inheritance etc. The action is shown in Figure 4.6.

Figure 4.6 Website Request and Response from Web server to Browser

4.5 Web Server Installation & Configuration Files

Web server software that runs on server hardware, governs the server side scripting compilation into an intermediate byte-code that is then interpreted by the runtime engine.

Web server software is available as open source or licensed version in the market. Recent statistics of Web server usage depict that more than 130% Websites are running under the open source Web servers such as Tomcat Apache, Nginx etc. Refer Figure 4.7.

The following are the steps to install and configure Apache Httpd Webserver and PHP module in windows server machine.

Step 1:
Go to Apache foundation Website and download the Httpd Webserver Software.

https://httpd.apache.org/download.cgi

Step2:
After downloading .MSI file from Apache foundation Website, user launches the .MSI file and clicks next and next button to finish the installation on server machine. The software takes default port number 130 or 130130. Once the user finished, the Web server software is installed and configured on server hardware machine as a service.

Step 3:
To test the installation of Apache Httpd Webserver, enter the following URL from your Web browser which is installed in your client machine.

https://localhost:130/ or https://localhost:130130

The output page that says “Its works”

Step 4:
Administrator user can start, stop and restart the Web server service at any time via windows Control panel. Once the services stops, the client machine will not receive the response message from server machine.

Figure 4.7 Webserver global usage
Step 5:
Webserver's configuration setting file “httpd.conf” is located in the conf directory under the apache installation directory. Edit this file and enable the PHP module to run PHP scripting language.

4.6 Web Development Concept

Web development concept describes in detail about Website development and hosting through network (Internet/Intranet). The process of development also includes Web content generation, Web page designing, Website security and so on.

4.6.1 How PHP Script Work
Website or Web page is developed by the programmer using PHP script. Finally the entire Website codes are moved to Web server path in a remote server machine.

From client side, the end user opens a browser, types the URL of the Website or Webpage and initiates the request to remote server machine over the network.

After receiving the request from client machine the Web server tries to compile and interpret the PHP code which is available in remote machine. Next a response will be generated and sent back to the client machine over the network from Webserver.

Finally the browser which is installed in the client machine receives the response and displays the output to user, as shown in Figure 4.8

4.6.2 PHP Syntax
Three types of PHP Syntax are available. They are as follows
1. Default Syntax
2. Short open Tags
3. HTML Script embed Tags
**Default Syntax:**
The default Syntax begins with “<?php” and closes with “?>”. Also refer Figure 4.9

**Short open Tags**
The Short open Tags begins with “<?” and closes with “?>”. But admin user has to enable Short style tags settings in php.ini file on the server. Refer the syntax in Figure 4.10

**HTML Script embed Tags:**
HTML Script embed Tags looks just like HTML scripts tags. The syntax is shown in Figure 4.11.

The above syntax is created and saved in a file with extension of .php. This .php file is ready to execute from Webserver and generate response to client machine.

**4.6.3 Embed PHP in HTML**
PHP script can be written in side of HTML code and save the file with extension of .php. The embedded PHP file get executed in the Webserver, the browser receives only the HTML and other client side files. None of the raw PHP code is visible in browser which means that PHP interpreter produces raw HTML files to browsers in the client machine. Refer Figure 4.12 for Web response
4.6.4 Variable in PHP

PHP has variables like other programming languages such as C, C++ and Python etc. Variables are the storage location, which can store the values for the later manipulations in the program.

The variable in PHP begins with a dollar ($) symbol and the assignment activity implemented using “=” operator, finally the statement ends with semi colon “;” The semicolon indicates the end of statement.

The main advantage of the PHP variable declaration is, it does not requires to specify the data type keyword separately such as int, char, float, double or string etc.

Basic Rules for Variable Declaration

- Variable name must always begin with a $ symbol.
- Variable name can never start with a number.
- Variable names are case-sensitive.

Example:
```
<?php
    $x = “Computer Application!”;
    $y = ‘Computer Application’;
    echo $x;
    echo “<br>”;
    echo $y;
?>
```

Integer:

Integer is a data type which contains non decimal numbers.

Example:
```
<?php
    $x = 59135;
    var_dump($x);
?>
```

The var_dump() system define function, returns structured information (type and value) about variables in PHP.

Float:

Float is a data type which contains decimal numbers.

Example:
```
<?php
    $x = 19.15;
    var_dump($x);
?>
```

4.6.5 PHP Data Type

PHP scripting language supports 13 primitive data types. Data Types plays important role in all programming languages to classify the data according to the logics. PHP supports the following data types.

1. String
2. Integer
3. Float
4. Boolean
5. Array
6. Object
7. NULL
8. Resource
Boolean:
Boolean is a data type which denotes the possible two states, TRUE or FALSE.

Example:
```php
<?php
class School {
    function marks() {
        $this->sec = "A";
    }
}
// create an object
$school_obj = new School();
// show object properties
echo $school_obj->sec;
?>
```

Array:
Array is a data type which has multiple values in a single variable.

Example:
```php
<?php
$x = "COMPUTER APPLICATION!";
$x = null;
var_dump($x);
?>
```

OUTPUT:
```
NULL
```

Var_dump:
The var_dump() function is used to dump information about a variable. This function displays structured information such as type and value of the given variable. Arrays and objects are explored recursively with values indented to show structure.

Object:
PHP object is a data type which contains information about data and function inside the class.

NULL:
Null is a special data type which contains a single value: NULL.

Resources
Resource is a specific variable, it has a reference to an external resource. These variables hold specific handlers to handle files and database connections in respective PHP program.

```php
<?php
// Open a file for reading
$handle = fopen("note.txt", "r");
var_dump($handle);
echo "<br>
// Connect to MySQL database server with default setting
$link = mysql_connect("localhost", "root", "");
var_dump($link);
?>
```

Boolean:
Boolean is a data type which denotes the possible two states, TRUE or FALSE.

Example:
```php
<?php
$x = true;
$y = false;
echo $x;
echo $y;
?>
```

Array:
Array is a data type which has multiple values in a single variable.

Example:
```php
<?php
$cars = array("Computer", "Laptop", "Mobile");
var_dump($cars);
?>
```

OUTPUT:
```
array(3) { [0] => string(5) "Computer " [1] => string(3) "Laptop " [2] => string(6) "Mobile " }
```

Var_dump:
The var_dump() function is used to dump information about a variable. This function displays structured information such as type and value of the given variable. Arrays and objects are explored recursively with values indented to show structure.

Object:
PHP object is a data type which contains information about data and function inside the class.
4.6.6. **Operators in PHP**

Operator is a symbol which is used to perform mathematical and logical operations in the programming languages. Different types of operator in PHP are:

1. Arithmetic operators,
2. Assignment operators,
3. Comparison operators,
4. Increment/Decrement operators,
5. Logical operators, and

**Arithmetic operators**

The arithmetic operators in PHP perform general arithmetical operations, such as addition, subtraction, multiplication and division etc. Refer Table 4.1.

<table>
<thead>
<tr>
<th>Table 4.1 PHP Arithmetic operators</th>
</tr>
</thead>
<tbody>
<tr>
<td>Symbol</td>
</tr>
<tr>
<td>+</td>
</tr>
<tr>
<td>-</td>
</tr>
<tr>
<td>*</td>
</tr>
<tr>
<td>/</td>
</tr>
<tr>
<td>%</td>
</tr>
</tbody>
</table>

**Assignment Operators:**

Assignment operators are performed with numeric values to store a value to a variable. The default assignment operator is “=”. This operator sets the left side operant value of expression to right side variable. Refer Table 4.2.

<table>
<thead>
<tr>
<th>Table 4.2 PHP Assignment operators</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignment</td>
</tr>
<tr>
<td>x = y</td>
</tr>
<tr>
<td>x += y</td>
</tr>
<tr>
<td>x -= y</td>
</tr>
<tr>
<td>x *= y</td>
</tr>
<tr>
<td>x /= y</td>
</tr>
<tr>
<td>x %= y</td>
</tr>
</tbody>
</table>
Comparison Operators:

Comparison operators perform an action to compare two values. These values may contain integer or string data types (Number or Strings). Refer Table 4.3.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Operator Name</th>
<th>Symbol</th>
<th>Operator Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>==</td>
<td>Equal</td>
<td>&gt;</td>
<td>Greater than</td>
</tr>
<tr>
<td>===</td>
<td>Identical</td>
<td>&lt;</td>
<td>Less than</td>
</tr>
<tr>
<td>!=</td>
<td>Not equal</td>
<td>&gt;=</td>
<td>Greater than or equal to</td>
</tr>
<tr>
<td>&lt;&gt;</td>
<td>Not equal</td>
<td>&lt;=</td>
<td>Less than or equal to</td>
</tr>
<tr>
<td>!==</td>
<td>Not identical</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Increment and Decrement Operators:

Increment and decrement operators are used to perform the task of increasing or decreasing variable's value. This operator is mostly used during iterations in the program logics. Refer Table 4.4.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>++$x</td>
<td>Pre-increment</td>
<td>Increments $x value by one, then returns $x</td>
</tr>
<tr>
<td>$x++</td>
<td>Post-increment</td>
<td>Returns $x, then increments $x by one</td>
</tr>
<tr>
<td>--$x</td>
<td>Pre-decrement</td>
<td>Decrements $x by one, then returns $x</td>
</tr>
<tr>
<td>$x--</td>
<td>Post-decrement</td>
<td>Returns $x, then decrements $x by one</td>
</tr>
</tbody>
</table>

Logical Operators:

Logical Operators are used to combine conditional statements. Refer Table 4.5.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Operator Name</th>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>&amp;&amp;</td>
<td>And</td>
<td>$x &amp;&amp; $y</td>
<td>True if both $x and $y are true</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Or</td>
</tr>
<tr>
<td>!</td>
<td>Not</td>
<td>!$x</td>
<td>True if $x is not true</td>
</tr>
<tr>
<td>xor</td>
<td>Xor</td>
<td>$x xor $y</td>
<td>True if either $x or $y is true, but not both</td>
</tr>
</tbody>
</table>
String Operators:
Two operators are used to perform string related operations such as Concatenation and Concatenation assignment (Appends). Refer Table 4.6.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Name</th>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>.</td>
<td>Concatenation</td>
<td>$text1 . $text2</td>
<td>Concatenation of $txt1 and $txt2</td>
</tr>
<tr>
<td>.=</td>
<td>Concatenation assignment</td>
<td>$text1 .=$text2</td>
<td>Appends $txt2 to $txt1</td>
</tr>
</tbody>
</table>

POINTS TO REMEMBER

- PHP is an Open Source
- PHP is a Case Sensitive
- PHP is a Simplicity Program language
- PHP is a Efficiency Program language
- PHP is a Platform Independent Program language
- PHP is a Security Program language
- PHP is a Flexibility Program language
- PHP is a Real-Time Access Monitoring Program language

GLOSSARY

<table>
<thead>
<tr>
<th>PHP</th>
<th>PHP abbreviated as “HYPER TEXT PREPROCESSOR”. It is a server-side scripting language</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL</td>
<td>Uniform Resource Locator, the address of a specific Web page or file on the Internet.</td>
</tr>
<tr>
<td>HTTP</td>
<td>HTTP means HyperText Transfer Protocol. HTTP is the underlying protocol used by the World Wide Web and this protocol defines how messages are formatted and transmitted, and what actions Web servers and browsers should take in response to various commands</td>
</tr>
</tbody>
</table>
### Webserver
A Web server is a Software that uses HTTP (Hypertext Transfer Protocol) to serve the files that form Web pages to users.

### Web Browser
A Web browser (commonly referred to as a browser) is a software application for accessing information on the World Wide Web. Each individual Web page, image, and video is identified by a distinct URL, enabling browsers to retrieve and display them on the user’s device.

### SERVER
A server is a computer or a device that provides functionality for other programs or devices, called “clients”. This architecture is called the client server model, and a single overall computation is distributed across multiple processes or devices.

#### EVALUATION

**Part - I**

**Choose the correct answer**

1. What does PHP stand for?
   a) Personal Home Page  
   b) Hypertext Preprocessor  
   c) Pretext Hypertext Processor  
   d) Pre-processor Home Page

2. What does PHP files have a default file extension?
   a) .html  
   b) .xml  
   c) .php  
   d) .ph

3. A PHP script should start with ___ and end with ___:
   a) <php>  
   b) < ? php ?>  
   c) < ? >  
   d) < ?php >

4. Which of the following must be installed on your computer so as to run PHP script?
   a) Adobe  
   b) windows  
   c) Apache  
   d) IIS

5. We can use ___ to comment a single line?
   i) /*  
   ii) //  
   iii) #  
   iv) /* */
   a) Only (ii)  
   b) (i), (iii) and (iv)  
   c) (ii), (iii) and (iv)  
   d) Both (ii) and (iv)
6. Which of the following PHP statement/statements will store 41 in variable num?
   a) Both (i) and (ii)
   b) All of the mentioned.
   c) Only (iii)
   d) Only (i)

7. What will be the output of the following PHP code?
   < ?php
   $num = 1;
   $num1 = 2;
   print $num . “+”. $num1 ;
   ?>
   a) 3
   b) 1+2
   c) 1.+2
   d) Error

8. Which of the following PHP statements will output Hello World on the screen?
   a) echo (“Hello World”);
   b) print (“Hello World”);
   c) printf (“Hello World”);
   d) sprintf (“Hello World”);

9. Which statement will output $x on the screen?
   a) echo “\$x”;
   b) echo “$$x”;
   c) echo “/\$x”;
   d) echo “$x;

10. Which of the below symbols is a newline character?
    a) \r
    b) \n
Part - II
Short Answers
1. What are the common usages of PHP?
2. What is Webserver?
3. What are the types scripting language?
4. Difference between Client and Server?
5. Give few examples of Web Browser?
6. What is URL?
7. Is PHP a case sensitive language?
8. How to declare variables in PHP?
10. Define Webserver.

Part - III
Explain in Brief Answer
1. Write the features of server side scripting language.
2. Write is the purpose of Web servers?
3. Differentiate Server side and Client Side Scripting language.
4. In how many ways you can embed PHP code in an HTML page?
5. Write short notes on PHP operator.
Part - IV

**Explain in detail**

1. Explain client side and server side scripting language.
2. Discuss in detail about Website development activities.
3. Explain the process of Webserver installation.
4. Discuss in detail about PHP data types.
5. Explain operators in PHP with example.

---

**STUDENT ACTIVITY**

Find out the following web technology details from famous website using free web tools: http://similarweb.com or http://pub-db.com

1. Programming details
2. Webserver details
3. Hosting Country details
The Function can be divided into three types as follows:
- User defined Function,
- Pre-defined or System or built-in Function, and
- Parameterized Function.

**User Defined Function**

User Defined Function (UDF) in PHP gives a privilege to user to write own specific operation inside of existing program module. Two important steps the Programmer has to create for users define Functions are:

1. **Function Declaration**
   - A user-defined Function declaration begins with the keyword “function”. User can write any custom logic inside the function block.

```
function functionName() {
    Custom Logic code to be executed;
}
```

**PHP Function and Array**

In PHP server side scripting language, Functions and array concepts are very important to solve the many complex problems in real world.

- PHP has over 700 functions built in that perform different tasks. Built in functions are functions that exist in PHP installation package.

### Functions in PHP

In most of the programming language, a block of segment in a program that performs a specific operation tasks (Insert, Execute, Delete, Calculate, etc.). This segment is also known as Function. A Function is a type of sub routine or procedure in a program. A Function will be executed by a call to the Function and the Function returns any data type values or NULL value to called Function in the part of respective program.
**Function Calling:**
A function declaration part will be executed by a call to the function. Programmer has to create Function Calling part inside the respective program.

**SYNTAX:**
functionName();

**Example:**
```php
<?php
function insertMsg() {
   echo "Student Details Inserted Successfully!";
}
insertMsg(); // call the function
?>
```

### 5.1 Parameterized Function

Required information can be shared between function declaration and function calling part inside the program.

The parameter is also called as arguments, it is like variables.

The arguments are mentioned after the function name and inside of the parenthesis. There is no limit for sending arguments, just separate them with a comma notation.

**Example 1:**
The following example has a function with one Argument ($sname):
```php
<?php
function School_Name($sname) {
   echo $sname."in Tamilnadu.<br>
}
School_Name ("Government Higher Secondary School Madurai");
School_Name ("Government Higher Secondary School Trichy");
School_Name ("Government Higher Secondary School Chennai");
School_Name ("Government Higher Secondary School Kanchipuram");
School_Name ("Government Higher Secondary School Tirunelveli");
?>
```

**Example 2:**
The following example has a function with two arguments ($sname and $Strength):
```php
<?php
function School_Name($sname,$Strength) {
   echo $sname."in Tamilnadu and Student Strength is".$Strength;
}
```
School_Name ("Government Higher Secondary School Madurai",200);
School_Name ("Government Higher Secondary School Trichy",300);
School_Name ("Government Higher Secondary School Chennai",250);
School_Name ("Government Higher Secondary School Kanchipuram",100);
School_Name ("Government Higher Secondary School Tirunelveli",200);
?>

Example 3:
For a function to return a value, use the return statement

```php
<?php
function sum($x, $y) {
    $z = $x + $y;
    return $z;
}

echo "5 + 10 = " . sum(5, 10) . "<br>";
echo "7 + 13 = " . sum(7, 13) . "<br>";
echo "2 + 4 = " . sum(2, 4);
?>
```

5.2 Array in PHP

Array is a concept that stores more than one value of same data type (homogeneous) in single array variable. They are 3 types of array concepts in PHP.

- Indexed Arrays,
- Associative Array and
- Multi-Dimensional Array.

5.2.1 Syntax:

**Array Syntax:**

Array defines with the keyword `array()`

One of the most useful aspects of using arrays in PHP is when combined with the `foreach` statement. This allows you to quickly loop though an array with very little code.
**Associative Arrays Syntax**

array(key=>value,key=>value,key=>value,etc.);

- **key** = Specifies the key (numeric or string)
- **value** = Specifies the value

### 5.2.2 Indexed Arrays

Arrays with numeric index for the available values in array variable which contains key value pair as user / developer can take the values using keys. Refer Figure 5.1.

**Example:**

```php
<?php
$teacher_name=array("Iniyan", "Kavin", "Nilani");
?>
```

### 5.2.3 Associative Arrays

Associative arrays are a key-value pair data structure. Instead of having storing data in a linear array, with associative arrays you can store your data in a collection and assign it a unique key which you may use for referencing your data.

**Example:**

```php
<?php
$Marks=array("Student1"=>"35","Student2"=>"17","Student3"=>"43");
echo "Student1 mark is" . $Marks["Student1"] . " is eligible for qualification"
echo "Student2 mark is" . $Marks["Student2"] . " is not eligible for qualification"
?>
```

### 5.2.4 Multidimensional Arrays

A multidimensional array is an array containing one or more arrays. PHP understands multidimensional arrays that are two, three, four, five, or more levels deep. However, arrays more than three levels deep are hard to manage for most people.

**Example:**

```php
<?php
// A two-dimensional array
$student=array
(
array("Iniyan",100,96),
array("Kavin",60,59),
array("Nilani",1313,139)
```
echo $$student[0][0]." Tami Mark: ".$$student [0][1]." English mark: ".$$student [0] [2]."<br>"; 
echo $$student[1][0]." Tami Mark: ".$$student [1][1]." English mark: ".$$student [1] [2]."<br>"; 
echo $$student[2][0]." Tami Mark: ".$$student [2][1]." English mark: ".$$student [2] [2]."<br>"; 
?>

### Points to Remember

- PHP Functions are reducing duplication of code
- PHP Functions are decomposing complex problems into simpler pieces
- PHP Functions are improving clarity of the code
- PHP Functions are reusing code
- PHP Functions are information hiding
- PHP Arrays are using foreach looping concepts

### Glossary

<table>
<thead>
<tr>
<th><strong>Functions</strong></th>
<th>A function is that they are reusable; if you have a task that needs to be performed a number of times, a function is an ideal solution.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>User defined Function</strong></td>
<td>Besides the built-in PHP functions, we can create our own functions. A function is a block of statements that can be used repeatedly in a program.</td>
</tr>
<tr>
<td><strong>System Define Functions</strong></td>
<td>A function is already created by the system; it is a reusable piece of block of code that performs a specific action. Functions can either return values when called or can simply perform an operation without returning any value.</td>
</tr>
<tr>
<td><strong>Parameterized Function</strong></td>
<td>PHP Parameterized functions are the functions with parameters or arguments.</td>
</tr>
<tr>
<td><strong>Array</strong></td>
<td>An array is a special variable, which can hold more than one value at a time. It’s a collection of heterogeneous data</td>
</tr>
<tr>
<td><strong>Associative Array</strong></td>
<td>Associative arrays are arrays that use named keys that you assign to them.</td>
</tr>
<tr>
<td><strong>Indexed Arrays</strong></td>
<td>The index can be assigned automatically in a collection of data set</td>
</tr>
<tr>
<td><strong>Multi-Dimensional Array</strong></td>
<td>A multidimensional array is an array containing one or more arrays.</td>
</tr>
</tbody>
</table>
Part - I
Choose the correct answer

1. Which one of the following is the right way of defining a function in PHP?
   a) function { function body }
   b) data type functionName(parameters) { function body }
   c) functionName(parameters) { function body }
   d) function functionName(parameters) { function body }

2. A function in PHP which starts with __ (double underscore) is know as..
   a) Magic Function  
   b) Inbuilt Function
   c) Default Function  
   d) User Defined Function

3. PHP’s numerically indexed array begin with position ___________
   a) 1   
   b) 2   
   c) 0   
   d) -1

4. Which of the following are correct ways of creating an array?
   i) state[0] = “Tamilnadu”;
   ii) $state[] = array(“Tamilnadu”);
   iii) $state[0] = “Tamilnadu”;
   iv) $state = array(“Tamilnadu”);
   a) iii) and iv)   
   b) ii) and iii)   
   c) Only i)   
   d) ii), iii) and iv)

5. What will be the output of the following PHP code?
   ```php
   <?php
   $a=array(“A”,”Cat”,”Dog”,”A”,”Dog”);
   $b=array(“A”,”A”,”Cat”,”A”,”Tiger”);
   $c=array_combine($a,$b);
   print_r(array_count_values($c));
   ?>
   a) Array ( [A] => 5 [Cat] => 2 [Dog] => 2 [Tiger] => 1 )
   b) Array ( [A] => 2 [Cat] => 2 [Dog] => 1 [Tiger] => 1 )

6. For finding nonempty elements in array we use
a) is_array ( ) function  
b) sizeof ( ) function  
c) array_count ( ) function  
d) count ( ) function  

 Indices of arrays can be either strings or numbers and they are denoted as  
a) $my_array {4}  
b) $my_array [4]  
c) $my_array| 4 |  
d) None of them  

 PHP arrays are also called as  
a) Vector arrays  
b) Perl arrays  
c) Hashes  
d) All of them  

 As compared to associative arrays vector arrays are much  
a) Faster  
b) Slower  
c) Stable  
d) None of them  

 What functions count elements in an array?  
a) count  
b) Sizeof  
c) Array_Count  
d) Count_array  

 Part - II  
 Short Answers  
1. Define Function in PHP.  
2. Define User define Function.  
3. What is parameterized Function.  
4. List out System defied Functions.  
5. Write Syntax of the Function in PHP.  
6. Define Array in PHP.  
7. Usage of Array in PHP.  
8. List out the types of array in PHP.  
10. Write array Syntax in PHP.

 Part - III  
 Explain in Brief Answer  
1. Write the features System define Functions.  
2. Write the purpose of parameterized Function.  
3. Differentiate user define and system define Functions.  
4. Write Short notes on Array.  
5. Differentiate Associate array and Multidimensional array.

 Part - IV  
 Explain in detail  
1. Explain Function concepts in PHP.  
2. Discuss in detail about User define Functions.  
3. Explain the Multidimensional Array.  
4. Explain Array concepts and their types.  
5. Explain Indexed array and Associate array in PHP.

 Student Activity  
- Create store the student details arrays and display the values.  
- List out real world Built-in string function usages in PHP
PHP Conditional Statements:
Conditional statements are useful for writing decision making logics. It is most important feature of many programming languages, including PHP. They are implemented by the following types:

- if Statement
- if...else Statement
- if...elseif....else Statement
- switch Statement

If statement in PHP:
If statement executes a statement or a group of statements if a specific condition is satisfied as per the user expectation.

Syntax:

```php
if (condition)
{
    Execute statement(s) if condition is true;
}
```
Example:

```php
<?php
$Pass_Mark=35;
$Student_Mark=70;
if ($Student_Mark>= $Pass_Mark){
    echo "The Student is Eligible for the Promotion";
}
?>
```

If else statement in PHP:

If statement executes a statement or a group of statements if a specific condition is satisfied by the user expectation. When the condition gets false (fail) the else block is executed.

Syntax:

```php
if (condition)
{
    Execute statement(s) if condition is true;
}
else
{
    Execute statement(s) if condition is false;
}
```

Example:

```php
<?php
$Pass_Mark=35;
$Student_Mark=70;
if ($Student_Mark>= $Pass_Mark){
    echo "The Student is eligible for the promotion";
}
else {
    echo "The Student is not eligible for the promotion";
}
?>
```
If elseif else statement in PHP:

If-elseif-else statement is a combination of if-else statement. More than one statement can execute the condition based on user needs.

**Syntax:**

```php
if (1st condition)
{
    // Execute statement(s) if condition is true;
}
elseif (2nd condition)
{
    // Execute statement(s) if 2nd condition is true;
}
else
{
    // Execute statement(s) if both conditions are false;
}
```

**Example:**

```php
<?php
$Pass_Mark=35;
$first_class=60;
$Student_Mark=70;
if ($Student_Mark>= $first_class){
echo “The Student is eligible for the promotion with First Class”;
}
elseif ($Student_Mark>= $Pass_Mark){
echo “The Student is eligible for the promotion”;
}
else {
echo “The Student is not eligible for the promotion”;
} ?>
```

else executes the following block of statements if the condition in the corresponding if is false. After the else, if another condition is to be checked, then an if statement follows the else. This is else if and is called as if else ladder.
**Switch Case:**
The switch statement is used to perform different actions based on different conditions.

**Syntax:**

```php
switch (n) {
    case label1:
        code to be executed if n=label1;
        break;
    case label2:
        code to be executed if n=label2;
        break;
    case label3:
        code to be executed if n=label3;
        break;
    ...  
    default:
        code to be executed if n is different from all labels;
}
```

**Example:**

```php
<?php
$favcolor = “red”;
switch ($favcolor) {
    case “red”:
        echo “Your favorite color is red!”;
        break;
    case “blue”:
        echo “Your favorite color is blue!”;
        break;
    case “green”:
        echo “Your favorite color is green!”;
        break;
    default:
        echo “Your favorite color is neither red, blue, nor green!”;
}
?>
```
2. What will be the output of the following PHP code?

```php
<?php
    $x = 0;
    if ($x++)
        print "hi" ;
    else
        print "how are u";
?>
```

a) hi  
b) no output  
c) error  
d) how are u
3. What will be the output of the following PHP code?

```php
<?php
    $a = "";
    if ($a)
        print "all";
    else
        print "some";
?>
```

a) all  

b) some  

c) error  

d) no output

4. Statement which is used to make choice between two options and only option is to be performed is written as

a) if statement  
b) if else statement  
c) then else statement  
d) else one statement

5. What will be the output of the following PHP code?

```php
<?php
    $x;
    if ($x == 0)
        print "hi";
    else
        print "how are u";
    print "hello"
?>
```

a) how are uhello  

b) hihello  

c) hi  

d) no output

6. What will be the output of the following PHP code?

```php
<?php
    $a = "";
    if ($a)
        print "all";
    else
        print "some";
?>
```

a) all  

b) some  

c) error  

d) no output

7. What will be the output of the following PHP code?

```php
<?php
    $x = 10;
    $y = 20;
    if ($x > $y + $y != 3)
        print "hi";
    else
        print "how are u";
?>
```

a) how are u  

b) hi  

c) error  

d) no output
8. What will be the output of the following PHP code?

```php
<?php
$x = 10;
$y = 20;
if ($x > $y & $f || 1)
    print "hi";
else
    print "how are u";
?>
```

a) how are u  
b) hi  
c) error  
d) no output

9. What will be the output of the following PHP code?

```php
<?php
if (-100)
    print "hi";
else
    print "how are u";
?>
```

a) how are u  
b) hi  
c) error  
d) no output

Part - II

Short Answers

1. Define Conditional Statements in PHP
2. Define if statement in PHP.
3. What is if else statement in PHP?

Part - III

Explain in Brief Answer

1. Write the features Conditional Statements in PHP.
2. Write is the purpose of if elseif else stament.
3. Differentiate Switch and if else statement.
4. Write Short notes on Switch statement.
5. Differentiate if statement and if elseif else stament.

Part - IV

Explain in detail

1. Explain Function Conditional Statements in PHP.
2. Discuss in detail about Switch statement with an example.
3. Explain the process Conditional Statements in PHP?
4. Explain concepts of if elseif else statement.
5. Explain if else statement in PHP.

STUDENT ACTIVITY

- Create simple decision making scenario using if else statement in student management application
- Explain real world usages in using Conditional Statements
Looping Structure:
Looping Structures are useful for writing iteration logics. It is the most important feature of many programming languages, including PHP. They are implemented using the following categories. Refer Figure 7.1 for Loop structure and flow chart

- **for Loop**
- **foreach Loop**
- **While Loop**
- **Do While Loop**

**For Loop:**
For loop is an important functional looping system which is used for iteration logics when the programmer know in advance how many times the loop should run.

**Syntax:**
```php
for (init counter; test counter; increment counter) {
    code to be executed;
}
```

**Parameters:**
- init counter: Initialize the loop initial counter value
- Test counter: Evaluated for every iteration of the loop. If it evaluates to TRUE, the loop continues. If it evaluates to FALSE, the loop ends.
- Increment counter: Increases the loop counter value.
Chapter 7 Looping Structure

**Figure 7.1** For loop Structure and Flow chart

**Example:**
```php
<?php
for ($i = 0; $i <= 10; $i++) {
    echo “The number is: $i<br”;
}
?>
```

**Foreach Loop:**
Foreach loop is exclusively available in PHP. It works only with arrays. The loop iteration deepens on each KEY Value pair in the Array. For each, loop iteration the value of the current array element is assigned to $value variable and the array pointer is shifted by one, until it reaches the end of the array element. Refer Figure 7.2.

**Syntax:**
```php
for each ($array as $value) {
    code to be executed;
}
```

**Example:**
seq = [18, 20, 32]
```
for each x of seq
print x
end
```

```
18 20 32
```

**Figure 7.2** Foreach loop Structure and Flow

The foreach construct provides an easy way to iterate over arrays. foreach works only on arrays and objects, and will issue an error when you try to use it on a variable with a different data type or an uninitialized variable.
Example:
```php
<?php
$Student_name = array("Magilan", "Iniyan", "Nilani", "Sibi", "Shini");

foreach ($Student_name as $value) {
    echo "$value <br>
}
?>
```

**While Loop:**
While loop is an important feature which is used for simple iteration logics. It is checking the condition whether true or false. It executes the loop if specified condition is true. Refer Figure 7.3

```
Initialization;
while(condition) {
    Statement-1;
    Statement-2;
    -
    Statement-n;
} Exit loop
Updation;
```

Syntax:
```php
while (condition is true) {
    code to be executed;
}
```

Example:
```php
<?php
$Student_count = 10;
$student_number = 1;
while($student_number <= $Student_count) {
    echo “The student number is: $student_number<br>
    $student_number++;
}
?>
```
**Do While Loop:**

Do while loop always run the statement inside of the loop block at the first time execution. Then it is checking the condition whether true or false. It executes the loop, if the specified condition is true. Refer Figure 7.4.

```
Syntax:

    do {
        code to be executed;
    } while (condition is true);
```

**Example:**

```php
<?php
$Student_count = 10;
$student_number=1;
do
{    echo “The student number is: $student_number<br>”;
     $student_number++;
}
while($student_number<= $Student_count)
?>
```
PHP while loops execute a block of code while the specified condition is true.

The for loop is used when you know in advance how many times the script should run.

The foreach loop works only on arrays, and is used to loop through each key/value pair in an array.

do...while - loops through a block of code once, and then repeats the loop as long as the specified condition is true.

---

<table>
<thead>
<tr>
<th>Looping Structure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>for Loop</td>
<td>For loops execute a block of code a specified number of times.</td>
</tr>
<tr>
<td>foreach Loop</td>
<td>The foreach construct provides an easy way to iterate over arrays.</td>
</tr>
<tr>
<td>While Loop</td>
<td>PHP while loops execute a block of code while the specified condition is true.</td>
</tr>
</tbody>
</table>

---

Part - I

Choose the correct answer

1. Most complicated looping structure is
   a) While
   b) Do While
   c) For
   d) None of them

2. Loops that iterate for fixed number of times is called
   a) Unbounded loops
   b) Bounded loops
   c) While loops
   d) For loops

3. Which loop evaluates condition expression as Boolean, if it is true, it executes statements and when it is false it will terminate?
   a) For loop
   b) For each loop
   c) While loop
   d) All of them

4. Which loop evaluates condition expression as Boolean, if it is true, it executes statements and when it is false it will terminate?
   a) For loop
   b) For each loop
   c) While loop
   d) All of them
5. What will be displayed in a browser when the following PHP code is executed:

```php
<?php
for ($counter = 20; $counter < 10; $counter++):
    echo “Welcome to Tamilnadu “;
    echo “Counter is: $counter”;
?
?>
```
a) Welcome to Tamilnadu  
b) Counter is: 20  
c) Welcome to Tamilnadu Counter is: 22  
d) Welcome to Tamilnadu Welcome to Tamilnadu Counter is: 22

6. What will be displayed in a browser when the following PHP code is executed:

```php
<?php
for ($counter = 10; $counter < 10; $counter = $counter + 5):
    echo “Hello”;
?
?>
```
a) Hello Hello Hello Hello Hello  
b) Hello Hello Hello  
c) Hello  
d) None of the above

7. PHP supports four types of looping techniques;  
a) for loop  
b) while loop  
c) foreach loop  
d) all the above

8. Consider the following code

```php
<?php
$count=12;
do{
    printf(“%d squared=%d<br/>”,
            $count, pow($count,2));
} while($count<4);
?>
```
What will be the output of the code.  
a) 12 squared 141  
b) 12 squared=141  
c) “12 squared=141”  
d) Execution error

9. What will be the output of the following PHP code ?

```php
<?php
for ($x = 1; $x < 10;++$x)
{
    print “*	”;
}
?>
```
a) **********  
b) *********  
c) ***********  
d) Infinite loop

10. What will be the output of the following PHP code ?

```php
<?php
for ($x = -1; $x < 10;--$x)
{
    print $x;
}
?>
```
a) 123456713910412  
b) 123456713910  
c) 1234567139104  
d) Infinite loop
Part - II
Short Answers
1. Define Looping Structure in PHP.
2. Define for loop in PHP.
3. What is For each loop in PHP?
4. List out Looping Structure in PHP.
5. Write Syntax of For loop in PHP.
6. Write Syntax of For each loop in PHP.
7. Write Syntax of while loop in PHP.
8. Write Syntax of Do while loop in PHP.
9. Compare For loop and for each loop.
10. Usage of for each loop in PHP.

Part - III
Explain in Brief Answer
1. Write the features Looping Structure.
2. Write the purpose of Looping Structure in PHP.
3. Differentiate For each and While loop.
4. Write short notes on Do while Loop.
5. Differentiate While and Do while loops.

Part - IV
Explain in detail
1. Explain Looping Structure in PHP.
2. Discuss in detail about For each loop.
3. Explain the process Do while loop.
4. Explain concepts of for loop with example.
5. Explain array concepts in Looping Structure.

STUDENT ACTIVITY
- Create simple array element and display the values using foreach
- Explain real world usages in using Looping Structure
Basic HTML Form Controls

The following control types are available in HTML form controlling:

- Text inputs
- Buttons
- Checkbox
- Radio box
- File Select
- Form Tag

Text inputs contain textbox and text area controls. Buttons may contain Submit button, Reset button and Cancel Button. Checkbox is the important feature which...
selects more than one value from the HTML form. Radio box is similar to checkbox but one value can be chosen at a time. File select is the best feature to select one file from the local machine to server machine at a time. Form tag is used to mention a method (POST or GET) and control the entire form controls in the HTML document. Refer Figure 8.1 and 8.2

8.1.1 PHP Basic Form Handling

When the user keying the input data in HTML controls and clicks the submit button the request will be generated and reaches a PHP file which is mentioned in the FORM tag under the Action attribute. All input values are synchronized and sent to the server via POST method or GET method. Method is an attribute form tag in HTML. Once the data reaches the server, two PHP variables such as $_POST and $_GET collects the data and prepares the response accordingly.

Post Method: The input data sent to the server with POST method is stored in the request body of the client’s HTTP request.

Get Method: The input data sent to the server with POST method via URL address is known as query string. All input data are visible by user after they clicks the submit button.

Example:

Test.html:
<html>
<body>
<form action="welcome.php" method="post">
Name: <input type="text" name="name"><br>
E-mail: <input type="text" name="email"><br>
<input type="submit">
</form>
</body>
</html>

Welcome.php:
<html>
<body>
Welcome <?php echo $_POST["name"]; ?>
Your email address is: <?php echo $_POST["email"]; ?>
</body>
</html>
HTML File contains two Text Box (Name and Email), One Button and one form tag. The remote server PHP file (welcome.php) is mentioned in form tag under the Action Attribute.

In “Welcome.php” file, PHP variables such as $_POST and $_GET collects the data and prepares the response accordingly.

Eventually the user will receive the output response in the client machine’s browser screen.

8.1.2 Basic PHP Form Validation

Validation is a process of checking the input data submitted by the user from client machine. There are two types of validation available in PHP. They are as follows,

Client-Side Validation: The input data validations are performed on the client machine's web browsers using client side scripts like Java script or adding “required” attribute in HTML input tags.

Server Side Validation: After the submission of data, validations are performed on the server side using the programming like PHP, ASP or JSP etc. available in the server machine.

A HTML form will take input from the site visitor and then will post it to a back-end application such as CGI, ASP Script or PHP script etc. The back-end application will perform required processing on the passed data based on defined business logic inside the application.

Validation rules for HTML input field

<table>
<thead>
<tr>
<th>Field</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name (Text Input)</td>
<td>Should require letters and white-spaces</td>
</tr>
<tr>
<td>Email (Text Input)</td>
<td>Should require @ and .strings</td>
</tr>
<tr>
<td>Website (Text Input)</td>
<td>Should require a valid URL</td>
</tr>
<tr>
<td>Radio</td>
<td>Must be selectable minimum one value</td>
</tr>
<tr>
<td>Check Box</td>
<td>Must be checkable minimum one value</td>
</tr>
<tr>
<td>Drop Down menu</td>
<td>Must be selectable minimum one value</td>
</tr>
</tbody>
</table>
Client Side Validation:

Before sending the data to server side program (PHP) the programmer can write few validations from browser in the client machine. For this validation, we have to add additional “required” attribute in HTML input tag. Refer Figure 8.3.

Example:

<input> required Attribute in HTML
<form action="welcome.php">
  Username: <input type="text" name="name" required>
  <input type="submit">
</form>

8.2 Files

File handling is an important activity of all web application development process. Files are processed for different tasks using the following events:

- PHP Open a File,
- PHP Read a File,
- PHP Close a File,
- PHP Write a File,
- PHP Appending a File and
- PHP uploading a File.

PHP Open a File:

fopen() is a system function available in PHP. This function helps to open a file in the server. It contains two parameters one for the file and the other one specifies in which mode the file should be opened (Read/Write).

Syntax:

```
$file_Object= fopen("FileName", "Read/WriteMode") or die("Error Message!");
```

Example:

```
<?php
  $myfile = fopen("Student.txt", "r") or die("Unable to open file!");
?>
```

PHP Read a File:

The fread() function reads from an open file. The file object comes from fopen function.

Syntax:

```
fread($file_Object,filesize("FileName"));
```
### Example:
```php
<?php
$fread($myfile, filesize("Student.txt"));
?>
```

### PHP Close a File:
The fclose() function is used to close an opened file. The file object comes from fopen function.

### Syntax:
fclose($file_Object);

### Example:
```php
<?php
$myfile = fopen("student.txt", "r");
// some code to be executed....
fclose($myfile);
?>
```

### PHP write a File:
The fwrite() function is used to write to a file.

### Syntax:
fwrite($myfile, $txt);

### Example:
```php
<?php
$myfile = fopen("new_school_file.txt", "w")
or die("Unable to open file!");
$txt = "School Name
";
fwrite($myfile, $txt);
$txt = "Student Name
";
fwrite($myfile, $txt);
fclose($myfile);
?>
```

### PHP Appending a File
The file_put_contents() function is used to Append to a file. Look at Table 8.1 for various parameters used in appending a file.

### Syntax:
```
file_put_contents(file, data, mode, context)
```

<table>
<thead>
<tr>
<th>Table 8.1 Appending a File Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter</td>
</tr>
<tr>
<td>-----------</td>
</tr>
<tr>
<td>File</td>
</tr>
<tr>
<td>data</td>
</tr>
<tr>
<td>mode</td>
</tr>
<tr>
<td>context</td>
</tr>
</tbody>
</table>

### Example:
```php
<?php
$txt = "Student id ";
$myfile = file_put_contents(‘logs.txt’, $txt.
PHP_EOL , FILE_APPEND | LOCK_EX);
?>
```

### PHP Close a File:
The fclose() function is used to close an opened file. The file object comes from fopen function.

### Syntax:
fclose($file_Object);

### Example:
```php
<?php
$fread($myfile, filesize("Student.txt"));
?>
```

### PHP write a File:
The fwrite() function is used to write to a file.

### Syntax:
fwrite($myfile, $txt);

### Example:
```php
<?php
$myfile = fopen("new_school_file.txt", "w")
or die("Unable to open file!");
$txt = "School Name
";
fwrite($myfile, $txt);
$txt = "Student Name
";
fwrite($myfile, $txt);
fclose($myfile);
?>
```

### PHP Appending a File
The file_put_contents() function is used to Append to a file. Look at Table 8.1 for various parameters used in appending a file.

### Syntax:
```
file_put_contents(file, data, mode, context)
```

<table>
<thead>
<tr>
<th>Table 8.1 Appending a File Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter</td>
</tr>
<tr>
<td>-----------</td>
</tr>
<tr>
<td>File</td>
</tr>
<tr>
<td>data</td>
</tr>
<tr>
<td>mode</td>
</tr>
<tr>
<td>context</td>
</tr>
</tbody>
</table>

### Example:
```php
<?php
$txt = "Student id ";
$myfile = file_put_contents(‘logs.txt’, $txt.
PHP_EOL , FILE_APPEND | LOCK_EX);
?>
```

### File Upload:
File upload is the best feature to select one file from the local machine to server machine. Form tag is used to mention a method as POST or GET and encrypt attribute mentioned as “multipart/form-data”. In the <Input> tag mention type=”file” attribute shows the input field as a file-select control, with a “Browse”
button next to the input control. The form above sends data to a file called “Student_photo_upload.php”. Refer Figure 8.4.

**Note:** First, ensure that PHP is configured to allow file uploads.

In Server machine “php.ini” file, search for the file_uploads directive, and set it to On:

```
file_uploads = On
```

After submitting the upload button the request reaches to Student_photo_upload.php file. In the file $_FILES variable collects all uploaded file information such as name of the file, size of the file and extension of the file etc. All the details are checked thoroughly and the errors are saved in an array variable. The file finally moves under the image directory if the array error variable is empty.

**Example:**

Fileupload.html:

```html
<!DOCTYPE html>
<html>
<body>
<form action="Student_photo_upload.php " method="post" enctype="multipart/form-data">
   Select image to upload:
   <input type="file" name="fileToUpload" id="fileToUpload">
   <input type="submit" value="Upload Image" name="submit">
</form>
</body>
</html>
```

![Figure 8.4 HTML and PHP File upload Screen](image1.png)
Student_photo_upload.php:

```php
<?php
if(isset($_FILES['image'])){  
    $errors= array();
    $file_name = $_FILES['image']['name'];
    $file_size =$_FILES['image']['size'];
    $file_tmp =$_FILES['image']['tmp_name'];
    $file_type=$_FILES['image']['type'];
    $file_ext=strtolower(end(explode(' . ',$_FILES['image']['name'])));
    $expensions= array("jpeg","jpg","png");

    if(in_array($file_ext,$expensions)=== false){
        $errors[]="extension not allowed, please choose a JPEG or PNG file."
    }

    if($file_size> 2097152){
        $errors[]=’File size must be exactly 2 MB’;
    }

    if(empty($errors)==true){
        move_uploaded_file($file_tmp,"images/".$file_name);
        echo “Success”;
    }else{
        print_r($errors);
    }
}
?>
```

AJAX (Asynchronous JavaScript And XML). AJAX is not a programming language. AJAX just uses a combination of: A browser built-in XMLHttpRequest object (to request data from a web server) JavaScript and HTML DOM (to display or use the data)
**POINTS TO REMEMBER**

- Form Attribute actionBackEnd script ready to process your passed data.
- Method to be used to upload data. The most frequently used are GET and POST methods.
- Target Specify the target window or frame where the result of the script will be displayed. It takes values like _blank, _self, _parent etc.
- You can use the enctype attribute to specify how the browser encodes the data before it sends it to the server.

---

**GLOSSARY**

<table>
<thead>
<tr>
<th>HTML</th>
<th>Hypertext Markup Language is the standard markup language for creating web pages and web applications.</th>
</tr>
</thead>
<tbody>
<tr>
<td>FORM Validation</td>
<td>Validation of HTML form data is important to protect your form from hackers and spammers!</td>
</tr>
<tr>
<td>Files handling</td>
<td>File handling is an important part of any web application. You often need to open and process a file for different tasks.</td>
</tr>
<tr>
<td>File upload</td>
<td>A PHP script can be used with a HTML form to allow users to upload files to the server.</td>
</tr>
</tbody>
</table>

---

**EVALUATION**

**Part - I**

**Choose the correct answer**

1. When you use the $_GET variable to collect data, the data is visible to...
   a) none  
   b) only you  
   c) everyone  
   d) selected few

2. Which one of the following should not be used while sending passwords or other sensitive information?
   a) GET  
   b) POST  
   c) REQUEST  
   d) NEXT

3. Which directive determines whether PHP scripts on the server can accept file uploads?
   a) file_uploads  
   b) file_upload  
   c) file_input  
   d) file_intake
10. Which of the following functions reads the entire contents of a file?
   a) fgets()
   b) file_get_contents()
   c) fread()
   d) readfile()

Part - II
Short Answers
1. Define HTML form controls.
2. Define for Form Handling method in PHP.
3. What is Form Validation in PHP?
4. List out HTML control to support PHP language.
5. Write Syntax of Text box in HTML.
6. Define File handling in PHP.
7. Define Browse button in HTML.
8. Write Syntax of Browse button in HTML.
10. Usage of File open function.

Part - III
Explain in Brief Answer
1. Write the features Form Handling.
2. Write the purpose Get method and Post method.
4. Write short notes on File handling.
5. Write short notes on File handling functions.
Part - IV
Explain in detail
(5-Marks) 1.
1. Explain Form Handling methods.
2. Discuss in detail about HTML form controls.
3. Explain the process File handling.
4. Explain concepts of HTTP Uploading process.
5. Explain in detail of File handling functions.

STUDENT ACTIVITY

- Create simple student Login Form to validate username and password using java script (client side validation)
- Create simple student registration form to insert student details like Student Name, username and password etc. using java script (client side validation)
Connecting PHP and MySQL

Data is important to all computer and Internet related applications. Numerous growths of data need a secure and convenient environment to store and manipulate autonomously. All these features are available in Relational Database Management System (RDMS) such as MySQL, Oracle, IBM DB2, and Microsoft SQLSERVER etc. These databases are connected with Programming language and perform the major operations like INSERT, SELECT, UPDATE and DELETE using Structure query language (SQL). The combination of PHP and MySQL has become very popular server side web scripting language in Internet. Refer Figure 9.1.

This chapter covers MySQL and PHP scripting language connectivity, which covers Database connection establishment, Database Selection, SQL statement execution, and Connection termination.

9.1 MySQL Function in PHP

In PHP Scripting language many functions are available for MySQL Database connectivity and executing SQL queries.

MySQLi is extension in PHP scripting language which gives access to the MYSQL database. MySQLi extension was introduced version 5.0.0,

![Figure 9.1. Browser Button](image-url)
The MySQLi extension contains the following important functions which are related to MySQL database connectivity and management.

- `mysqli_connect()` Function
- `mysqli_close()` Function
- `mysqli_select_db()` Function
- `mysqli_affected_rows()` Function
- `mysqli_connect_error()` Function
- `mysqli_fetch_assoc()` Function

### 9.1.1 Database Connections:

Before accessing MySQL Database, connect to Database Server machine via PHP scripting language using `mysqli_connect()` Function.

**Syntax:**

```php
mysqli_connect(“Server Name “,”User Name”,”Password”,”DB Name”);
```

This function requires four parameters to connect to database server. Database Server name, Database username, password and Database Name.

### 9.1.2 Managing Database Connections

The below code snippet describes managing database connection methods and features.

```php
<?php
$servername = "localhost";
$username = "username";
$password = "password";
$DB_name = "School_DB";

// Create connection
$conn = mysqli_connect($servername, $username, $password,$DB_name);

// Check connection
if (!$conn) {
    die("Connection failed: ". mysqli_connect_error());
}
echo “Connected successfully”;
?>
```
In the above code snippet, three variables are used to connect to the Database server. They are:

- $servername -> Database Server Server IP address
- $username -> Database Server User Name
- $password -> Database Server Password
- $DB_Name -> Database Name

The mysqli_connect function uses these variables and connect Database server from PHP scripting. If connection gets fail, output will be printed with MySQL error code. Otherwise connection is success.

### 9.1.3 Performing Queries

The main goal of MySQL and PHP connectivity is to retrieve and manipulate the data from MySQL database server. The SQL query statements are helping with PHP MySQL extension to achieve the objective of MySQL and PHP connection. “mysqli_query” is a function, helps to execute the SQL query statements in PHP scripting language.

**Syntax:**

```
mysqli_query(“Connection Object”,”SQL Query”)
```

**Example:**

```php
$con=mysqli_connect(“localhost” , ”my_user” , ”my_password” , ”Student_DB “);
$sql=”SELECT student_name,student_age FROM student”;mysqli_query($con,$sql);
```

### 9.1.4 Closing Connection:

mysqli_close() Function is used to close an existing opened database connection between PHP scripting and MySQL Database Server.

**Syntax:**

```
mysqli_close(“Connection Object”);
```

**Example:**

```php
<?php
$con=mysqli_connect(“localhost”,”$user”,”$password”,”SCHOOL_DB”);
// ....some PHP code...
mysqli_close($con);
?>
```
Example of PHP and MySQL Program:

```php
<?php
$servername = "localhost";
$username = "username";
$password = "password";
$dbname = "school_DB";

$connection = mysqli_connect($servername, $username, $password, $dbname);
if (mysqli_connect_errno())
{
    echo "Failed to connect to MySQL: " . mysqli_connect_error();
}

$sql_stmt = "SELECT * FROM my_contacts"; // SQL select query
$result = mysqli_query($connection, $sql_stmt); // execute SQL statement
$rows = mysqli_num_rows($result); // get number of rows returned
if ($rows) {
    while ($row = mysqli_fetch_array($result)) {
        echo 'ID: ' . $row['id'] . '<br>';
        echo 'Full Names: ' . $row['full_names'] . '<br>';
        echo 'Gender: ' . $row['gender'] . '<br>';
        echo 'Contact No: ' . $row['contact_no'] . '<br>';
        echo 'Email: ' . $row['email'] . '<br>';
        echo 'City: ' . $row['city'] . '<br>';
        echo 'Country: ' . $row['country'] . '<br><br>';
    }
}
mysqli_close($connection); // close the database connection
?>
```

In the above code snippet, the SQL query retrieve two records from student table in school database. These records are populated into client browser using PHP scripting language.

According to recent Survey, approximately 544 million websites are running PHP stack as of January 2018. Of course, this count is likely even higher today given the widespread use of PHP in web designing and development.
Facebook technology stack consists of applications written in many languages, including PHP and many others. Facebook still uses PHP but has built a compiler for it so it can be turned into native code. Facebook has many things built in PHP. Actually, it’s not the real PHP; Facebook has written an alternative version of PHP called HipHop’s HPHPC which helps convert PHP code into C++.

PHP has also attracted the development of many software frameworks that provide building blocks and a design structure to promote rapid application development (RAD). Some of these include PRADO, CakePHP, Symfony, CodeIgniter, Laravel, Yii Framework, Phalcon, and Zend Framework, offering features similar to other web frameworks.

## Points to Remember

- PHP is an Open source & Community support scripting language.
- PHP is a server-side scripting language designed for Web development.
- Seventy Percentage of Website has been built by PHP and MySQL.
- Major of the webservers can support PHP scripting language.
- PHP can embed easily with HTML and client-side scripting language.
- PHP has built-in function which is easily connect to MySQL database.
- PHP scripting language has been supported by many Software frameworks.

### Glossary

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>SQL</td>
<td>A domain-specific language used in programming and designed for managing data held in a relational database management system.</td>
</tr>
<tr>
<td>Queries</td>
<td>A query is a request for data or information from a database table or combination of tables.</td>
</tr>
<tr>
<td>MySQL</td>
<td>MySQL is an open-source relational database management system.</td>
</tr>
<tr>
<td>SERVER</td>
<td>A server is a computer or a device that provides functionality for other programs or devices, called “clients”. This architecture is called the client–server model, and a single overall computation is distributed across multiple processes or devices.</td>
</tr>
<tr>
<td>Database</td>
<td>A database is an organized collection of data, generally stored and accessed electronically from a computer system.</td>
</tr>
</tbody>
</table>
Part - I

Choose the correct answer

1. Which one of the following statements instantiates the mysqli class?
   a) mysqli = new mysqli()
   b) $mysqli = new mysqli()
   c) $mysqli->new.mysqli()
   d) mysqli->new.mysqli()

2. Which one is correct way, we can retrieve the data in the result set of MySQL using PHP?
   a) mysql_fetch_row.
   b) mysql_fetch_array
   c) mysql_fetch_object
   d) All the above

3. How Can we Create a Database Using PHP and MySQL?
   a) mysqli_create_db(“Database Name”)
   b) mysqli_create_db(“Data”)
   c) create_db(“Database Name”)
   d) create_db(“Data”)

4. Which is the correct function to execute the SQL queries in PHP?
   a) mysqli_query(“Connection Object”,“SQL Query”)
   b) query(“Connection Object”,“SQL Query”)
   c) mysql_query(“Connection Object”,“SQL Query”)
   d) mysql_query(“SQL Query”)

5. Which is the correct function Closing Connection in PHP?
   a) mysqli_close(“Connection Object”);
   b) close(“Connection Object”);
   c) mysql_close(“Connection Object”);
   d) mysqli_close(“Database Object”);

6. Which is the correct function to establish Connection in PHP?
   a) mysqli_connect(“Server Name “,”User Name”,”Password”,”DB Name”);
   b) connect(“Server Name “,”User Name”,”Password”,”DB Name”);
   c) mysql_connect(“Server Name “,”User Name”,”Password”,”DB Name”);
   d) mysqli_connect (“Database Object”);
7. Which is the not a correct MySQL Function in PHP?
   a) Mysqli_connect() Function
   b) Mysqli_close() Function
   c) mysqli_select_data() Function
   d) mysqli_affected_rows() Function

8. How many parameter are required for MYSQLi connect function in PHP?
   a) 2  b) 3  c) 4  d) 5

9. How many parameter are required for MYSQLi query function in PHP?
   a) 2  b) 3  c) 4  d) 5

10. How many parameter are required for MYSQLi Close function in PHP?
    a) 1  b) 2  c) 3  d) 5

11. Which version of PHP supports MySQLi functions?
    a) Version 2.0
    b) Version 3.0
    c) Version 4.0
    d) Version 5.0

Part - II

Short Answers
1. What are the MySQLi function available PHP?
2. What is MySQLi function?
3. What are the types MySQLi function available PHP?
4. Difference between Connection and Close function?
5. Give few examples of MySQLi Queries.
6. What is Connection string?
7. What is web Database?
8. What is mysqli_fetch_assoc() Function?
10. Define mysqli_affected_rows() Function.

Part - III

Explain in Brief Answer
1. Write the Syntax for MySQLi Queries.
2. Write is the purpose of MySQLi function available.
3. Differentiate mysqli_affected_rows() Function and mysqli_fetch_assoc() Function.
4. Write MySQL Connection Syntax with example.
5. Write a note PHP MySQL database connection.
Part - IV

Explain in detail

1. Discuss in detail about MySQL functions with example.
2. Explain the Database error handling and management process in PHP?
3. Explain in details types of MySQL connection method in PHP.
4. Explain MySQLi Queries with examples.

STUDENT ACTIVITY

- Create simple student Login Form to validate username and password using PHP and MySQL (Server side validation)
- Create simple student registration form to insert students details like Student Name, username and password etc. using PHP and MySQL (Server side validation).
Introduction to Computer Networks

10.1 Introduction

A set of computers connected together for the purpose of sharing resources is called as computer networks. At present, Internet is the most common resource shared everywhere. Some of the shared resources shown in Figure 10.1 are file server, web camera, speakers, printer, scanner, fax machine etc., Accessing services such as WWW (World Wide Web), Digital audio, Digital video which are shared to use applications, software, and storage servers.

All are well-known the term Internet Networks of network is called Internet.

A multination company having worldwide branches, the company wants to know about the demand and feedback of product in day to day basis. If all branches are connected in network with Internet easily collect all the information about the product.

Computer networking is a technique of digital telecommunications network one that permits nodes to share its resources. This computer networking exchanges the data with each other through wired or wireless connections between different terminals called nodes. The data from these wires is transferred over any cable media such as fiber optic cable wire or a wireless media such as WiFi.

Computer which is connected to network called as nodes. The data originates and terminates at these particular nodes is called as a source and destination. In networking,
nodes are identified by its IP addresses i.e., (network address) and can include hosts such as mobile phones, tabs, personal computers, huge servers and other networking devices. Connecting more than one device is called as network. In many cases, application at particular communications were layered others were simply in general communications protocols. The well-known networking for all is Internet.

### 10.2 History of Computer Networking and the Internet

The history of computer networks and its development were briefly explained in the table given below:

<table>
<thead>
<tr>
<th>S. No</th>
<th>Period</th>
<th>Method</th>
<th>History</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Late 1950</td>
<td>SAGE (Semi – Automatic Ground Environment)</td>
<td>It was used at U.S Military Radar system.</td>
</tr>
<tr>
<td>2</td>
<td>1960</td>
<td>SABRE(Semi Automatic Business Research Environment)</td>
<td>At Commercial Airline Reservation system online connected with two main frame computers.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Packet switching</td>
<td><strong>Packet switching</strong> was developed by Paul Baran and Donald Devices to transfer the information between computers and network.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>NPL network</strong> (National Physical Laboratory) at united kingdom local area network (LAN) using line speed of 768kbit/s was implemented by Davies pioneered</td>
</tr>
<tr>
<td>3</td>
<td>1963</td>
<td>Intergalactic Computer network</td>
<td>Intergalactic Computer network was send by J.C.RLicklder to his office colleagues discussing about this concept, a computer network engaged to access communication with users of computers.</td>
</tr>
<tr>
<td>Year</td>
<td>Event</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>------</td>
<td>-------</td>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td>1965</td>
<td>Telephone switch</td>
<td>At first widely used Telephone switch was introduced by <strong>Western Electric</strong> which implemented true computer control.</td>
<td></td>
</tr>
<tr>
<td>1966</td>
<td>WAN (Wide Area Network)</td>
<td>An experimental paper on WAN (Wide Area Network) has been published by Thomas Marill and Lawrence G. Roberts published in the area of time sharing.</td>
<td></td>
</tr>
<tr>
<td>1969-1970</td>
<td>ARPANET (Hierarchical routing after 1970’s Internet today)</td>
<td>First In 1969, four nodes of ARPANET were connected between four universities namely the university of California at Los Angeles, at Santa Barbara, the Stanford Research Institute and the university of Utah using the 50 Kbit/s circuits. Packet –switched networks was the theoretical work to model was performed by <strong>Leonard Kleinrock</strong>, ARPANET was which underpinned the development of it and his theoretical work on hierarchical routing in late 1970s with his student Farouk Kamoun remains critical to the operation of the Internet today.</td>
<td></td>
</tr>
<tr>
<td>1972</td>
<td>X.25 TCP/IP</td>
<td>Using X.25 as commercial services were deployed then was using an infrastructure for expanding TCP/IP networks.</td>
<td></td>
</tr>
<tr>
<td>1973</td>
<td>Hosts</td>
<td>In 1973, a French network named <strong>CYCLADES</strong> was the first for making <strong>hosts</strong> which is responsible for reliable delivery of data, later it became centralized service of network in itself.</td>
<td></td>
</tr>
<tr>
<td>1973-1979</td>
<td>Ethernet</td>
<td>A memo at Xerox PARC was written by Robert Metcalfe describing Ethernet in 1973, in an Aloha based networking system which was developed in 1960s by Norman Abramson and colleagues at the University of Hawaii. At July 1976 the paper published “Ethernet: Distributed Packet Switching for Local Computer Networks” by Robert Metcalfe and David Boggs, then collaborated on many patents received in 1977 and 1978. Robert Metcalfe pursued making on open standard at 1979.</td>
<td></td>
</tr>
<tr>
<td>1976</td>
<td>ARCNET</td>
<td>ARCNET was created by John Murphy of Data point corporation in which token-passing network was used first to share the storage device in 1976.</td>
<td></td>
</tr>
<tr>
<td>1995</td>
<td>NEW FIBRE OPTIC CABLES</td>
<td>The speed capacity of transmission for Ethernet was slightly elevated from 10 Mbit/s to 100 Mbit/s at 1995. After 19913, Ethernet supported transmission speed capacity towards gigabit. Frequently, highest speeds up to 100 Gbit/s were appended (still 2016). Ethernet has ability to grow easily (such as quick compatible to support new fiber optic cable speed)</td>
<td></td>
</tr>
</tbody>
</table>
INTERNET Stands for

- INTERnational NETwork (Technology, telecom, intelligence)
- INTER connected computer NETwork (science, space and environment)
- Internet stands for Interesting Notions Transmitted Electronically Round Newly Engineered Technology.

Now a days the Internet plays a vital role. It provides all the information and services to us. Early days if we want anything, we have to go to market and purchase in person. Nowadays we order anything and everything (food, clothes, stationeries, vegetables…etc.) through online(Internet). Online service providers are Flipkart, Amazon, snap deal etc to buy products via Internet and have the product at door steps. Online payments help in sending and receiving money via payment gateway using this Internet. Refer Figure 10.2 for the Evolution of Internet

Internet is running all time 24X7, 365 days. A person sale or buy anything and everything, anywhere and anytime that is main advantage of Internet.

Now on E-Governance made easier to collect their certificates through online, early days a person spend more time to collect the certificates and he have to directly many more difficulties. To avoid this bribery at office e-governance via Internet let a new path on all for ordinary man.

E-Banking plays an important role in our day today life, via Internet it can be accessed anytime, anywhere 24/7. The speed and efficiency was very much better than that of done by counter at bank. Now a days online payment were done via Internet to
avoid standing in the queue at office to pay bills with very low transaction fees.

Merchandising via Internet makes merchant an easier to get a specific type of products, company, brand can be done easier via Internet.

Powerful search engine can take us to imaginary concept to our hand with all as a text, audio, video, with briefly and by without moving to library, or taking advice from expert. Current affairs can be updated immediately without any delay. For example on olden days Internet Explorer, Yahoo, bing were powerful search engine. Later, Google stepped in with user friendly gmail, youtube, googledrive, google maps, etc. and are useful applications. Students, researchers can get their relevant study and research materials easily via Internet.

Disadvantages of Internet

- Simply wasting the precious time on Internet by surfing, searching unwanted things.
- Lot of unnecessary information is also there, why because any one can post anything on their webpage, blogs.
- Hackers and viruses can easily theft our more valuable information available in the Internet. There a lot of security issues are there in E-banking.

10.2.1 The Internet Explosion

Internet is simply defined as the World Wide Web connection of individual networks which operated by academic, industry, government, and private parties. The Internet served to interconnect with laboratories engaged at government research, and from 1994 it is expanded to serve millions of user and a multiple purpose in all parts of this universe.

In few years, the Internet built itself as a highly powerful platform that changed their way we do business and the way we communicate. Internet promotes as the universal source of information of billions of people, at work, at home, at school. Internet gave high communication medium, has given an international, “Globalised” at all dimension of the world.

Internet is growing all the time. By two things, have marked its evolution now a days the mobile technology and social web. These two innovations have been changed the people life style to use Internet. We may find many communities in social web. Face book was created in 2004 but gowned into worldwide network all over more than 2,230 million active users. Mobile technology on hand made possible to great reach of Internet and increase the Internet user all over the world.

The Internet allows all to be democratic in mass media. Anyone can have a webpage in Internet with very low investment. Similarly any business can reach a very large market directly, economically and fast, no matter of location or size of their business. Almost anyone that who can read and write can have a access and a presence in World Wide Web with very low investment. People everywhere can express and publish their ideas and opinions via blogging.

10.2.2 Growth of Computer Networking

On account of networks operate all us the scenes in business and home, we usually wont thing wrong about it, still
something’s goes wrong. Now a days computer network technology was developing in very interesting ways. Some keys developed that have occurred over past several years included

Growth on popularity of cloud storage and cloud computing. On behalf of buying physical copies of games, music and movies, increasingly downloading (or streaming) and buy digital licenses their need via Internet.

Developments on mobile network infrastructure–both deployments of 4G and 3G networks (older) that have allow the people in their developed areas who can allow it to their smart mobile phones as video broadcasting system and as mobile television. Some of the people underlying and staying connected all the times, whenever they at the workplace, via a home network, via public WiFi hotspots or smart phones.

Difficulties faced by the service providers (include Google)in expanding their residential fiber optic cables Internet service due to increased competition and installation cost from other broadband providers. Even though 4G LTE mobile network was not reached by many parts of world, the industry of telecommunication has been hard working on the development of their next generation “5G” cellular communication Technology. This 5G intense to boost up the speed the mobile connections dramatically. Exactly how much customers was in need of this 5G connection and to go. When 4G was initially being developed, companies are not waited and they do not feel shy to advertisement about the 5G efforts. It might be tested on laboratory on by prototype versions of some elements then it may be standard 5G consumers were also interested on the promise of signal coverage with 5G. Figure 10.3 shows Generation of Mobile Networks

![Figure 10.3 Generation of Mobile Networks](image)

Artificial intelligence will help to maintain, manage, and protect it. Now the networks were monitored by algorithm that enables for anomalous build-ups of traffic and activity which may be the result of nasty activities such as (DDos) Distributed Denial-of-Service attacks and attempted hacks. This Artificial Network powering algorithms will become most intelligent; it might find faster and reliable methods of anticipating threats and cleaning networks. Artificial intelligence able to be a better predict traffic as it collects and analyzes data in real time, some of network managers were better prepared for big events such as the World cup, Olympics, Valentine's Day, which often put on the Internet under pressure.
10.3 Uses of the Computer Networks

The computer networks plays major role on providing information to large, small organization as well as individual common man. Nowadays almost all the companies, bank and stores are implemented the computerized transactions. Transaction are going in varies locations, It may be in same campus, building, city, or at different places (or) cities. For all these purpose the computer network use us. Let us see about in this passage.

The common uses of computer network are

- Communication
- Resource sharing
- Data (or) software sharing
- Money saving

Communication
Using computer networks, we can interact with the different people with each other at all over the world. It provides a powerful communication among widely separated employees, team, section. They can easily communicate at very low cost via mobile, social media, telephone, e-mail, chatting, video telephone, video conferencing, SMS, MMS, groupware etc…

Resource sharing
Resource sharing means one device accessed by many systems. It allows all kind of programs, equipment’s and available data to anyone via network to irrespective of the physical location of the resource of them. Simply resource sharing is sharing such as printers, scanner, PDA, fax machine, and modems. For example, many computers can access one printer if it is in networks.

Software (or) Data sharing
Using computer network, similarly application or other software will be stored at central computer or server. We can share one software from one to another. It provides high reliability source of the data. For example, all files can not be taken backup or duplicate on more than one computer. So if one is not unavailable due to hardware failure or any other reason, the copies can be used.

Money saving
Using the computer networking, it’s important financial aspect for organization because it saves money. It reduces the paper work, man power and save the time.

10.3.1 Networks in Business
In twenty first centuries communications is necessary for successful business operations and technology for the business interaction. Here computer networks were faster, the Internet became full strength and wireless communications has been transformed the way of business performed. By the usage of latest technologies, such as cloud computing, are being used to allow globally without scarifying security or limiting user access. Here on via Internet conversations happen faster, Quick Decision making saves a lot of time, we all know that “time is money” in business. On the way of e-banking we already have seen that we can pay or receive money from or to the customer may be easily done via gateways or by online payments were much easier on this method. Here any type of business
it might large or small scale B2C, B2B, B2G, C2B, C2C, C2G, G2B, G2C, G2G or commercial that transfer of information across the Internet can be done here. Cheaper marketing was carried out on this method, on early days product choices and comparison is very difficult nowadays easy it lookout in Internet, via network it can be very easier and very cheaper to reach the customer who was in need of our product. Company renewals, license, other certificates, bill payments, receipts, invoice, stock maintenance, can be done without any geographical boundaries required here on doing via Internet and computer networks. Government subsidies were available for their business to promote their business by digitalization.

Direct human interactions are reduced because of Internet. Even working environment is also shrink. Buyer directly purchase any product from manufacturer with lowest cost, middle person brokerage charges are reduced. Above is possible if we are in Internet. The network connectivity in business is shown in Figure 10.4

10.3.2 Networks at Home

Now a day on this current situation our entire home became networked instead of indivigual network we can access more than one person in one device(router/datacard). On this home network gaming and entertainment was very much needed for both parent and children’s. Network at home is a group of devices such as computers, mobile, speakers, camera, game system, and printer that connect via network with each other. Networks at home were connected in two ways they are:

- Wired network
- Wireless network

A Wired network system connected with network cable. For example speakers, CCTV, printers, outdoors, and scanners etc., with cables.

A Wireless network is connecting devices like tablets(tab), indoor cameras and E-readers, etc., without cables (WiFi). Refer Figure 10.5

![Figure 10.4 Networks in Business](image-url)
be done easier via Internet and computer networking. No geographical can separate them.

From the home we ordered delicious food from various hotels and restaurants at time without delay can be bought via Internet.

10.3.3 Mobile Networks

Mobile network is the network connecting devices without cable (wireless). Mobile computers, such as laptop, tablet, and handheld computers, were fastest growing segments. At land areas network was distributed as cells, each will be served by single – location transceiver, but generally three cell sites or a base transceiver station. This base station provides the cell with network coverage and other features that can be utilized for transmission of voice, data and other content as well. Joining together all radio coverage is called as wide geographical area. This portable transceivers
used to communicate with one another with fixed transceivers and moving via more than one cell during transmission. For example mobiles, tablets, pagers, laptops, engaged with mobile broadband just like modems etc. Refer Figure 10.6

**Features of Mobile Networks**

- Less consumption of power is used by mobile devices comparing with a single transmitter or satellite often cell towers were nearer.
- Huge capacity than a large transmitter, at single frequency can be used for different or many links as long as they are in different in cells.
- Covering large area than a single transmitter, we can add more towers indefinitely and cannot be limited by any horizon limits.

Probably all telecommunications providers had developed data and voice cellular networks for the occupied the whole land area of earth. From this it allows mobile phones and computing devices were connected to the public switched telephone network. Private cellular networks can be used at various locations like research and about large organizations and small industries, likely as public safety agencies. Even though all the service provider giving Internet cannot make a reach to all (computer). After the reach of mobile it makes all to access the Internet via mobile or cellular phone reaches the network easier to access. Where ever we go, we can access. For example one business man wants to travel his office by transport for an hour, on that time he cannot have connectivity to office or home, but via this mobile network he can stay in touch by his mobile. By searching some important points, checking mail can be done, watching the progress can be easier on this way. Computer knowledge not necessary to easily access the Internet via mobile network, here.

**10.3.4 Social Application**

Very fast and easiest way to cover all the people, who they are connected in social network media. For example WhatsApp, Face book, twitter, blogs, pintrest, LinkedIn, classmates and so on. Through the above social media we share our taughts in different formats and different size of files. The corporate also uses intranets. Refer Figure 10.7 given below.

![Social Media Outline](image)

These social networks share several attributes in common:

- **Membership.** Social nets all generally requires user to register names and accounts for avoid duplicate and secrecy so many public networks offer free registration, but some charge fees for their premium services. Private networks (such as BANK ACCOUNT HOLDERS groups) restrict registration to people who meet certain eligibility criteria.
discussions became more convenient as not everyone needs to be online at the exact same moment to post comments.

- **Broadcast announcements.** Cities can more comfort to spread word of emergencies and natural calamities. Venues and local shops can advertise upcoming events on social networks. Businesses able market their products to customers (and retrieve some direct feedback).

- **Fostering diversity of thought.** Some critics of social networks point out that online communities attract people by similar interests and backgrounds. Indeed, when the people with different opinions do get together on online, many discussions seem to degenerate into personal attacks and so-called “flame wars.” It can be argued, by online debates are healthy in the long run. Although individuals may begin with more extreme views, over time their thinking gets influenced by the comments of others at least to some extent.

    For people who struck with busy schedule can have some relaxation and known current affairs, news via this social networks can easier to wish someone and keep on touch their follower, loveable person.

**Usefulness of Social Networks**

Besides being a fun place to meet and relax with people, social networking lead us some extremely useful benefits to their individuals and communities:

- **Group information sharing over long distances.** Although friends and family members can keep in contact via mobile phone calls or by text messages, social nets suggest a much richer environment for staying connected. To many scenarios such as sharing photo albums videos or convey their wishes someone, work better these networks because an entire group can participate together with one. Overall, group discussions became more convenient as not everyone needs to be online at the exact same moment to post comments.

**POINTS TO REMEMBER**

- A set of computers connected together for the purpose of sharing resources is called as computer network. Internet is the most common resource shared on today.
- Computer networking is a technique of digital telecommunications network one that permits nodes to share its resources from one to another. This computer networking exchanges the data as a main element. These link were transferred over cable media like optic cables or wire or wireless media such as Bluetooth and WIFI.
- U.S Military Radar system used SAGE (Semi – Automatic Ground Environment) at late 1950.
In 1960 SABRE (Semi Automatic Business Research Environment) for Commercial Airline Reservation system online connected with two main frame computers.

Packet switching here it will split it into a small segments of data called as Packets and combine all when it reach its destination.

In 1965 Telephone switch at first widely used Telephone switch was introduced by **Western Electric** which implemented true computer control.

In 1966 WAN (WIDE AREA NETWORK) was introduced for time sharing.

ARPANET at 1969-1970 was which underpinned the development of it and his theoretical work on hierarchical routing in late 1970 s with his student Farouk Kamoun remains critical to the operation of the Internet today.

In 1973 TCP/IP Using X.25 as commercial services were deployed, then using a infrastructure for expanding TCP/IP networks.

ARCNET, token-passing network was used first to share storage device at 1976.

In 1995, the speed capacity of transmission of the Ethernet technology was slightly increased from 10 Mbit/s to 100Mbit.

1998, Ethernet supported transmission speed capacity towards gigabit. Frequently, highest speeds up to 100 Gbit/s were added. Ethernet has ability to upgrade easily like adapting to support NEW FIBRE OPTIC cable speeds etc.

Artificial intelligence able to be a better predict traffic as it collects and analyzes data in real time, some of network managers were better prepared for big events such as the World cup, Olympics, Valentine's Day, which often put on the Internet under pressure

The common uses of computer networks were

- Communication
- Resource Sharing
- Data (or) software sharing
- Money savings

Here computer networks were faster, the Internet became full strength and wireless communications has been transformed the way of business performed

Networks at home were connected by two ways they are

- Wired network
- Wireless network

At land areas network was distributed as cells, each will be served by one fixed – location transceiver. This base station provides the cell with network coverage. That data can further be used for transmission of voice, data and any other resources. Joining together of all radio coverage is called as wide geographical area.

When we have mixed group of people coming together online, many discussions arise which lead to personal attacks called “flame wars.”
| **WWW** | World wide web |
| **SAGE** | Semi – Automatic Ground Environment |
| **SABRE** | Semi Automatic Business Research Environment |
| **Packet Switching** | It used to transfer the information between computers and network |
| **Telephone Switches** | First widely used to which implemented true computer control. |
| **WAN** | Wide Area Network |
| **Arpanet** | Advanced Research Projects Agency Network |
| **Hosts** | the service provider that leases this infrastructure, which is known as hosting. |
| **NEW FIBER OPTIC cable** | Here speed capacity of transmission has increased 10 Mbit/s to 100 Mbit/s now on this fibre optic cable has speed upto 100 Gbit/s |
| **e-Governance** | This is an application of ICT for access the government services, communication transactions, of various standards system between government to citizen, government to business. |
| **e-Banking** | It was a safe, fast, easy and efficient electronic service that enables you access to bank account and to carry out online banking services, 24 hours a day, and 7 days a week. |
| **Hackers** | Hackers were skilled computer experts, some who with their technical knowledge access our accounts. |
| **Viruses** | Malware treats or computer warms that replicates it By its own is called as virus |
| **Globalized** | Developed to make international influence or operation possible. |
| **Blogging** | Add new material to or regularly update a blog. |
| **Cloud Storage** | Just a storage of data on online, access in different area no geographical limits was in need |
| **Cloud Computing** | It is based on Internet computing, to share resources, software and information. |
| **e-Readers** | E-Readers is similarly called as e-book reader these were designed for the purpose of reading via mobile electronics device to read digital e-books and periodically |
| **Flame wars** | Flame wars are nothing that lengthy exchange of angry or abusive messages between users of an online forum or other discussion area. |
Part - I
Choose the correct answer

1. A set of computers connecting together is called as ----------
   a) Network   b) Server
   c) Hub   d) Node

2. Computer network devices that originates route and terminate the data were called as
   a) Hub
   b) Resource
   c) Node
   d) Cable

3. Match the period and methods available on history of computer networking in the Internet
   a) 1950 - X.25 TCP/IP
   b) 1966 - SAGE
   c) 1976 - WAN
   d) 1972 - ARCNET
   a 4321   b 3421
   c 1234   d 2341

4. Western Electric introduced the first widely used ---------------- that implemented true computer control.
   a) Packet switch
   b) Arpanet
   c) Host
   d) Telephone switch

5. Wi-Fi is short name for
   a) Wireless Fidelity
   b) Wired fidelity
   c) Wired fiber optic
   d) Wireless fiber optic

6. People everywhere can express and publish their ideas and opinions via
   a) Tele-medicine
   b) blogging
   c) Server
   d) Node

7. Which one of the following periods, the speed capacity supported towards gigabit on computer network?
   a) SABRE
   b) SAGE
   c) NEW FIBRE OPTICS
   d) ARCNET

8. One among them was challenging to the business people on computer networking
   a) Hacking
   b) Viruses
   c) Both a & b
   d) none of this above
9. ------- able to predict, manage, and protect the computer network at Internet
   a) Artificial intelligence
   b) Broadband provider
   c) Cloud computing
   d) Transceivers

10. ---------- use less power comparing with single transmitter or satellite often cell towers nearer
   a) Mobile devices
   b) Transistors
   c) WIFI
   d) Communication

11. People now a days getting relaxed via
   a) Business
   b) Corporate company
   c) News papers
   d) Social media

12. Which one of the following is not the social media
   a) Gmail
   b) Facebook
   c) twitter
   d) Linkedin

13. Facebook was created at ---------- year
   a) 2002    b) 2004
   c) 2013    d) 2010

14. In mobile network, land areas for network coverage was distributed as
   a) Firmware    b) cells
   c) Range       d) Service

15. Which one were harmful to computer
   a) Bloggers
   b) Browser
   c) Hackers
   d) twitter

16. Which innovation made the people to use Internet?
   a) Social web
   b) Mobile technology
   c) Mobile App
   d) Both a & b.

Part - II
Short Answers
1. Define Computer Network.
2. Define Internet.
3. What are the common uses of computer network?
4. List out some features of mobile network.
5. Difference between wired and wireless networks.

Part - III
Explain in Brief Answer
1. Define ARPANET.
2. What is the usage of cloud storage and cloud computing?
3. What is meant by artificial Intelligence?
4. List out some usefulness of social networks.
5. How computer networks saves the money saving?
Part - IV

Explain in detail

1. Define computer networking and Internet. Explain different developments on computer network and Internet.
2. Explain the growth of the computer networking.
3. Mention some uses of network at business, home, mobile, social application.

---

**STUDENT ACTIVITIES**

**List out the wireless network?**

1. Find out how your family members and public members uses the network?
2. Instead of landline (wired network) what were the types of wireless network you know
3. Some of example devices with wireless networks

**How social media has its memory management?**

1. Do you have a account on social media (or) create an account
2. Analyse how the social media applications transfer a huge data
Network Examples and Protocols

**LEARNING OBJECTIVES**

- To know network examples like Intranet, Intranet, Extranet
- Different types of mobile networks
- Know about wlans :802.11
- To Know about RFID
- Discus briefly about osi, tcp,ip and other network protocols

### 11.1 Introduction

Internet Protocol (IP) is the principle of the communications protocol in the Internet protocols for layering on datagram across boundaries of other networks. The main function is to allows Internet working and boost up the Internet.

Internet protocol (IP) will deliver packets from the source host and it will deliver to the destination host via through an IP address in the packets header. Vint Cerf and Bob Kahnin in 1974 introduced IP connection less datagram service was in the transmission control program. Now the IP is referred as TCP/IP Transmission Control Protocol/Internet Protocol.

Network protocols is that the usual procedures, rules, formal standards and policies comprised of formats which allocates communication between more than one device which connected to the network. Network protocols have to do end-to-end process of secure on time and manage data or network communication.

All requirements which combine process, on network protocols such as to carry out the communication between routers, servers, computers, laptop, and other authorized networked device. Here on network protocols might be installed and rooters in both sender and receiver to ensure data or network communication and apply to software and hardware nodes which communicate on a network.

**The broad types of networking protocols, including:**

- Network communication protocols is that the Basic data communication protocols which specific as HTTP and TCP/IP.
- Network security protocols is that which implement security over
network communications and include HTTP, SFTP and SSL.

- Network management protocols will provide network governance and maintenance and include ICMP and SNMP.

### 11.1.1 Internet/Intranet/Extranet

**INTERNET:** The Internet, “the Net,” is a worldwide system of computer networks - a network of networks where the users at any one computer can, if they have permission, get information from any other computer. The Internet is a network of global connections – comprising private, public, business, academic and government networks – linked by guided, wireless and fiber-optic technologies. It was perceived by the Advanced Research Projects Agency (ARPA) of the U.S. government in 1969 and was first recognized as the ARPANet. The unique aim was to generate a network that would permit users of a research computer from one university to “talk to” research computers on other universities. The jargons Internet and World Wide Web are frequently used interchangeably, but they are not precisely the same thing; the Internet denotes to the global communication system, including infrastructure and hardware, whereas the web is one of the services interconnected over the Internet. See Figure 11.1

**INTRANET:** It is a private network within an enterprise to share company data and computing resources between the employees. It may consist of many interlinked local area networks. It includes connections through one or more gateway (connects two networks using different protocols together known as protocol convertor) computers to outside Internet. See Figure 11.2

**EXTRANET:** It is a private network that uses Internet technology and the public telecommunication system to securely share business’s information with suppliers, vendors, partners, customers, or other businesses. See Figure 11.3 and 11.4
### Internet of Things

Internet of Things refers to the digital interconnection of everyday objects (home appliances, wearable devices or automobiles) with the Internet. The ‘thing’ in IoT refers to an objects that have been assigned an IP address and have the ability to collect and transfer data over a network without manual assistance or intervention.

### Comparison

<table>
<thead>
<tr>
<th>Type</th>
<th>Definition</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internet</td>
<td>a global network, public TCP/IP network used by over a billion people all over the world</td>
<td>Sending email to a friend</td>
</tr>
<tr>
<td>Intranet</td>
<td>a TCP/IP network with access restricted to members of an organization</td>
<td>Accessing your record in the employee personnel file</td>
</tr>
<tr>
<td>Extranet</td>
<td>TCP/IP network with restricted access to members</td>
<td>Checking availability of inventory from an outside supplier</td>
</tr>
</tbody>
</table>
11.1.2 Mobile Networks
A mobile network or cellular network as it is made up of a large number of signal areas called cells. These cells join to form a large coverage area. Users can cross into different cells without losing their connection. Within each cell there is a base station, which sends and receives the mobile signals. A mobile device will connect to the nearest or least base station. The base stations are connected to digital exchange where the communication is sent to other telephone.
or data networks. Cells will often be smaller in size in large towns, as the number of users in the area is more. Communication over mobile network is be made up of voice, data, images and text messages. See Figure 11.5

Mobile networking assign to the technology and supports voice/data, network connectivity using via radio transmission solution. Mobile networking assign to the technology that can support data / voice, network connectivity using via radio transmission solution, wireless. Similarly the common application of mobile networks is mobile phones, tablets, etc. In past, wireless communications largely used circuit switching to carry only voice over a network, but now currently both data and voice are being transmitted over both circuit via switched networks and packet-switched networks.

The generations of mobile networks are as follows.
- First Generation (1G) 1981 – NMT launch
- Second Generation (2G) 1991 – GSM launch
- Second to Third Generation Bridge (2.5) 2000 – GPRS launch
- Third Generation (3G) 2003 – UK 3G launch
- Fourth Generation (4G) 2007
- Fifth Generation (5G) 2019+

First Generation (1G) 1981 – NMT launch

During the initial periods the mobile systems were based on analog transmission. NMT stands for Nordic Mobile Telephone communication. They had a very low traffic density of one call per radio channel, and a very poor voice quality, and they used unsure and unencrypted transmission, which leads to the spoofing of its identities.

Second Generation (2G) 1991 – GSM launch

Later the second generation of mobile systems were placed on digital transmission with GSM. GSM stands for (Global System for Mobile communication) was most popular standard which is used in second generation, using 900MHz and 1800MHz for the frequency bands. GSM mobile systems grown digital transmission using SIM. SIM stands for (Subscriber Identity Module) technology to authenticate a user for identification and billing purposes, and to encrypt the data to prevent listen without permission (eavesdropping). The transmission used as TDMA. TMDA stands for (Time Division Multiple Access) and CDMA One stands for (Code Division Multiple Access) method to increase the amount of information transported on the network. Mobility is supported at layer 2, which
stops seamless roaming across assorted access networks and routing domains. This means each operator must cover the entire area or have agreements in place to permit roaming.

Second to Third Generations Bridge (2.5G) 2000 – GPRS launch

GPRS was introduced here, it seen as an excess period of mobile networking development, between 2G and 3G. GPRS stands for (General Packet Radio Service). GPRS is a data service which enables mobile devices to send and receive messages, picture messages and e-mails. It allows most popular operating speeds of up to 115kbit/s, latterly maximum of 384kbit/s by using EDGE. EDGE stands for (Enhanced Data rates for Global Evolution). GSM data transmission rates typically reached 9.6kbit/s.

Third Generation (3G) 2003 – First UK 3G launch

This generation of mobile systems merges different mobile technology standards, and uses higher frequency bands for transmission and Code Division Multiple Access to delivery data rates of up to 2Mbit/s supports multimedia services (MMS: voice, video and data). European standard is UMTS (Universal Mobile Telecommunication Systems). Mobile phones systems continue to use digital transmission with SIM authentication for billing systems and for data incorruption. Data transmission used a WCDMA. WCDMA stands for (Wideband Code Division Multiple Access). One technique to obtain data rates between 384kbit/s and 2048kbit/s. Few 3G suppliers use ATM (Asynchronous Transfer Mode) for their ‘over the air’ network with in MPLS (Multiprotocol Label Switching) or IP for theirs backbone network.

Mobility still supported at layer 2, and hence like 2G it still prohibits seamless roaming beyond heterogeneous access networks and routing domains. The transmission were band frequencies are between 1900 and 2200 MHz. All UMTS license holders at the UK holds a 20 year license with the condition that 80% population coverage is achieved by 31 December 2007. The present third generation licensed operators in the UK can be seen below as at August 2004.

Fourth Generation (4G) 2007

4G is at the research stage. 4G was based on an adhoc networking model where there was no need for a fixed infrastructure operation. Adhoc networking requires global mobility features (e.g. Mobile IP) and connectivity to a global IPv6 network to support an IP address for each mobile device. Logically roaming in assorted IP networks (for example: 802.11 WLAN, GPRS and UMTS) were be possible with higher data rates, from
2Mbit/s to 10–100Mbit/s, offering reduced delays and newly services. Mobile devices will not expect on a fixed infrastructure, they will require enhanced intelligence to self configure in adhoc networks and having a routing capabilities to route over a packet-switched network.

**Fifth Generation (5G) 2019+**

5G is the stage succeeds the 4G (LTE/WiMAX), 3G(umts) and 2G(GSM) syetems. 5G targets to performance the high data rate, reduced latency, energy saving, cost reduction, higher system, capacity, and massive device connectivity. The two phases of 5G, First one will be Release-15 complete by March 2019,Second one Release-16 is expected to complete at March 2020, for submission to the ITU(International Telecommunication Union) as a candidate IMT-2020 technology. The ITU IMT – 2020 provides speeds up to 20 gigabits per second it has been demonstrated with millimeter waves of 15 gigahertz and higher frequency. 3 GPP standard includes any network using th New Radio software. 5G New Radio can access at lower frequencies from 600 MHz to 6 GHz. Speed in the lower frequencies are only modest higher than 4G systems, estimated at 15% to 50% faster.

**11.1.3 WLANS 802.11**

Wi-Fi stands for Wireless Fidelity. It is a wireless network technology that permits computers and alternative devices to be connected to every alternative into a local area network and to the net without wires and cables. Wi-Fi is additionally stated as wireless local area networkthat stands for wireless local area network, and 802.11, that is that the technical code for the protocol. See Figure 11.6

![Figure 11.6 Wi-Fi](image)

**ADVANTAGES: Benefits of Wi-Fi are**

- It provides mobility. Example: I get Internet connection wireless through my laptop computer at home and at work, because of Wi-Fi, hotspots both at home and at work.
- It provides connection to Internet.
- Flexibility of LAN.
- Ensures connectivity.
- It allows places that are remote to benefit from connectivity.
- Low cost, high benifits.

**11.1.4 RFID**

2. RFID uses RF wireless technology to identify.

RFID stands for Radio –Frequency Identification (RFID). RFID used for radio waves to read and capture information stored on a tag attached to an object. Tag can be read from several feet away and does not need to be in direct-line-of-sight of the reader to be tracked. RFID has been made up of two parts a reader and a tag or a label. RFID tags are installed with a transmitter and receiver.
RFID component on the tags has two parts: a microchip which stores and processes the information, and the antenna to receive and transmit a signal. The Tag replies the information from its memory bank. The reader will transmit to read the result to RFID computer program.

Two types of RFID tags were Active RFID and Passive RFID systems.

1. Passive RFID tag will be used the reader radio wave energy to really its stored information back to the reader.
2. Battery powered RFID tag is installed with small battery that powers the broadcast of information

Main Components of a RFID System

- **A RFID tag:** It has silicon microchip attached to a small antenna and mounted on a substrate. See Figure 11.7

![Figure 11.7 RFID Tag](image1)

- **A reader:** It has a scanner with antennas to transmit and receive signals, used for communication. See Figure 11.8

![Figure 11.8 An RFID Reader](image2)

- **A Controller:** It is the host computer with a Microprocessor which receives the reader input and process the data.

Two types of RFID Systems:

1. **Active RFID system:** the tag has its own power source. These systems used for larger distances and to track high value goods like vehicles.
2. **Passive RFID system:** the tag gets power through power from a reader antenna to the tag antenna. They are used for shorter range transmission.

**Working of Passive RFID System**

A Passive RFID system using Induction coupling method:

The RFID tag gets power from the reader through the inductive coupling method. See Figure 11.9

![Figure 11.9 Passive RFID using Inductive Coupling](image3)

A Passive RFID system using EM wave propagation method:

The reader antenna transmits the electromagnetic waves that are received by the antenna. See Figure 11.10

![Figure 11.10 Passive RFID using EM-wave transmission](image4)
11.2 Reference Model

11.2.1 OSI Model

Open System Interconnection (OSI) model was found in the year 1934, general framework that enables network protocols along with software and systems to be developed based on general set of guidelines. It describes the standards for the inter-computer communication. See Figure 11.12

![Figure 11.12 OSI LAYERS](image)

OSI Layers:

1. **Physical Layer**: This is the 1st layer, it defines the electrical and physical specifications for devices.

2. **Data Link Layer**: It is the 2nd layer and it guarantees that the data transmitted are free of errors. This layer has simple protocols like “802.3 for Ethernet” and “802.11 for Wi-Fi”.

3. **Network Layer**: It is the 3rd layer determining the path of the data packets. At this layer, routing of data packets is found using IP Addressing.

4. **Transport Layer**: It is the 4th layer that guarantees the transportation/sending of data is successful. It includes the error checking operation.

5. **Session Layer**: It is the 5th layer, identifies the established system session between different network
entities. It controls dialogues between computers. For instance, while accessing a system remotely, session is created between your computer and the remote system.

6. **Presentation Layer**: It is the 6th layer that does the translation of data to the next layer (Prepare the data to the Application Layer). Encryption and decryption protocols occur in this layer such as, Secure Socket Layer (SSL).

7. **Application Layer**: It is the 7th layer, which acts as the user interface platform comprising of software within the system.

### 11.2.2. **TCP/IP**

**Transmission Control Protocol/Internet Protocol**, TCP/IP is a set of protocols which governs communications among all computers on the Internet. TCP/IP protocol tells how information should be packaged, sent, and received, as well as how to get to its destination. See Figure 11.3

**TCP WORKING**: TCP/IP is a combination of two protocols: Transmission Control Protocol (TCP) and Internet Protocol (IP). The Internet Protocol typically specifies the logistics of the packets that are sent out over networks; it specifies the packets which have to go, where to go and how to get there. The Transmission Control Protocol is accountable for guaranteeing the trustworthy transmission of data. It sees that the packets for errors and submits the requests for re-transmissions incase any of them are missing.

#### Frequent TCP/IP Protocols

- **HTTP** – It is used between a web client and a web server and it guarantees non-secure data transmissions.
- **HTTPS** – It is used between a web client and a web server ensures secure data transmissions.
- **FTP** – It is used between computers for sending and receiving file.

### Domain Names and TCP/IP Addresses

The address for any website is not as easy as to remember, domain name are used instead. For example, **216.58.216.164** is one of the IP address for Google and **google.com** is the domain name.

---

**Figure 11.13 TCP/IP Layer**
The Different Layers of TCP/IP

There are four total layers of TCP/IP protocol, each of which is listed below with a brief description.

- **Network Access Layer** - concerned with building packets.
- **Internet Layer** - describes how packets are to be delivered.
- **Transport Layer** - ensure the proper transmission of data.
- **Application Layer** - application network processes. These processes include File Transfer Protocol (FTP), Hypertext Transfer Protocol (HTTP), and Simple Mail Transfer Protocol (SMTP).

### 11.2.3 Other Network Protocols

Network protocols other than OSI and TCP/IP were simply known as other network protocols which implements security over the network communication that include HTTPS, SSL, and SFTP. Other networks similarly classified in network layer IP, ARP, ICMP, IGMP, at transport layer TCP, UDP at Application Layer HTTP, FTP, Telenet, SMTP, and DNS.

HTTPS positions for Hypertext Transfer Protocol Secure. It's a protocol where encoded data transfer on a secure connection. This HTTPS make data more and provides data security over the network mainly on public networks like Wi-Fi. See Figure 11.14

For example, let us take a bank website, say hdfcbank.com. https it support for our secured bank transaction in networks. Frequently we go to login page, we may watch an HTTPS in address bar with some specific design. HTTPS mainly deals with financial transactions or transfer users personal data were highly sensitive. Banking websites were common examples for HTTPS. Data exchanged between the user and the website is not stolen, read or altered by a third party. But it can be encode everything, with some limitations too. For example, can encode port numbers and host addresses.

In layman's terms, HTTPS guarantees that users watch websites that they want to watch. Data exchanged between the user and the website is not read, stolen or tampered with by a third party. But it can't encrypt everything - it has some limitations too. For example, HTTPS can't encrypt host addresses and port numbers.
TCP/IP procedures are based on a layered framework. TCP/IP has four layers. See Figure 11.15

**Network Interface Layer**

It is the bottommost level layer. It is comparable to that of the Open System Interconnection Physical and Data Link layers. Different TCP/IP protocols are being used at this layer, Ethernet and Token Ring for local area networks and protocols such as X.25, Frame Relay, and ATM for wide area networks. It is assumed to be an unreliable layer.

**Network Layer**

It is the layer where data is addressed, packaged, and routed among networks. The important Internet protocols that operate at the Network layer are:

- **Internet Protocol (IP):** Routable protocol which uses IP addresses to deliver packets. It is an unreliable protocol, does not guarantee delivery of information.

**Address Resolution Protocol (ARP):** Resolves IP addresses to MAC (Medium Access Control) addresses. (A MAC address is a hardware identification number that uniquely identifies each device on a network.) i.e., to map IP network addresses to the hardware addresses.

**Internet Control Message Protocol (ICMP):** Used by network devices to send error messages and operational information. Example: A host or router might not be reached or a requested service is not presented.

- **Internet Group Management Protocol (IGMP):** It is a communication protocol used by hosts and routers to send Multicast (group Communication) messages to multiple IP addresses at once.

**Transport Layer**

The sessions are recognized and data packets are swapped between hosts in this layer. Two main protocols established at this layer are:

- **Transmission Control Protocol (TCP):** Provides reliable connection oriented transmission between two hosts. It ensures delivery.
of packets between the hosts.

**User Datagram Protocol (UDP):** Provides connectionless, unreliable, one-to-one or one-to-many delivery.

**Application Layer**

The Application layer of the TCP/IP model is similar to the Session, Presentation, and Application layers of the OSI Reference Model. The most popular Application layer protocols are:

- **Hypertext Transfer Protocol (HTTP):** The core protocol of the World Wide Web. **File Transfer Protocol (FTP):** Enables a client to send and receive complete files from a server. **Telnet:** Connect to another computer on the Internet. **Simple Mail Transfer Protocol (SMTP):** Provide e-mail services. **Domain Name System (DNS):** Refer to other host computers by using names rather than numbers.

---

**POINTS TO REMEMBER**

- The Internet is a network of global connections – comprising private, public, business, academic and government networks – linked by guided, wireless and fiber-optic technologies.
- **ARPANET** was Advanced Research Projects Agency (ARPA) of the U.S. government in 1969 and was first recognized
- **INTRANET:** It is a private network within an enterprise to share company data and computing resources between the employees.
- **EXTRANET:** It is a private network that uses Internet technology and the public telecommunication system to securely share business’s information with suppliers, vendors, partners, customers, or other businesses.
- Communication over mobile network is be made up of voice, data, images and text messages.
- **RFID** – *(Radio Frequency Identification)* uses RF wireless technology to identify.
- Open System Interconnection (OSI) model was found in the year 1934, over all basis that permits network protocols along with software and schemes to be developed based on Universal guidelines.
- **Transmission Control Protocol/Internet Protocol (TCP/IP)** is a set of protocols permitting communications among all computers on the Internet.
- **HTTP** – A protocol used between a web client and a web server protects non-secure data transmissions. The core protocol of the World Wide Web.
- **HTTPS** - A protocol used between a web client and a web server permits secure data transmissions.
- **FTP** - Used between computers for sending and receiving data. Enables a client to send and receive complete files from a server.
- **Internet Protocol (IP):** routable protocol which uses IP addresses to deliver packets. It is an unreliable protocol, does not guarantee delivery of information.
- **Address Resolution Protocol (ARP):** Resolves IP addresses to MAC (Medium Access Control) addresses. (A MAC address is a hardware identification number that uniquely identifies each device on a network.)
- **Internet Control Message Protocol (ICMP):** Used by network devices to send error messages and operational information.
- **Transmission Control Protocol (TCP):** Provides reliable connection oriented transmission between two hosts. It guarantees delivery of packets between the hosts.
- **Simple Mail Transfer Protocol (SMTP):** Provides e-mail services.
- **Domain Name System (DNS):** A method of referring to other host computers by using names rather than numbers.

### Glossary

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internet</td>
<td>Several networks, small and big all over the world, are connected together to form a Global network called the Internet.</td>
</tr>
<tr>
<td>Intranet</td>
<td>It is a website used by organizations to provide a place where employees can access company related information.</td>
</tr>
<tr>
<td>Extranet</td>
<td>It is a private network using Internet technology to share part of business information with supplier’s partners and customers.</td>
</tr>
<tr>
<td>APRANet</td>
<td>Advanced Research Projects Agency Network</td>
</tr>
<tr>
<td>TCP/IP</td>
<td>Transmission Control Protocol / Internet Protocol</td>
</tr>
<tr>
<td>Wi-Fi</td>
<td>Wireless Fidelity.</td>
</tr>
<tr>
<td>RFID</td>
<td>Radio Frequency Identification.</td>
</tr>
<tr>
<td>OSI</td>
<td>Open System Interconnection</td>
</tr>
<tr>
<td>HTTP</td>
<td>Hypertext Transfer Protocol</td>
</tr>
<tr>
<td>HTTPS</td>
<td>Hypertext Transfer Protocol Secure</td>
</tr>
<tr>
<td>FTP</td>
<td>File Transfer Protocol</td>
</tr>
<tr>
<td>SMTP</td>
<td>Simple Mail Transfer Protocol</td>
</tr>
<tr>
<td>UDP</td>
<td>User Datagram Protocol</td>
</tr>
<tr>
<td>DNS</td>
<td>Domain Name System</td>
</tr>
</tbody>
</table>


Part - I

Choose the correct answer

1. The-----------, “the Net,” is a worldwide system of computer networks
   a) Internet
   b) mobile
   c) communication
   d) protocol

2. Which one of the following will be easy the way to uses Internet technology and the public telecommunication system to securely share business’s information with suppliers, vendors, partners and customers.
   a) Extranet  b) Intranet
   c) arpanet  d) arcnet

3. Match the following and choose the correct answer
   i. HTTP - The core protocol of the World Wide Web.
   ii. FTP - enables a client to send and receive complete files from a server.
   iii. SMTP - Provide e-mail services.
   iv. DNS - Refer to other host computers by using names rather than numbers.
      a) i, ii, iii, iv  b) ii, iii, iv, i
      c) iii, iv, i, ii  d) iv, iii, ii, i

4. Communication over ----------- -------is be made up of voice, data, images and text messages.
   a) Social media
   b) mobile network
   c) whatsapp
   d) software

5. Wi-Fi stands for-----------------------
   a) Wireless Fidelity
   b) wired fidelity
   c) wired optic fibre
   d) wireless optic fibre

6. A TCP/IP network with access restricted to members of an organization
   a) LAN  b) MAN
   c) WAN  d) Intranet

7. RFID stands for --------------
   a) Radio Free identification
   b) real Frequency identity
   c) Radio Frequency indicators
   d) Radio Frequency Identification.

8. It guarantees the sending of data is successful and which checks error on operation at OSI layer is------------------------
   a) Application layer
   b) Network layer
   c) Transport Layer
   d) Physical layer

9. Which one of the following will secure data on transmissions
   a) HTTPS  b) HTTP
   c) FTP  d) SMTP

10. -------- provides e-mail service
    a) DNS  b) TCP
    c) FTP  d) SMTP
11. ------------ refer to other host computers by using names rather than numbers.
    a) DNS     b) TCP     c) FTP     d) SMTP

12. TCP/IP is a combination of two protocols:
   i. Transmission Control Protocol (TCP)
   ii. Internet Protocol (IP)
   iii. Selection Protocol (SP)
   iv. Captial Protocol (CP)
    a) i, ii     b) i, iii     c) iii, iv     d) ii, iii

Part - II
Short Answers
1. Define Intranet
2. What is the uses of mobile networks?
3. List out the benefits of WiFi
4. How many types of RFID system available and what are they?
5. Expand HTTP, HTTPS, FTP.

Part - III
Explain in Brief Answer
1. Compare Internet, Intranet and Extranet
2. List out the components of a RFID enabled system.
3. Write short notes on HTTP, HTTPS, FTP.
4. What are the layers available in TCP/IP Reference Model?
5. Expand ARP, ICMP, SMTP and DNS.

Part - IV
Explain in detail
1. Explain about Internet, Intranet and Extranet.
2. Discuss about OSI model with its layers.
3. Difference between TCP/IP and OSI Reference Model.
4. Explain about the development, merits and demerits in Mobile networks.

Student Activities
List out some web address with http and https
1. Find some of the http web addresses
2. Give some example for https
3. Can you know difference between http and https.
seven layers. Application layer is one among the seven layers. There are several applications in the application layer and DNS (Domain Name System) is one among them. Internet is based on IP addresses, not domain names. But it is easy to use domain names to refer them rather than the long numbers (IP address). To enable the use of domain names in a network, the Domain Name System (DNS) is used. Domain names to IP address mapping must be consistent across the network to ensure interoperability. DNS provides the domain name to IP address mapping through Name servers. To know more about DNS working we must first know about IP address, URL, DNS components. So, let us see about each in detail. Refer Figure 12.1
While typing a web address, e.g., www.tnschools.gov.in, DNS translates it into a machine friendly IP address (for example 35.173.69.207 is the IP for www.tnschools.in) and directs your Internet connection to the correct website.

American computer scientist Paul V. Mockapetris together with Jon Postel, invented the Internet Domain Name System (DNS). Jon Postel was an administrator of the Internet Assigned Numbers Authority (IANA) until his death and he was known as “God of the Internet”.

Jon Postel  Paul V. Mockapetris

12.3.1 IPv4 Address
IPv4 address is a 32-bit unique address given to a computer system. No two systems can have same IP address. If the network has p connections then ‘p’ addresses should be there. An address space is the total number of addresses that can be made by that protocol. It is determined by the number of bits that the protocol use. If the protocol uses ‘n’ bits then the address space of that protocol would be $2^n$ addresses can be formed. So, the number of addresses that can be formed in IPv4 is $2^{32}$. There are two ways to represent the IP address

- Binary notation
- Dotted-decimal notation

In binary notation the address is expressed as 32-bit binary values.

For E.g. 00111001 10001001 00111000 00000111

In dotted-decimal notation the address is written in decimal format separated by dots(.). Refer Figure 12.2

For e.g. 128.143.137.144
12.3.2 **IPv6 Address**

IPv6 address is a 128-bit unique address given to a computer system. The number of addresses that can be formed in IPv6 is $2^{128}$. In IPv6 address, the 128 bits are divided into eight 16-bits blocks. Each block is then changed into 4-digit Hexadecimal numbers separated by colon symbols. E.g. 2001:0000:32313:DFE1:0063:0000:0000:FEFB. Refer Figure 12.3

---

**Figure 12.3 IPv6 Address**

<table>
<thead>
<tr>
<th>Network prefix (64 bits)</th>
<th>Host number (64 bits)</th>
</tr>
</thead>
<tbody>
<tr>
<td>XXXX : XXXX : XXXX : XXXX</td>
<td>XXXX : XXXX : XXXX : XXXX</td>
</tr>
</tbody>
</table>

$X$ - Hexadecimal number (0,1,2,3,4,5,6,7,8,9,A,B,C,D,E,F)

$XXXX$ - 0000 to FFFF

---

12.4 **Uniform Resource Locator (URL)**

URL (Uniform Resource Locator) is the address of a document on the Internet. URL is made up four parts—protocols, hostname, folder name and file name. Each part has its own specific functions. Depending on the applications, additional information can be added to the URL but the common and fundamental URL consists of these four parts. Refer Figure 12.4

---

**Figure 12.4 URL Parts**

Figure 12.4 shows the basic URL where http is a protocol, www.cms.tn.gov.in is a hostname / domain name, sites/default/files/press_release are the folders and pr070119a.jpg is the file name. These are all the basic information which can be obtained from a URL.

**URL Type**
Depending on the location of the document the URL is divided into 2 types
- Absolute URL
- Relative URL

**12.4.1 Absolute URL**
Absolute URL is the complete address of a document on the Internet. Absolute URL contains all the information that are required to find the files on the Internet. These are similar to postal address if any of the information is missing then the post will not be able to deliver to the right person. Similarly, if any of the four parts is missing then the browser would not able to link to the specific file. So, all the four parts is very important in absolute URL.

**12.4.2 Relative URL**
Relative URL is the partial address of a document on the Internet. Relative URL contains only file name or file name with folder name. We can use this type of URL when the file is on the same server related to original document.

**12.5 DNS Components**
There are three important components in the Domain Name System. They are
- Namespace
- Name server
- Zone

---

**12.5.1 Name Space**
The domain names must be very unique and appropriate. The names should be selected from a namespace. The name space can be organized in two ways
- Flat name space
- Hierarchical name space

Flat name space is where the name is assigned to the IP address. They do not have any specific structure. In this flat name space, some meaningful names are been given to IP address for accessing. The major disadvantage of flat name space is that they cannot be used in large system. Because they need to be accessed and controlled centrally to avoid ambiguity and redundancy. But it is difficult in flat name system. To avoid this major disadvantage hierarchical name space is used in large.

Hierarchical name space is where the name is made up of several parts. The first part may represent the nature of organization, the second part may represent the name of organization, and third part may represent the department of the organization and so on. In this way the power to control the name space can be decentralized. The centralized authority can be given to nature and then to name of the organization and so on. To achieve hierarchical name space, Domain Name Space was designed.

**Domain Name Space**
Domain name space was designed to achieve hierarchical name space. In this, the names are represented as a tree like structure with root element on the top and this tree can have a maximum of 128 levels starting from root element taking the level 0 to level 127.
Figure 12.5 represent the domain name space where the root element is present at the top most level i.e., level 0. The root element always represents the NULL string (empty string). The next level to the root element is node (children of root element). Each node in the tree has a **label** and a **domain name**.

**Label**

It is a string which can have maximum of 63 characters. Each node in that level should have different labels thereby assuring the individuality of the domain name.

In other words, Labels are the names given to domains. **Domain** is a sub tree in domain name space tree structure. The domain can be further divided into sub domains.
Domain names have the minimum length of 2, and the maximum length of 63 characters. The entire name may be at most 253 characters long.

Domain names are not case-sensitive. (It may be upper, lower or mixing of both case letters)

Generic Top-Level Domain names:
Top level domain is the last part of a domain name. Generic top level domains are used for generic purpose and maintained by IANA. Refer Table 12.1

<table>
<thead>
<tr>
<th>Domain Name</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>com</td>
<td>Commercial Organisation</td>
</tr>
<tr>
<td>edu</td>
<td>Educational Institutions</td>
</tr>
<tr>
<td>gov</td>
<td>Government (US)</td>
</tr>
<tr>
<td>mil</td>
<td>Military groups</td>
</tr>
<tr>
<td>org</td>
<td>Non profit Organization</td>
</tr>
<tr>
<td>net</td>
<td>Networking organization</td>
</tr>
<tr>
<td>info</td>
<td>Information service providers</td>
</tr>
</tbody>
</table>

Basic rules of Domain names
- Domain can consists of Alphabets a through z, and the digits 0 through 9.
- Hyphens are allowed, but hyphens can not be used as first character of a domain name.
- Spaces are not allowed
- Special symbols (such as !, $, & and so on) are not permitted.

Figure 12.7 explain the domain name and label clearly. challenger.atc.fhda.edu. is the domain name which is obtained by reading the labels from bottom to top, separating each label by dot (.) Refer Figure 12.7

Domain name
It is the sequence of labels. In domain name the sequence of labels are separated by dot (.). The domain name is always read from the lower level to higher level i.e., from the leaf node to root node. Since the root node always represent NULL string, all the domain name ending with dot.

Figure 12.7 Domain representation of www.tnscert.org
Country top-level domain names
Country domain uses 2-character country abbreviation according to country. For e.g., google.in – for INDIA, google.us for US. Refer Table 12.2

<table>
<thead>
<tr>
<th>Domain Name</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>in</td>
<td>India</td>
</tr>
<tr>
<td>us</td>
<td>United States</td>
</tr>
<tr>
<td>fr</td>
<td>France</td>
</tr>
<tr>
<td>uk</td>
<td>United Kingdom</td>
</tr>
<tr>
<td>ca</td>
<td>Canada</td>
</tr>
<tr>
<td>au</td>
<td>Australia</td>
</tr>
<tr>
<td>lk</td>
<td>Srilanka</td>
</tr>
<tr>
<td>bd</td>
<td>Bangladesh</td>
</tr>
<tr>
<td>cn</td>
<td>China</td>
</tr>
<tr>
<td>pk</td>
<td>Pakistan</td>
</tr>
<tr>
<td>jp</td>
<td>Japan</td>
</tr>
<tr>
<td>sg</td>
<td>Singapore</td>
</tr>
</tbody>
</table>

Table 12.2 Country domain names

Inverse domain performs the opposite task of normal DNS query. It converts the IP address to domain name.

Name Server is a main part in the Domain Name System (DNS). It translates the domain names to IP addresses. Name server contains the DNS database which consists of domain names and their corresponding IP addresses. There is a need to store large number of domain names for the world wide usage, so plenty of servers are used in the hierarchical manner. Name servers do the important task of searching the domain names. While you are searching a website, Local Name server (provided by ISP) asks the different name servers until one of them find out your answer. At last it returns IP address for that domain name. Your computer can now connect to the requested webpage stored on the webserver. Refer Figure 12.8

12.5.2 Name Servers
The information which needs to be stored in Domain name space is quite large. Single system would be inefficient and insufficient to store such a huge amount as responding to requests from all over the world. It also becomes unreliable because in case of any failure the data becomes inaccessible.
12.5.3 Zone

The entire name space is divided into many different zones. It is the area up to which the server has access. Zone is defined as a group of contiguous domains and sub domains. If the zone has a single domain, then zone and domain are the same.

Every zone has the server which contains a database called zone file. Using the zone file, the DNS server replies the queries about hosts in its zone. There are two copies of zone files available, Master file and slave file. Refer Figure 12.9

ICANN, Internet Corporation for Assigned Name and Numbers is the Non-profit Organization which assigns names and numbers for all Internet resources like domain names and IP addresses.

**DO YOU KNOW?**

- A domain is a single node of the Domain Namespace.
- A zone is a subset of the Domain namespace generally stored in a file.
- Domain Name space is an entire collection Domains, Sub domains and Zones
- Name server manages the database of domain names and corresponding IP addresses.
- A server can contain more than one zone files (Zones). A zone can contain more than one sub domains

**LETS RECAP**

![Figure 12.8 working structure of Name server](image-url)
**12.5.4 Resolver**

Domain Name System is a client/server application. A host system need to map domain name to IP address or vice versa according to the call and that work is done by resolver. Resolver either asks server to provide information about IP address. If it doesn’t find any information, then it sends the request to other servers and so on. Once the resolver receives the mapping, it checks whether it is an error or resolution (mapping) and provides result according to that.

**12.5.5 How DNS works?**

When the user enters the URL (consists of protocol, domain name, folder name, file name) in the browser, the system first checks its DNS cache for the corresponding IP address. If the IP address is found in the cache then the information is retrieved from cache. If not, then the system needs to perform DNS query i.e., the system needs to query the resolver about the IP address from Internet Service Provider (ISP). Each resolver has its own cache and if it is found in that then that information is retrieved. If not, then the query is passed to next domain.
Domain Name System (DNS) maintains all the directory of domain names and helps us to access the websites using the domain names. It translates the domain name into IP address.

IP address is a logical address used to uniquely identify a computer over the network. There are two types: IPv4 and IPv6.

IPv4 address is a 32 bit unique address given to a computer or a device. There are two ways to represent the IP address: Binary notation, Dotted-decimal notation.

Web Server

Web server is a program running on dedicated machine which handle the queries of www enduser. Server is used to host the websites and to deliver the contents of websites using HTTP. While typing the URL in browser, the browser send the URL to DNS. After getting an IP address from DNS, it sends the request to the web server with IP address. Now the content of websites appear on browser.

IANA is an affiliated authority of ICANN. IANA does the overall management of the DNS Root, IP addressing, and other Internet protocol resource handling. IANA takes care of a number of key aspects of the DNS, including the root zone, and the domains .int and .arpa.

https://www.iana.org/

The WHOIS is a service of ICANN. It is a free, publicly available directory containing the details of registered domain names and their owners (registrants). https://whois.icann.org/en

Points to remember

- Domain Name System (DNS) maintains all the directory of domain names and helps us to access the websites using the domain names. It translates the domain name into IP address.

- IP address is a logical address used to uniquely identify a computer over the network. There are two types: IPv4 and IPv6.

- IPv4 address is a 32 bit unique address given to a computer or a device. There are two ways to represent the IP address: Binary notation, Dotted-decimal notation.
IPv6 address is a 128 bit unique address given to a computer or a device. It follows Hexadecimal number notation.

URL (Uniform Resource Locator) is the address of a document on the Internet. URL is divided into two types: Absolute URL and Relative URL.

URL is made up of four parts- protocols, hostname, folder name and file name. Absolute URL contains all the four necessary and fundamental parts of URL.

Relative URL contains only folder name and the file name or just the file name.

There are 3 important components in the Domain Name System. They are **Namespace, Name server and Zone**.

**Label** is a string which can have maximum of 63 characters. Each node in that level should have unique label.

Domain name space is a tree like structure with root element on the top. It can have a maximum of 128 levels starting from root element taking the level 0 to level 127.

Domain name is the sequence of labels separated by dot (.). The domain name is always read from the leaf node to root node. The root node always represent NULL string. So All the domain name ends with dot.

In the domain name space (DNS) tree structure **domain** is a sub structure tree. The domain can be further divided into sub domains.

Name Servers are programs that run on a physical system and store all the zone data. It provides to clients when queried by them.

Zone is the contiguous part up to which the server has access. The domain assigned for the server does not divide into further sub domains then zone is same as domain.

Resolver, a client/ server application, initiates the process of resolving the domain names.
Part - I

Choose the correct answer

1. Which of the following is used to maintain all the directory of domain names?
   a) Domain name system  
   b) Domain name space  
   c) Name space  
   d) IP address

2. Which of the following notation is used to denote IPv4 addresses?
   a) Binary  
   b) Dotted-decimal  
   c) Hexadecimal  
   d) a and b
3. How many bits are used in the IPv6 addresses?
   a) 32
   b) 64
   c) 128
   d) 16

4. Expansion of URL is
   a) Uniform Resource Location
   b) Universal Resource Location
   c) Uniform Resource Locator
   d) Universal Resource Locator

5. How many types are available in Relative URL?
   a) 2   b) 3   c) 4   d) 5

6. Maximum characters used in the label of a node?
   a) 255   b) 128   c) 63   d) 32

7. In domain name, sequence of labels are separated by
   a) ;
   b) .(dot)
   c) :
   d) NULL

8. Pick the odd one out from the following.
   a) node   b) label
   c) domain   d) server

9. Which of the following initiates the mapping of domain name to IP address?
   a) Zone
   b) Domain
   c) Resolver
   d) Name servers

10. Which is the contiguous area up to which the server has access?
   a) Zone
    b) Domain
    c) Resolver
    d) Name servers

11. ISP stands for
    a) International Service provider
    b) Internet Service Provider
    c) Internet service Protocol
    d) Index service provider

12. TLD stands for
    a) Top Level Data
    b) Top Logical Domain
    c) Term Level Data
    d) Top Level Domain

13. Which of the following statements are true?
    i) Domains name is a part of URL.
    ii) URL made up of four parts
    iii) The relative URL is a part of Absolute URL
    iv) URL doesn’t contain any protocol
    a) i & ii   b) ii
    c) i, ii & iii   d) i, ii & iv

14. Assertion (A) : The number of addresses used in IPv6 addressing method is 128.
    Reason (R) : IPv6 address is a 128 bit unique address.
    a) A is true and R is false.
    b) A is false and R is true.
    c) Both A and R are correct and R is the correct explanation of A.
    d) Both A and R are correct and R is not the correct explanation of A.
10. What are the categories available in domain name space?
11. Write any four generic Top Level Domain.

Part - III
Explain in Brief Answer
1. Write a note on DNS.
3. Differentiate Domain name and URL
4. What are the differences between Absolute URL and Relative URL?
5. Write a note on domain name.
6. Differentiate web address and URL

Part - IV
Explain in detail
1. Explain briefly the components of DNS.
2. Classify and Explain the IP address.
3. Explain about the name server?
4. What is domain name space? Explain.
5. Explain how the DNS is working.

Part - II
Short Answers
1. List any four domain names.
2. What is an IP address?
3. What are the types of IP address?
4. What is an URL?
5. List out four URLs you know.
6. What are the types of URL?
7. What is a domain?
8. What is a zone?
9. What is a resolver?

Part - III
Explain in Brief Answer
10. What are the categories available in domain name space?
11. Write any four generic Top Level Domain.

Part - IV
Explain in detail
1. Explain briefly the components of DNS.
2. Classify and Explain the IP address.
3. Explain about the name server?
4. What is domain name space? Explain.
5. Explain how the DNS is working.

STUDENT ACTIVITIES

1. Find out IP address of your system
   i. Click start menu and type command or cmd to open command prompt
   ii. A command prompt window will be displayed. Type ipconfig and press enter.
   iii. The IP number is listed under IPv4 Address and IPv6 Address.
   iv. Find out the MAC address of the network card in the list.
   v. Find out and analyze what the other information displayed on the screen.
2. Find out IP address for the websites using command prompt
   i. Click start menu and type command or cmd to open command prompt.
   ii. A command prompt window will be displayed. Type tracert and press enter.
   iii. From the displayed window, You’ll see the IPv4 and IPv6 address.
   iv. Find out IP address for another website.

3. List out websites to find out IP address of other websites
   **For example:**

4. Use nslookup in command line and analyse what purpose it is used.

5. Buy your own domain name or create free sub-domain and connect free hosting servers.
   **For example:**
13.1 Introduction

Once the basics of computer was invented by Charles Babbage, the people started inventing much newer technology compatible with the computer. In the 19th Century the US military base had much technology to serve weapons and people but they did not have any technology to send a report from one place to another. Then slowly the word network grew bigger and bigger. Then the Advanced Research Projects Agency Network (ARPANET) was invented and the TCP/IP was adopted with ARPANET. Then the researchers began to research the “network of networks”.

First the network was within one computer to another computer, then it moved to one place to another place, then one city to another, then slowly it grew up and became one as Internet. The essential service of Internet is WWW (World Wide Web) which was invented by Tim Berners Lee. Internet can be accessed easily from anywhere but the setting up of the network is a big nightmare. Still network cables are being used worldwide to produce a faster Internet to the people. The network cables are used to transfer the data from one device to another device.

**Figure 13.1 Network cables**
*Source: Data center knowledge*
In the figure 13.1 huge and huge cables are used during network cabling, it really makes everyone confuse which wire should connect. So the process is going to reduce the number of cables and making alternatives in networking.

13.2 Types of Network Cables

There are many types of cables available in the networking. Here we discuss about six different cables.

1. Coaxial Cables: This cable was invented at late 1880’s, which is used to connect the television sets to home antennas. This cable is used to transfer the information in 10 mbps. The cable is divided into thinnet and thicknet cables. These cables have a copper wire inside and insulation is covered on the top of the copper wire to provide protection to the cable. These cables are very difficult to install and maintain, because they are too big to carry and replace. The coaxial cable got its name by the word “coax”. Nowadays coaxial cables are also used for dish TV where the setup box and the television is connected using the coaxial cable only. Some of the cable names are Media Bridge 50-feet Coaxial cable, Amazon basics CL2-Rated Coaxial cables, etc. See Figure 13.2

2. Twisted Pair Cables: It is type of cable with two or more insulated wires twisted together. It started with the speed of 10 mbps (10BASE-T cable is used). Then the cable is improved and the speed was higher and went to 100 mbps and the cable was renamed as 100BASE-TX. Then finally the cable improved more made to 10 gbps and named as 10GBASE-T. This twisted cable has 8 wires which are twisted to ignore electromagnetic interference. Also the eight wires cannot be placed in a single unit there could be a difficult in spacious, so it is twisted to make as one wire. There are two types of twisted pair cables, Unshielded Twisted Pair (UTP) and Shielded Twisted pair (STP). The UTP is used nowadays as modern cables for Internet and they are lower in cost and installation and maintenance is easy compared to the coaxial cables. STP is similar to UTP, but it is covered by an additional jackets to protect the wires from External interference. See Figure 13.3

3. Fiber Optics: This cable is different from the other two cables. The other two cables had an insulating material at the outside and the conducting material like copper inside. But in this cable it is of strands of glass and pulse of light is used to send the information. They are mainly
used in Wide Area Network (WAN). The WAN is a network that extends to very large distance to connect the computers. One example of WAN is Internet. These cables are placed in deep underground to avoid any damage to the cables. The optic cable uses light to transmit the information from one place to another. There are two types of fiber optic cables available, One is single-mode (100BaseBx) another one is Multimode (100BaseSX). Single-mode cables are used for long distance transmission and at a high cost whereas the multimode cables are used for short distance transmission at a very low cost. The optic cables are easy to maintain and install. See Figure 13.4

4. USB Cables: The Universal Serial Bus are used to connect keyboard, mouse and other peripheral devices. But there are some special network devices used to connect the Internet through the USB called dongles. The dongle is a small peripheral device which has a compatible of mobile broadband with a sim slot in it and connects the Internet and acts as a modem to the computer. See Figure 13.5

The latest version of USB is USB 3.0 which has the data transfer rate 4.85 Gbps. But USB 2.0 has just 480 Mbps.

Micro USB is a miniaturized version of the USB used for connecting mobile devices such as smart phones, GPS devices and digital cameras.

5. Serial and Parallel cables: Before In the year of 1980s to 1990s the Ethernet and the USB were not developed. Then the Serial and Parallel interface cables are used to connect the Internet to the system. They were sometime used for PC to PC networking. Before the USB emerged, the system will have both serial port and parallel port. The serial port will send 1 bit at one time
whereas the parallel port will send 8 bit at one time. The parallel cables are used to connect to the printer and other disk drivers. RS232 is one type of serial cable, also known as Null modem cable. See Figure 13.6.

6. **Ethernet Cables**: Ethernet cable is the most common type of network cable mainly used for connecting the computers or devices at home or office. This cable connects wired devices within the local area network (LAN) for sharing the resources and accessing Internet.

The Crossover Ethernet cable is an example of the Null modem Cables. This cable is used to join two PCs or two network devices of the same type. This cable is the sophisticated Ethernet cable used to connect the Internet to the system. This cable works at a speed of 10 gbps and more. The Ethernet crossover cable is identical on both the ends. Nowadays Routers are being connected through the crossover cables to provide wireless network from the local network. See Figure 13.7.

**Figure 13.6** The serial cable at the left and parallel cable at the right.

**Figure 13.7** The Ethernet cables.

13.3 **Ethernet Cabling Components**

Computer Networking is a group of interconnected computers or other devices for sharing the data and resources among them. Computers can be connected on the network with the help of wired media (Unshielded Twisted pair, shielded Twisted pair, Co-axial cables and Optical fibre) or wireless media (Infra Red, Bluetooth, WiFi).

Wireless networks enable more devices including mobiles sharing the resources and Internet connections remotely. But Compared to wireless networks, wired networks maintain a faster Internet speed and more secure. Wired networks for larger area are more expensive. Wired networks are still used widely in the offices where need increased speed and secure connections.

The computers with wired connections must be configured with
Ethernet cards. These cards enable the computers to have a connection with other devices by using Ethernet cables. The switches and routers may be used to increase the number of systems to be interconnected.

The Ethernet cable is the basic component of the Local Area Network (LAN); here the only one popular Ethernet wire is used, RJ45 Ethernet cable. Here we shall be discussing the different components used inside this Ethernet cable. The components of the Ethernet cable are RJ45 connector, patch cable (UTP cable), plastic covering. The RJ45 connector is made up of plastic cubes connected at both the ends. With this connector we will connect one end at the computer and other end at the LAN port. The patch cables have eight small wires inside. The plastic covering is used to provide protection to the wires when it is bending or twisted during connecting to the system or to the LAN port.

Ethernet cabling is the process of connecting the computers with other devices using Ethernet cables. The three main components are used in the Ethernet cabling components are

1. Patch Cable (Twisted pair)
2. RJ45 Connector
3. Ethernet Ports
4. Crimping Tool

13.3.1 Patch Cable (Twisted Pair)
These cables are generally made up of 8 wires in different colors. Four of them are solid colours, and the others are striped. The eight colors are white green, green, white orange, blue, white blue, orange, white brown and brown. The following figure 13.8 shows the patch cable.
### Chapter 13  Network Cabling

#### 13.3.2 RJ45 Connector

The RJ45 connector is a small plastic cup which will be used to connect the wire inside the connector and ready to connect the Internet. The RJ45 connector looks similar like a telephone jack but it looks a slightly wider. The Ethernet cables are sometime called as RJ45 cables. In RJ45 the “RJ” stands for the Registered Jack and the “45” simply refers to the number of interface standard in the cable. See Figure 13.9

![RJ45 Connector](image)

Each RJ45 connector has eight pins and connected to each end of the Ethernet cable. since it has 8-position, 8-contact (8P8C) modular plug, It is also known as 8P8C connector. These plugs (connector) are then inserted into Ethernet port of the network card.

**Wiring schemes and colour codes of the connector**

The RJ45 connector has eight small jack inside to connect eight small wires of the patch cable. The eight cables are in eight different colors. Let's discuss that eight colors and where does that eight colors connect to the RJ45 connector.

Wiring schemes specifies how the wires to be connected with RJ45 connector. There are two wiring schemes available to terminate the twisted-pair cable on each end, which are T-568A and T-568B. The Table 13.1 describes the pinouts and colour coding of these schemes.

<table>
<thead>
<tr>
<th>Pin</th>
<th>T-568A</th>
<th>Pin</th>
<th>T-568B</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>white / green stripe (Tx+)</td>
<td>1</td>
<td>white / orange stripe (Tx+)</td>
</tr>
<tr>
<td>2</td>
<td>green (Tx-)</td>
<td>2</td>
<td>orange (Tx-)</td>
</tr>
<tr>
<td>3</td>
<td>white / orange stripe (Rx+)</td>
<td>3</td>
<td>White / green stripe (Rx+)</td>
</tr>
<tr>
<td>4</td>
<td>blue</td>
<td>4</td>
<td>blue</td>
</tr>
<tr>
<td>5</td>
<td>white / blue stripe</td>
<td>5</td>
<td>white / blue stripe</td>
</tr>
<tr>
<td>6</td>
<td>orange (Rx-)</td>
<td>6</td>
<td>green (Rx-)</td>
</tr>
<tr>
<td>7</td>
<td>white / brown stripe</td>
<td>7</td>
<td>white / brown stripe</td>
</tr>
<tr>
<td>8</td>
<td>brown</td>
<td>8</td>
<td>brown</td>
</tr>
</tbody>
</table>

Although four pairs of wires are available in the cable, Ethernet uses only two pairs: Orange and Green. The other two colors (blue and brown) can be used ISDN or phone connections.

As we have already discussed about the pin details in the Ethernet connector. The position of the pin details briefly. Now let's see the pin details of the Ethernet ports, the pin 1 shows the transmission positive the pin 2 shows the transmission negative the pin 3 shows the receiver positive. The pin 4 shows the reserved position it is nothing but tells the connection for some other use. The pin 5, 7, 8 are also used as reserved position. The pin 6 shows the receiver negative. The two main signals of the pins: the one is the
TX which is transmission of data and RX which is Receiver of data. See Figure 13.10 & Figure 13.11

1. In the Figure 13.10 the position of pin no. 1 describes the transmit data or bidirectional, the bidirectional means it can be sent to both connection with the TX (positive). The TX+ has positive terminal and the color is used in this position is white green.

2. In the position of pin no. 2 describes the transmit data or bidirectional with the TX (negative). The TX- has negative terminal and the color is used in this position is Green.

3. In the position of pin no.3 describes the receive data or bidirectional with the RX (positive). The RX is compatible to receive the data which has positive terminal and the color is used in this position is white orange.

4. In this position of pin no. 4 describes that it is not connected or bidirectional. It means there will be no transmitting or receiving will exist. But it can be used later for some other connection. The color used in this pin is blue.
5. In this position of pin no. 5 describes that it is not connected or bidirectional and the color is white blue.

6. In this position of pin no. 6 describes the receive data or bidirectional with the RX (Negative) which has a negative terminal and the color used in this position is orange.

7. In this position of pin no. 7 describes that it is not connected or bidirectional and the color is white brown.

8. In this position of pin no. 8 describes that it is not connected or bidirectional and the color is brown.

13.3.3 Ethernet card and Port

Ethernet card is a Network Interface Card (NIC) that allows computers to connect and transmit data to the devices on the network. It may be an expansion card or built-in type. Expansion card is a separate circuit board also called as PCI Ethernet card which is inserted into PCI slot on motherboard of a computer. Now a days most of the computers come with built-in Ethernet cards which resides on motherboard. Wireless Ethernet cards are also available, which uses radio waves to transmit data. See Figure 13.12

Ethernet port is an opening which is a part of an Ethernet card. It accepts RJ45 connector with Ethernet cable. It is also called as RJ45 jack. It is found on personal computers, laptops, routers, switches, hubs and modems. We can see an Ethernet port on the back side of a computer or a laptop. It connects Ethernet cable with Ethernet card mounted on motherboard.

In these days, most of the computers and laptops have a built-in Ethernet port for connecting the device to a wired network. Some of them not having an Ethernet port use an Ethernet dongles to form a network with other devices. Devices or computers which use wifi only for networking eliminates both the cable and its port. See Figure 13.13

Once you inject the plug into the port the two led lights will glow in the computer; the one is green and another one is orange. The orange light will start blinks then it means the Internet is connected.
Crimping process for making Ethernet cables

1. Cut the cable with desired length
2. Strip the insulation sheath about 1 inch from both end of the cable and expose the Twisted pair wires
3. After stripping the wire, untwist the smaller wires and arrange them into the proper wiring scheme, T568B preferred generally.
4. Bring the wires tighter together and cut them down so that they all have the same length (½ inch).
5. Insert the all 8 coloured wires into the eight grooves in the connector. The wires should be inserted until the plastic sheath is also inside the connector.
6. Use the crimping tool to lock the RJ45 connector on the cable. It should be strong enough to handle manual traction. Now it is ready for data transmission.
7. Use a cable tester to verify the proper connectivity of the cable, if need. See Figure 13.15

TIPS

<table>
<thead>
<tr>
<th>Devices/Technology</th>
<th>Alternative Names</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ethernet Technology</td>
<td>RJ45, 802.3 (according to IEEE)</td>
</tr>
<tr>
<td>RJ45 Connector (male)</td>
<td>RJ45 plug, Ethernet connector, 8P8C connector</td>
</tr>
<tr>
<td>RJ45 socket (female)</td>
<td>RJ45 jack, Ethernet Port</td>
</tr>
<tr>
<td>RJ45 Cable</td>
<td>Ethernet cable,</td>
</tr>
</tbody>
</table>

13.3.4 Crimping Tool

Crimping is the process of joining two or more pieces of metal or wire by deforming one or both of them to hold each other. Joining RJ45 connector together with twisted pair cable at each end is an essential process in Ethernet cabling which lead the cable to function properly.

The crimping tool is a physical tool which is used to connect the patch wire and the Ethernet connector. The crimping tool looks like a small cutting handle with two mold of Ethernet port. The tool will puncture the connector and makes the wire set in the connector. See Figure 13.14

Figure 13.14 Crimping Tool for RJ-11 (6 pin) and RJ-45 (13 pin)

Figure 13.15 Crimping process using crimping tool
transmission configuration, the two pins give the receiver configuration and the other two pins will be kept for reserved. The two pin will have the positive terminal and the negative terminal.

Figure 13.16 comparison of RJ-45 with RJ-11

1. **RJ-11**: It is the most popular modern form of registered jack. It is found in home and office. This registered jack is mainly used in telephone and landlines. When we look the pin details of the RJ-11, there are 6 pin where the two pins give the

13.4 **Types of Jacks**

**Registered Jacks**: A Registered Jack commonly known as RJ is a network interface used for network cabling, wiring and jack construction. The primary function of the registered jack is to connect different data equipment and telecommunication devices. The commonly known registered jacks are RJ-11, RJ-45, RJ-21, and RJ-28. The registered jack refers to the male physical connector (Plug), a female physical connector (Jack) and it's wiring. We will talk some of the variety of registered jack below with some definitions. See Figure 13.16

1. **RJ-11**: It is the most popular modern form of registered jack. It is found in home and office. This registered jack is mainly used in telephone and landlines. When we look the pin details of the RJ-11, there are 6 pin where the two pins give the

Bob Metcalfe **invented Ethernet** in 1973 while at Xerox PARC (Palo Alto Research Center in California, USA) and the company patented it in 1975. It was used for interconnecting advanced computer workstations, making it possible to send data to one another and to high-speed laser printers. Metcalfe and others then finalized an open **Ethernet** standard in 1980, and by 1985 it had become an IEEE standard. An industry was born, and **Ethernet** was ready for its meteoric rise.

There have been a number of networking standards published in the 802 branch of the IEEE, including the 802.3 Ethernet and 802.5 Token Ring standards. The IEEE standard was first published in 1985 with the title *IEEE 802.3 Carrier Sense Multiple Access with Collision Detection (CSMA/CD) Access Method and Physical Layer Specifications*. The IEEE standard does not use “Ethernet” in the title, even though Xerox relinquished their trademark on the Ethernet name. That's because open standards committees are quite sensitive about using commercial names that might imply endorsement of a particular company. As a result, the IEEE calls this technology **802.3 CSMA/CD** or just **802.3**. However, most people still use the Ethernet name when referring to the network system described in the **802.3** standard.

Source: www.wikipedia.org
have 8 pins. This RJ-61 will use the twisted pair cable with a modular 8 connection. See Figure 13.17

13.5.1 Straight-Through Wiring
In general, the Ethernet cables used for Ethernet connections are “straight-through cables”. These cable wires are in the same sequence at both ends of the cable, which means that pin 1 of the plug on one end is connected to pin 1 of the plug on the other end (for both standard – T568A & T568B). The straight through wiring cables are mostly used for connecting PC / NIC card to a hub. This is a simple physical connection used in printers, computers and other network interfaces. See Figure 13.19

13.5.2 Cross-over Wiring
If you require a cable to connect two computers or Ethernet devices directly together without a hub, then you will need to use a Crossover cable instead. Then the pairs (Tx and Rx lines) will be crossed which means pin 1 & 2 of the plug on one end are connected with pin 3 & 6 of the plug on other end, and vice versa (3 & 6 to pin 1 & 2).

The easiest way to make a crossover cable is to make one end to T568A colour coding and the other end to T568B. Another way to make the cable is to remember the colour coding used in this type. Here Green set of wires at one end are connected with the Orange set of wires.

There are three types of wiring techniques to construct the Ethernet cable. It is also known as color coding techniques. They are

- Straight-Through Wiring
- Cross-over Wiring
- Roll-over Wiring
at another end and vice versa. Specifically, connect the solid Green (G) with the solid Orange, and connect the green/white with the orange/white. See Figure 13.20

![Cross over wiring](image)

**Figure 13.20 Cross over wiring**

### 13.5.3 Roll-over Wiring

Rollover cable is a type of null-modem cable that is often used to connect a device console port to make programming changes to the device. The role over wiring have opposite pin arrangements, all the cables are rolled over to different arrangements. In the rollover cable, the coloured wires are reversed on other end i.e. The pins on one end are connected with other end in reverse order (i.e. pin 1 to 8, 2 to 7, 3 to 6, 4 to 5, 5 to 4, 6 to 3, 7 to 2, 8 to 1).

Rollover cable is also known as Yost cable or Console cable. It is typically flat (and light blue color) to distinguish it from other types of network cabling.

![Rollover Wiring](image)

**Figure 13.21 Roll over Wiring**

These all the three arrangements are used to perform an interface change. But, all the three arrangements transmits the data at the same speed only. See Figure 13.21

**How to determine the type of Ethernet cables?**

**Straight-through:** The coloured wires are in the same sequence at both ends of the cable.

**Cross-over:** The first coloured wire at one end of the cable is the third coloured wire at the other end of the cable.

**Roll-over:** The coloured wires are in the opposite sequence at either end of the cable.

---

**POINTS TO REMEMBER**

- By using World Wide Web, now people can access the network from different parts of the world.
- The Network cables are used to transfer the data and information to another computer.
- Coaxial cables are used for connecting the television with setup box.
- Twisted cable has 13 wires which are twisted to ignore electromagnetic interference.
- Two types of twisted pair cables are Unshielded Twisted Pair (UTP) and Shielded Twisted pair (STP).
- The optic cable uses light to transmit the information from one place to
another. They are mainly used in Wide Area Network (WAN).

- There are two types of fibre optic cables available are Single-mode (100BaseBx) and Multimode (100BaseSX).
- Single-mode cables are used for long distance transmission and at a high cost whereas the multimode cables are used for short distance transmission at a very low cost.
- USB cables are used to connect keyboard, mouse and other peripheral devices.
- The serial port will send 1 bit at one time whereas the parallel port will send 13 bit at one time.
- The parallel cables are used to connect to the printer and other disk drivers.
- Cross over cable is used to join two network devices of the same type like example two PCs or two network devices. The Null modem cables are the example of the crossover cables.
- The Ethernet cable is the basic component of the Local Area Network (LAN).
- The RJ45 Ethernet connector is a small plastic cup which will be used to connect the wire inside the connector and ready to use to connect the Internet.
- The RJ45 connector has eight small pins inside to connect eight small wires in the patch cable. The eight cables has eight different colours.
- The Ethernet port is the jack where the Ethernet cable is to be connected. This port will be there in both the computers and the LAN port.
- The crimping tool is a physical tool which is used to connect the patch wire and the Ethernet connector (RJ45).
- A Registered Jack (RJ) is a network interface used for connecting different data equipment and telecommunication devices.
- RJ11 jack is mainly used in telephone and landlines.
- There are three wiring techniques available in Ethernet cables: Straight through Wiring, Cross over Wiring and Roll over Wiring.

**GLOSSARY**

<table>
<thead>
<tr>
<th>ARPANET</th>
<th>Advanced Research Project Agency Network, predecessor to the modern Internet</th>
</tr>
</thead>
<tbody>
<tr>
<td>10BASE-T / 100BASE-TX</td>
<td>10 Mbps / 100 Mbps</td>
</tr>
<tr>
<td>100BASE-FX</td>
<td>Mbps stands for Mega bits per second</td>
</tr>
<tr>
<td>100BASE-BX</td>
<td>T stands for Twisted pair</td>
</tr>
<tr>
<td>100BASE-SX</td>
<td>X stands for number of paired copper wires</td>
</tr>
<tr>
<td></td>
<td>F, B, S – Fibre optic cables</td>
</tr>
</tbody>
</table>
| **WAN** | **Wide Area Network,**
|         | **WAN is the network that spans large geographical area** |
| **USB** | **Universal Serial Bus, connects all the peripheral devices with the computers** |
| **Null modem cables** | **A communication method directly connects two computers without modem or any equipment.** |
| **LAN** | **Local Area Network in which the devices used in home or office interconnected for sharing the resources.** |
| **TX / RX** | **Transmit / Receive signals used in connectors** |
| **Dongles** | **The dongle is a small peripheral device with a sim slot in it and connects the Internet and acts as an Ethernet port to the computer.** |

**Part - I**

**Choose the correct answer**

1. **ARPANET stands for**
   - a) American Research Project Agency Network
   - b) Advanced Research Project Area Network
   - c) Advanced Research Project Agency Network
   - d) American Research Programs And Network

2. **WWW was invented by**
   - a) Tim Berners Lee
   - b) Charles Babbage
   - c) Blaise Pascal
   - d) John Napier

3. **Which cable is used in cable TV to connect with setup box?**
   - a) UTP cable
   - b) Fibre optics
   - c) Coaxial cable
   - d) USB cable

4. **Expansion of UTP is**
   - a) Uninterrupted Twisted Pair
   - b) Uninterrupted Twisted Protocol
   - c) Unshielded Twisted Pair
   - d) Universal Twisted Protocol

5. **Which medium is used in the optical fibre cables to transmit data?**
   - a) Microwave
   - b) Infra red
   - c) Light
   - d) Sound

6. **Which of the following is a small peripheral device with a sim slot to connect the computers to Internet?**
   - a) USB
   - b) Dongles
   - c) Memory card
   - d) Mobiles

7. **Which connector is used in the Ethernet cables?**
   - a) RJ11
   - b) RJ21
   - c) RJ61
   - d) RJ45
8. Which of the following connector is called as champ connector?
   a) RJ11
   b) RJ21
   c) RJ61
   d) RJ45

9. How many pins are used in RJ45 cables?
   a) 8
   b) 6
   c) 50
   d) 25

10. Which wiring standard is used for connecting two computers directly?
    a) straight Through wiring
    b) Cross Over wiring
    c) Rollover wiring
    d) None

11. Pick the odd one out from the following cables
    a) roll over
    b) cross over
    c) null modem
    d) straight through

12. Match the following
    1. Ethernet - Port
    2. RJ45 connector - Ethernet
    3. RJ45 jack - Plug
    4. RJ45 cable - 802.3
    a. 1, 2, 4, 3
    b. 4, 1, 3, 2
    c. 4, 3, 1, 2
    d. 4, 2, 1, 3

**Part - II**

**Short Answers**

1. Write a note on twisted pair cable.
2. What are the uses of USB cables?
3. Write a note on the types of RJ45 connector.
4. What is an Ethernet port?
5. What is the use of Crimping tool?
6. What are the types of twisted pair cables?
7. What is meant by champ connector?

**Part - III**

**Explain in Brief Answer**

1. Write a note on crossover cables.
2. Write a short note on RJ45 connector.
3. What are the differences between serial and parallel ports?
4. What is meant by null modem cable?
5. What are the components involved in Ethernet cabling?
6. What are the types of Fibre optic cables?

**Part - IV**

**Explain in detail**

1. What is meant by Registered Jack? Explain briefly the types of Jacks.
2. Explain wiring techniques used in Ethernet cabling.
3. Explain about RJ45 connector.
4. Explain the components used in Ethernet cabling.
5. Explain the types of network cables
1. Make your own Crossover cable.
   A. Purchase the following
      i. a patch cable (UTP cat 5e / 6) with desired length
      ii. RJ45 connector (8P8C modular plug) of both wiring schemes (T568A and T568B)
      iii. Crimping Tool
   B. Construct the cable using the method described in the textbook, with the help of crimping tool

2. Connect two computers using Crossover cable for sharing resources
201

Open Source Software is usually created and updated by many programmers around the world and made freely accessible. Proprietary software is owned by an organization or individual. The makers of proprietary software have not allowed the users or other developers to view or edit the source code. But the advantage of the proprietary software is that it gives more control, support, training, security and stability for user making the software reliable to the users.

In a network it is not easy to find problems. Especially when there are more systems are connected, the complexity is more, so we need Network Software to Control, Analysis the Server, System, protocol, Network, Traffic flow and reports about ups and downs of network parts. Notification help the user and administrator easily find working status of network systems and hardware. Alert message give details of faults, where and when it happens.

14.1 Introduction

Free software and compilers were provided with early computer hardware. With these human understandable code the user can modify, add new code and identify the errors.

Can anyone change the codes in open source software?

Open source software has been developed by a variety of programmers. However, to add a new change to the software, the modified codewill be submitted to a group of dedicated programmers. These programmers then test the modified codes and if itsatisfies the appropriate rules, it will then be distributed to all.

Why it called open source

Open Source simply refers to making the source code of the software freely available for users or other developers to use and make changes into the original repository or fork the project into and build a new one. Open source software is usually created and updated by many programmers around the world and made freely accessible. Proprietary software is owned by an organization or individual. The makers of proprietary software have not allowed the users or other developers to view or edit the source code. But the advantage of the proprietary software is that it gives more control, support, training, security and stability for user making the software reliable to the users.

In a network it is not easy to find problems. Especially when there are more systems are connected, the complexity is more, so we need Network Software to Control, Analysis the Server, System, protocol, Network, Traffic flow and reports about ups and downs of network parts. Notification help the user and administrator easily find working status of network systems and hardware. Alert message give details of faults, where and when it happens.

LEARNING OBJECTIVES

To know the
- Need of Open Source Software.
- NS2 and its Use
- OpenNMS and Group which created OpenNMS
- OpenSource Hardware
NRCFOSS
National Resource Centre for Free and Open Source Software an Institution of Government of India. To help in development of FOSS in India

Organizations related to Open Source
- Apache Software Foundation
- The Document Foundation
- The Eclipse Foundation
- Free Software Foundation
- Linux Foundation
- OpenCourseWare Consortium
- Open Source Initiative

BOSS
BOSS (Bharat Operating System Solutions) Operating System Developed in India by C-DAC (Centre for Development of Advanced Computing) Help to prompt the use of open source software in India. It Supports many India Languge.

Types of open source license
- Apache License 2.0
- BSD 3-Clause “New” or “Revised” license
- BSD 2-Clause “Simplified” or “FreeBSD” license
- GNU General Public License (GPL)
- GNU Library or “Lesser” General Public License (LGPL)
- MIT license
- Mozilla Public License 2.0
- Common Development and Distribution License
- Eclipse Public License

When you change the source code, OSS requires the inclusion of what you altered as well as your methods. The software created after code modifications may or may not be made available for free.

Open-Source Software vs. Free Software
Although the terms are often used interchangeably, OSS is slightly different from free software. Both deal with the ability to download and modify software without restriction or charge. However, free software a concept developed in the 1980s by an MIT computer science researcher, Richard Stallman is defined by four conditions, as outlined by the nonprofit Free Software Foundation. These “four freedoms” emphasize the ability of users to use and enjoy software as they see fit.

In contrast, the OSS criteria, which the Open Source Initiative developed a decade later, place more emphasis on the modification of software, and the consequences of altering source code, licensing, and distribution.

Obviously, the two overlap; some would say the differences between OSS and free software are more philosophical than practical. However, neither should be confused with freeware. Freeware usually refers to proprietary software that users can download at no cost, but whose source code cannot be changed.
**Open-Source Software and Developers**

OSS projects are collaboration opportunities that improve skills and build connections in the field. Domains that developers can contribute to the open source community include:

- Communication tools.
- Distributed revision control systems.
- Bug trackers and task lists.
- Testing and debugging tools.

**How Open Source work**

[Diagram showing the process of open-source development and improvement.]
Benefits of Open Source software and tools

- There are many opensourcesoftwares. so we can select and use any software that suits our needs.
- The complete options of the software can be used without any cost and restrictions.
- We can share our ideas with the team, write the required code and share it with many.
- As we can identify the programming techniques of group members, we can learn many ideas and make our program writing skills more efficient.
- The coding in opensourcesoftwares are being groomed by many enthusiastic members of the group. So if we report problems that we have in the program they are quickly mended by the group's effort.
- As we can make changes to the opensourcesoftwares, we can add the most required features in the software.
- Many open source software are very user friendly.

Like benefits Opensource Software also have Some Problems Like Difficult to work for beginners, Exchange of files to other softwares, Some time Lack of Responsibility, service and problems with hardware compatible.

Example of open source Application software

NS2 , OPEN NMS, Ubuntu , MySQL, PDF Creator, Open Office, 7zip GNU CASH, GIMP, BLENDER, AUDACITY, VLC, MOZILA FIREFOX, MAGENTO, ANDROID, PHP

14.2 Network simulation tool – NS2

In computer network, network simulation is a method whereby a software program models the activities of a network by calculating the communication between the different network objects such as (routers, nodes, switches, access points, links etc.). A network simulator is a software program that replicates the functioning of a computer network. In simulators, the computer network is typically demonstrated with devices, traffic etc. and the performance are evaluated. Normally, users can then adapt the simulator to accomplish their precise analysis needs. The network parameters define the state of the network (node placement, existing links) and the events (data transmissions, link failures, etc.). A significant output of simulation is the trace files. Trace files can document every incident that happened in the simulation and are used for examination.

NS2 is the abbreviation of NETWORK SIMULATOR version 2. It was considered explicitly for exploration in network communication and event-driven open-source simulator in computer.

OTCL and c++ used to create and run NS2. NS2 works on Windows and Linux platforms, that supports wired or wireless network and also use the command line interface as a user interface, API a pure event base software tool with super simulation design, it has more models which help the user to get desired output easily.
Open NMS (Network Management System) is a free and open-source initiative grade network monitoring and management platform. It is established and maintained by a community of users, developers, and by the Open NMS Group. Offering services, training, and support. The goal is for Open NMS to be an actually distributed, scalable management application platform for all features of the FCAPS (Fault, configuration, accounting, performance, security) network management model. Presently the emphasis is on Fault and Performance Management.

It was intended to cope with tens of thousands of devices from a single server as well as achieve unlimited devices using a cluster of servers. OpenNMS comprises a discovery engine to routinely configure and manage network devices without operator intervention. It is written in Java and is issued under the GNU (General Public License.)

OpenNMS is the World's first software for Network monitor and management with open-source options. There are two types in this Meridian and Horizon. When we need stability and long-term support, choose Meridian which is best for Enterprises as well as businesses. Horizon used where innovation occurs frequently. It is Best for IT-ecosystem, new technology monitoring. OpenNMS was released in 1999 by Steve Giles, Brian Weaver, and Luke Rindfuss.

In 2004 OpenNMS Group was created by Balog, Matt Brozowski, and David Hustace. It is written in Java and can run on all type of platform. It gives us Event management & Notification, Discovery & Provisioning, service monitoring and Data Collection. Won lot of awards for best of opensource software.

OpenNMS has three main functional areas:

- Service monitoring, where a number of monitor modules can govern if network-based services (ICMP, HTTP, DNS, etc.) are accessible.
- Data Gathering by using SNMP and JMX.
- Event management and notifications, which comprises of alarm reduction and a robust announcement system with accelerations and duty schedules.

OpenNMS is recognized for its scalability. Though it can be easily used to handle a small SMB Network, it is also accessible enough to be used in place of large enterprise management products such as HP Open View, IBM Microtune or IBM Tivoli.

In this period of increased competition and cyber crimes, the computers used by individuals or business organizations may have spy hardwares of rivals. Open source hardware technology helps in such threats. In this technique we get the components of the hardware and its circuit diagram, so that we can remove suspicious spyware if found.

---

**Open Source Hardware**

- Remix
- Remake
- Remanufacture
- Redistribute
- Resell
- Study and Learn
Open Source denotes to some program whose source code is made available for usage or reform as users or other developers see appropriate.

In simulators, the computer network is typically demonstrated with devices, traffic etc. and the performance are evaluated.

A significant output of simulation is the trace files. Trace files can document every incident that happened in the simulation and are used for examination.

NS2 has C++ and Object-oriented Tool Command Language (OTcl) of languages 2.

It link together for C++ and the OTcl using TclCL.

Open NMS (Network Management System) is a free and open-source initiative grade network monitoring and network management platform.

Network monitoring software notifications help the user/administrator for fixed errors.

---

**Glossary**

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>NS2</td>
<td>Network Simulation 2</td>
</tr>
<tr>
<td>OpenNMS</td>
<td>First Open Source Network Management Software</td>
</tr>
<tr>
<td>Trace File</td>
<td>A document file, consists of every incident happens in a simulation</td>
</tr>
<tr>
<td>OTCL</td>
<td>Object-oriented Tool Command Language</td>
</tr>
<tr>
<td>FCAPS</td>
<td>Fault, configuration, accounting, performance, security</td>
</tr>
<tr>
<td>GNU</td>
<td>General Public License</td>
</tr>
<tr>
<td>SSFNet</td>
<td>Scalable Simulation Framework Net Models</td>
</tr>
<tr>
<td>API</td>
<td>APPLICATION PROGRAM INTERFACE</td>
</tr>
<tr>
<td>SOURCE CODE</td>
<td>Set of Instructions that decide, how the software should work</td>
</tr>
<tr>
<td>BOSS</td>
<td>Bharat Operating System Solutions</td>
</tr>
<tr>
<td>C-DAC</td>
<td>Centre for Development of Advanced Computing</td>
</tr>
</tbody>
</table>
Part - I
Choose the correct answer

1. If the source code of a software is freely accessible by the public, then it is known as
   a) freeware
   b) Firmware
   c) Open source
   d) Public source

2. Which of the following is a software program that replicates the functioning of a computer network?
   a) Network software
   b) Network simulation
   c) Network testing
   d) Network calculator

3. Which of the following can document every incident that happened in the simulation and are used for examination?
   a) Net Exam
   b) Network hardware
   c) Trace file
   d) Net document

4. Which is an example of network simulator?
   a) simulator
   b) TCL
   c) Ns2
   d) C++

5. Fill in the blanks: NS2 comprises of _______ key languages?
   a) 13      b) 3      c) 2      d) 4

6. Choose the Correct Pair from the following to build NS2
   a) UNIX & TCL
   b) UNIX & a. C++
   c) C++ & OTcl
   d) C++ & NS2

7. Which of the following is not a network simulation software?
   a) Ns2
   b) OPNET
   c) SSFNet
   d) C++

8. Which of the following is a open source network monitoring software?
   a) C++
   b) OPNET
   c) Open NMS
   d) OMNet++

9. Open NMS was released in
   a) 1999      b) 2000
   c) 2003      d) 2004

10. OpenNMS Group was created by
    a) Balog
    b) Matt Brozowski
    c) David Hustace
    d) All of them.
Part - II

Short Answers
1. Explain the History of open source software
2. What is meant by network simulator?
3. What is trace file?
4. Write short notes on NS2.
5. Explain NRCFOSS.
6. Write short note on Open NMS?

Part - III

Explain in Brief Answer
1. What are the uses of Open source Network Software?
2. Explain Free software.
3. List out the Popular open source software.
4. Write note on open source hardware.
5. What are the main functional areas of Open NMS?
6. Explain Types of Organisations related to Open Source.

Part - IV

Explain in detail
1. Differentiate Proprietary and open source software.
2. List out the Benefits of Open Source Software
3. Explain various Open Source License.

STUDENT ACTIVITIES
1. Mention Open source software and free software names that not explain in this chapter.
2. Mention Software that are accounts related.
3. Mention Open Source Developing and maintaining companies
In near future commercial activities such as buying or selling of goods between merchant and consumer will be bygone and forgotten like barter system.

In near future commercial activities such as buying or selling of goods between merchant and consumer will be bygone and forgotten like barter system.

15.1 Introduction to E-Commerce

“The wise possess all”. Anyone who is quick to identify and adopts innovations would be successful. Commerce always profits from innovations. Successful businesses quickly identify developing opportunities in emerging new technology, and expand their commercial capabilities.

The customer goes to the market, checking out a variety of products, choosing required stuff, purchasing them and then paying the specific amount is traditional commerce. However, recent ways of buying or selling goods and services have come up with technology innovations.

Like the most other things, the Internet and technology have changed the way that commerce is conducted. Refer Figure 15.1
In 1996, IBM coined the term E-Business. Just as business is broader than commerce, E-Commerce is a subset of E-Business. E-Commerce is commercial transaction through Internet, but E-Business entirely depends on the Internet for its every intra-company and inter-company activities such as procurement of raw materials, marketing, finance, manufacturing, selling and negotiation.

While, E-Commerce is limited with monetary transactions using Internet E-Business is grounded on technologies such as Network Infrastructures (like Internet, Intranet, Extranet), Multimedia content & network publishing infrastructures (like HTML, Online Marketing), Messaging & information distribution infrastructures (like EDI, e-mail, http, Computerized Inventory Management Systems) and other Common business service infrastructures (like electronic payments gateways, globalized Supply Chain Management (SCM), Online Transaction Processing). See Figure 15.2

A company can be called E-Business if and only if

- It has the ability to conduct business electronically over Internet.
- It manages payment transaction through Internet.
- It has a platform for selling products & services via Internet.

**Definition**

E-Commerce is currently one of the most important aspects of the Internet era. Just like the words e-mail, e-book with the prefix ‘e’ (‘e’ stands for electronic) Commerce and Internet makes E-Commerce. It also allows the consumers to exchange goods and services with no barriers of time or distance. Electronic commerce has expanded rapidly over the past few years and is predicted to accelerate.

**E-Commerce can be described as the process of buying or selling products, services or information via computer networks.**

It could be a consumer based retail sites or auction sites or trade between large business organizations. The commodity could be a laptop or a wrist watch or it could be an operating system or a simple browser plugin.

The goods, information or services are delivered in tangible or electronic form. See Figure 15.3

**Figure 15.2** E-Business building block

**Figure 15.3** Tangible and intangible goods.
- Goods - e.g. mobile phones, digital cameras, clothes, accessories, antivirus.
- Information - e.g. subscription to some newspapers, scientific journals, television channels.
- Services - e.g. matrimonial services, placement services.
- Tangible form – e.g. a digital camera purchased by a consumer from an online shopping website which might be delivered at the requested address.
- Electronic form – e.g. a music album or a software downloaded from a site which might be delivered in electronic form.

15.2 The Evolution of Electronic Commerce

E-Commerce is not a completely new type of commerce. The dawn of E-Commerce started few decades ago and, continues to grow exponentially. It first emerged on private networks in 1970s. Electronic Data Interchanges and teleshopping together paved the way for the E-Commerce.

The history of modern E-Commerce is closely twisted together with the history of the Internet. E-Commerce became really possible when the Internet was opened to commercial use. Online shopping started to grow when National Science Foundation opened the Internet to the public in 1991. Since then businesses have started to take up residence at websites.

With the progress of the Internet technology and vastly developed global Internet community, large number of Dotcoms, FinTech and Internet Startups have appeared and a strong foundation of electronic commerce continues to build.

The Internet had provided new commercial potential not only for large organizations, but also provided a sustainable entry point for Small and Medium-sized Enterprises (SMEs) of E-Commerce. Today, E-Commerce is no longer an exclusive domain of large organizations or private networks.

Even though E-Commerce has been existing since few decades, it has recently sustained significant growth. It is because the Internet has transformed from an auxiliary communication medium of academics and large organizations to an entrenched communication medium that extends nearly all parts of mainstream society. Integrated with commercialization of the Internet, personal computers and electronic payment systems together made E-Commerce flourish.

In 1979, Michael Aldrich, an English entrepreneur, proposed a technique that enables online transaction processing between consumers and businesses, or between businesses. It was later proficiently called as E-Commerce. In 1980 he invented a multi-purpose home infotainment device called Teleputer, which was a fusion of Television, Computer and Telecom networking technologies.
Growth of E-Commerce is also related to the socio-technological changes. The more, the medium becomes deep-rooted, the more, are the users drawn towards it. Increase of users, increases the markets. As the markets expand, more business organizations are attracted. The more businesses accumulate it create competition. The competition leads to innovation; innovation in turn drives the development of technology; technology facilitates E-Commerce’s growth. See Figure 15.4

In August 11, 1994 by noon of the day, Phil Brandenberger of Philadelphia (U.S.A), bought a music CD (Sting’s “Ten Summoners’ Tales”) from Kohn of Nashua (U.S.A) and paid $12.48 plus shipping charges using his credit card through online. This is marked as the first true E-Commerce transaction.

Figure 15.4 Timeline describing various events in E-Commerce
15.3 The Development and Growth of Electronic Commerce

Economists describe four distinct waves (or phases) that occurred in the Industrial Revolution. In each wave, different business strategies were successful. Electronic commerce and the information revolution brought about by the Internet likely go through such series of waves. Refer Figure 15.5


The Dotcom companies of first wave are mostly American companies. Thereby their websites were only in English. The Dotcom bubble had attracted huge investments to first wave companies.

As the Internet was mere read-only web (web 1.0) and network technology was in its beginning stage, the bandwidth and network security was very low. Only EDI and unstructured E-mail remained as a mode of information exchange between businesses. But the first wave companies enjoyed the first-move advantage and customers had left with no options.


The second wave is the rebirth of E-Commerce after the dotcom burst. The second wave is considered as the global wave, with sellers doing business in many countries and in many languages. Language translation and currency conversion were focused in the second wave websites. The second wave companies used their own internal funds and gradually expanded their E-Commerce opportunities. As a result E-Commerce grows more steadily, though more slowly. The rapid development of network technologies and interactive web (web 2.0, a period of social media) offered the consumers more choices of buying. The increased web users nourished E-Commerce companies (mostly B2C companies) during the second wave.

- The Third Wave of Electronic Commerce: 2010 – Present

The third wave is brought on by the mobile technologies. It connects users via mobile devices for real-time and on-demand transactions. mobile technologies. It connects users via mobile devices for real-time and on-demand transactions. Not only the information is filtered by time, but

Figure: 15.5 Evolution of Electronic Commerce
also the geographic coordinates are used to screen the specific location-tailored information properly. The term Web 3.0, summarize the various characteristics of the future Internet which include Artificial Intelligence, Semantic Web, Generic Database etc.

15.4 Classification of E-Commerce Business models

Business organizations, Consumers and Government (also called as Administrations) are the major parties in the E-Commerce. Sometimes Employees (Informal workers) also indulge in this system. Based upon the entities involved in transaction, E-Commerce has been classified into the following typical categories. The model in which the government plays as an entity is termed as e- Governance. See Figure 15.7

<table>
<thead>
<tr>
<th>BUSINESS</th>
<th>CONSUMER</th>
<th>GOVERNMENT</th>
</tr>
</thead>
<tbody>
<tr>
<td>C2B</td>
<td>C2C</td>
<td>C2G</td>
</tr>
<tr>
<td>G2B</td>
<td>G2C</td>
<td>G2G</td>
</tr>
</tbody>
</table>

Figure 15.6 E-Commerce business models

1. Business to Business (B2B)
2. Business to Consumer (B2C)
3. Business to Government (B2G)
4. Consumer to Business (C2B)
5. Consumer to Consumer (C2C)
6. Consumer to Government (C2G)
7. Government to Business (G2B)
8. Government to Consumer (G2C)
9. Government to Government (G2G)

● Business to Business (B2B)

In B2B E-Commerce, commercial transactions take place between different business organizations, through the Internet. For example, a cycle company

Dotcom Bubble

The Dotcom Bubble was a historic excessive growth (excessive assumption) of economy that occurred roughly between 1995 and 2000. It was also a period of extreme growth in the usage and adaptation of the Internet as well.

In the late 1995, there was a tremendous development in US equity investments in Internet-based companies. During the dotcom bubble, the value of equity markets grew exponentially with the NASDAQ composite index of US stock market rising from under 1000 points to more than 5000 points.

Dotcom Burst

The Nasdaq-Composite stock market index, fell from 5046.86 to 1114.11. This is infamously, known as the Dotcom Crash or Dotcom Burst. This began on March 11, 2000 and lasted until October 9, 2002. During the crash, thousands of online shopping companies, like as Pets.com failed and shut down. Some companies like Cisco, lost a large portion of their market capitalization but survived, and some companies, like Amazon declined in value but recovered quickly.
may buy tyres from another company for their cycles. When compared to other models, the value per transaction in B2B transaction is high, because of bulk purchases. The company also might get the advantage of discounts on bulk purchases. See Figure 15.7

Out-sourcing and Off-shoring are generally associated with B2B E-Commerce.

- If a company’s work is hired to another company, it would be termed as out-sourcing.
- If the work is outsourced to a company, which is outside of its own country, is termed as off-shoring.

![Figure 15.7 Business to Business](image)

- **Business to Consumer (B2C)**

  In B2C E-Commerce, commercial transactions take place between business firms and their consumers. It is the direct trade between companies and end-consumers via the Internet. B2C companies sell goods, information or services to customers through online in a more personalized dynamic environment and is considered as real competitor for a traditional storekeeper. An example of B2C transaction is a book company selling books to customers. This mode is intended to benefit the consumer and can say B2C E-Commerce works as ’retail store’ over Internet. See Figure 15.8

![Figure 15.8 Business to Consumer](image)

- **Business to Government (B2G)**

  B2G is a business model that refers to business organizations sells products, services or information to Governments or to its administrations. In other words, when a company get paid for its goods, services by the Government through Internet it is called as B2G model. B2G networks models provide a way for businesses to bid on Government projects or products those Governments might need for their organizations. e.g. A Government or its administration buys laptops for students from a business. See Figure 15.9
- **Consumer to Business (C2B)**

C2B can be described as a form of E-Commerce where, the transaction is originated by the consumers. The consumers will fix a set of requirements or specific price for a service or a commodity. C2B model, is also called as reverse auction model. Here, customer bid his price for a service or a product. Then E-Commerce business entity will match the requirements of the consumers to the best possible extent.

For instance, in a travel website (eg.yatra.com) a consumer may specify his dates of travel, his source and destination, number of tickets required and range of hotel etc. The website then finds out the various options for him which best meets his requirements. These websites generate revenue through affiliate links, sponsored advertisement or even a small commission in every booking. e.g. Name-your-price websites. See Figure 15.10

- **Consumer to Consumer (C2C)**

C2C in E-Commerce provides opportunity for trading of products or services among consumers who are connected through the Internet. In brief when something is bought and sold between two consumers using Internet it is called C2C E-Commerce. Here the websites act as a platform to facilitate the transaction. The electronic tools and Internet infrastructure are employed to support transactions between individuals. Typically, this type of E-Commerce works as Consumer to Business to Consumer (C2B2C). It means that a consumer would contact a business in search for a suitable customer. Most of the auction websites and matrimonial websites are working on this methodology.

For example, a consumer who wants to sell his property can post an advertisement on the website (eg:timesclassifieds.com). Another person who is interested in buying a property can browse the property, advertisement posted on this site. Thus, the two consumers can get in touch with each other for sale/purchase of property through another business’ website. See Figure 15.11
o Consumer to Government (C2G)

Citizens as Consumers and Government engage in C2G E-Commerce. Here an individual consumer interacts with the Government. C2G models usually include income tax or house tax payments, fees for issuance of certificates or other documents. People paying for renewal of license online may also fall under this category. See Figure 15.12

![Figure 15.11 Consumer to Consumer](image)

Figure 15.11 Consumer to Consumer

o Government to Business (G2B)

G2B is closely related to B2G. G2B in E-Commerce refers to a business model where Government providing services or information to business organization. It may be a formal offer such as a takeover bid for a road project. See Figure 15.13

![Figure 15.12 Consumer to Government](image)

Figure 15.12 Consumer to Government

G2B is a part of e-governance. The Government provides information about business rules, requirement and permission needed for starting a new business, and other specifications in its portal. The objective of G2B is to reduce burdens on business, provide one-stop access to information thereby boost the economy. e.g. ebiz.gov.in See Figure 15.14

![Figure 15.13 Government to Business](image)

Figure 15.13 Government to Business

![Figure 15.14 ebiz.gov.in](image)

Figure 15.14 ebiz.gov.in
● **Government to Consumer (G2C)**

G2C in E-Commerce is very similar to C2G. Here the Government provides platform for its citizens to avail its services and information through the Internet. The services may be issuance of certificates through online. e.g. https://csc.gov.in/governmenttocitizen. See Figure 15.15

![Government to Consumer](image)

**Figure 15.15** Government to Consumer

- **Government to Government (G2G)**

G2G is the online (usually non-commercial) interaction between Government organizations or departments. G2G’s principle objective is to implement e-governance rather commerce. G2G model in e-governance involves distributing data or information between its agencies/departments. G2G systems can be classified into two types

- Internal facing or local level - joining up a single Government’s bureaucracies. e.g. https://www.nic.in/
- External facing or international level - joining up multiple Governments’ bureaucracy.

See Figure 15.16

![Government to Government](image)

**Figure 15.16** Government to Government

### 15.5 E-Commerce Revenue Models

Apart from regular selling of commodities, today there are many other ways by which companies can make money from the Internet. The other forms of E-Commerce activities are:

1. **Affiliate site** is a form of third party marketing in which the site owner get paid based on the performance. The affiliate site may be a price comparison service or shopping directories or review sites or blogs that contain a link to a normal retailing site and are paid when a customer makes a purchase through it. The affiliate site usually attracts visitors by offering more information and tutorials on some specific product or a topic. See Figure 15.17 to Figure 15.23
2. Auction site is a kind of website, that auctions items on the Internet and levies some commission from the sales. e.g. https://www.ebay.com/

Figure 15.17 Affiliate site (price comparison website)

Figure 15.18 E-Auction website
3. Banner advertisement site displays advertisements of other companies in its websites and thereby earns revenue.

![Banner advertisement site](image)

**Figure 15.19** Banner advertisement site

4. Bulk-buying sites collect a number of users together all of who want to buy similar items; the site negotiates a discount with the supplier and takes a commission. e.g. [https://www.alibaba.com/](https://www.alibaba.com/)

![Bulk-buying sites](image)

**Figure 15.20** Bulk-buying sites
5. Digital publishing sites effectively host the e-books or magazines on the web. They make profits in a number of ways such as advertising, selling etc., https://wordpress.org/

![Digital Publishing website](image1.png)

**Figure 15.21** Digital Publishing website

6. Licensing sites allow other websites to make use of their software. For example, the search engines which allow a visitor of the site to search within the website more easily.

![Google Search in IGNOU website](image2.png)

**Figure 15.22** Google Search in IGNOU website

7. Name-your-price sites are just like normal retail sites. In contrast, the buyer negotiates with the retailer for a particular product or service. https://in.hotels.com/

![Name-your-price sites](image3.png)

**Figure 15.23** Name-your-price sites

8. Online Shopping mall site allows multi E-Commerce traders to assemble together on a single website. Often these sellers would be related to each other, for example they may all sell luxury goods. This site would take a percentage of their profit.
Chapter 15 E-COMMERCE

15.6 Comparison between Traditional Commerce and E-Commerce

E-Commerce isn't just commerce anymore. Even though they share the primary principle of buying and selling goods and services, there is a difference between traditional commerce and E-Commerce.

![Figure 15.24 Traditional vs E-Commerce](image)

Table 15.1 Traditional vs E-Commerce

<table>
<thead>
<tr>
<th>Traditional Commerce</th>
<th>E-Commerce</th>
</tr>
</thead>
<tbody>
<tr>
<td>Traditional commerce is buying or selling of products and services physically.</td>
<td>E-Commerce carries out commercial transactions electronically on the Internet.</td>
</tr>
<tr>
<td>Customer can easily identify, authenticate and talk to the merchant.</td>
<td>Neither customer nor merchant see the other.</td>
</tr>
<tr>
<td>Physical stores are not feasible to be open all the time.</td>
<td>It is always available on all time and all days of the year.</td>
</tr>
<tr>
<td>Products can be inspected physically before purchase.</td>
<td>Products can't be inspected physically before purchase.</td>
</tr>
<tr>
<td>Scope of business is limited to particular area.</td>
<td>Scope of business is global. Vendors can expand their business Worldwide.</td>
</tr>
<tr>
<td>Resource focus Supply side.</td>
<td>Resource focus Demand side.</td>
</tr>
<tr>
<td>Business Relationship is Linear.</td>
<td>Business Relationship is End-to-end.</td>
</tr>
<tr>
<td>Marketing is one way marketing.</td>
<td>One-to-one marketing.</td>
</tr>
<tr>
<td>Payment is made by cash, cheque, cards etc.</td>
<td>Payment system is mostly credit card and through fund transfer.</td>
</tr>
<tr>
<td>Most goods are delivered instantly.</td>
<td>It takes time to transport goods.</td>
</tr>
</tbody>
</table>
15.7 Advantages and Disadvantages of E-Commerce

The pros and cons of E-Commerce affect three major stakeholders: consumers, business organisations, and society.

The following are the advantages and disadvantages of E-Commerce for a consumer.

**Advantages**

- E-Commerce system is operated on all days and all the day. It is able to conduct business 24 x 7. Neither consumer nor suppliers need physical store to be opened to do business electronically. People can interact with businesses at the time of their convenience.

- Speed is a major advantage in E-Commerce. Advanced Electronic communications systems allow messages to reach across the world instantaneously. There is no need to wait days for a catalogue to arrive by post. Communication delay is not a part of the Internet or E-Commerce world.

- The Internet is too easy to 'shop around' for products and services that may be more cheaper and effective than left to buy only in a Brick and Mortar shop. It provides an opportunity to buy at reduced costs. It is possible to explore the Internet, identify original manufacturers, thereby bypass wholesalers and achieve a cheaper price.

- The whole world becomes a shop for today’s customers. They can have wide choice by comparing and evaluating the same product at different websites before making a purchase decision.

- Customers can shop from home or anywhere at their convenience. They don't need a long wait to talk to a salesman. They can read the details regarding model numbers, prices, features etc. of the product from the website and buy at their own convenience. Payments can also be made through online.

**Disadvantages**

- E-Commerce is often used to buy goods that are not available locally but from businesses all over the world. Physical goods need to be transported, which takes time and costs money. In traditional commerce, when we walk out of a shop with an item, it's ours; we have it; we know what it is, where it is and how it looks. But in E-Commerce we should wait between placing the order and having the product in hand. Some E-Commerce companies handle this by engaging their customer updating status of their shipments.

- Unlike returning goods to a traditional shop returning goods through online is believed to be an area of difficulty. The doubts about the period of returning, will the returned goods reach source in time, refunds, exchange and postage make one tiresome.

- Privacy issues are serious in E-Commerce. In E-Commerce generating consumer information is inevitable. Not all the companies use the personal information they obtained to improve services to consumers. Many companies misuse the information and make money out of it. It is true that privacy concerns are a critical reason why people get cold feet about online shopping.
● Physical product disputes are a major disadvantage in E-Commerce. E-Commerce purchases are often made on trust. This is because, we do not have physical access to the product. Though Internet is an effective channel for visual and auditory information it does not allow full scope for our senses. We can see pictures of the perfumes, but could not smell their fragrance; we can see pictures of a cloth, but not its quality. If we want to inspect something, we choose what we look at and how we look at it. But in online shopping, we would see only the pictures the seller had chosen for us. People are often much more comfortable in buying the generic goods (that they have seen or experienced before and in which there is little ambiguity) rather than unique or complex things via the Internet.

● We couldn’t think of ordering a single ice cream or a coffee from a shop in Paris. Though specialized and refrigerated transport can be used, goods bought and sold via the Internet need to survive the trip from the supplier to the consumer. This makes the customers turn back towards traditional supply chain arrangements for perishable and non-durable goods.

● Delivery ambiguity. Since supplying businesses can be conducted across the world, it can be uncertain whether they are indeed genuine businesses or just going to take our money. It is pretty hard to knock on their door to complain or seek legal recourse. Further, even if the item is sent, it is easy to start bothering whether or not it will ever arrive on time.

The following are some of the advantages and disadvantages of E-Commerce for a Business organisation.

Benefits of E-Commerce to a business organisation.

● Access to Global Market: The Internet spans the world of E-Commerce, and it is possible to trade with any business or a person who is connected with the Internet. It helps to access the global marketplace. Simple local businesses such as herbal product stores are able to market and sell their products internationally using E-Commerce. Thus, the whole world becomes a potential market for an E-Commerce company.

Disruptive innovations in E-commerce

The innovations which replace the existing technologies are called as disruptive innovations. Disruptive innovation creates a new market. Not all innovations are near disruptive. The first automobiles in the late nineteenth century were a great innovation. But it didn’t affect existing animal-based road transport market until 1908 when Henry Ford introduced affordable motor cars. The term disruptive innovation was first coined by Clayton M in his book “The Innovator’s Dilemma”.

Example: Film cameras market is disrupted by digital camera innovations, floppy disk market is interrupted by CD and USB innovations. E-Commerce itself is a disruptive innovation.
Chapter 15  E-COMMERCE

- **Low cost of entry:** Though E-Commerce was first emerged in private networks it did not remain the same. Internet has changed the face of E-Commerce. The Internet is all about democratization. Internet is a place where the small guy can effectively fight against the giants and hope to win. Days when E-Commerce was only for affordable large national chains are gone. Today, it is common for retailers to move their traditional store to online with very less add-on only for building a good website.

- **Computer platform-independent:** Most computers have the ability to communicate via the Internet, irrespective of operating systems and hardware. Consumers need not have to upgrade their computer or network to participate in E-Commerce. They are not limited by existing hardware.

- **Lower Transaction Cost:** E-Commerce reduces the cost of business transactions substantially. For instance, significant number of customer service representatives in a bank can be reduced by using net banking. Since these interactions are initiated by customers, the customers provide a lot of data for the transactions that may otherwise need to be entered by employees. This means that some of the work and costs are effectively shifted to customers; this is referred as ‘customer outsourcing’.

- **24X7 working:** A website is open all 24 hours, 7 days in a week. As E-Commerce firm can provide information about its products and services to customers around the clock, it can thus, take orders, keep an eye on delivery of goods and receive payments at any time.

- **Voice Shopping and chatbots**

  The future navigational experience is less text-based but more conversation-based in order to find any information. Humans can speak 150 words per minute but can type only 40 words. Voice activated speakers like google home / alexa are capable of doing much more than just playing favorites songs. Through voice shopping these devices place order to e-shopping websites. In the other end chatbots interact with consumers and take the orders. The Artificial Intelligence, machine learning and big data technology allows consumers interact with chatbots instead a customer relation officer to buy a things via phone.
Limitations of E-Commerce

Every rose has its thorns. Similarly, E-Commerce also has some limitations. The following are the major drawbacks of E-Commerce for a business organisation.

- **People won't buy all products online:** There are certain products like high price jewels, clothes or furnishings which people might not like to buy online. They might want to, inspect it, feel the texture of the fabric etc. which are not possible in E-Commerce. The online shopping does not allow physical inspection, customers have to rely on electronic images of the products. E-Commerce is an effective means for buying known and established services, that is, things that are being used every day. Example booking tickets, buying books, music or software. Also the E-Commerce company need not worry about fast changes in computer network technology. E-Commerce applications can be more efficiently developed and distributed because they are platform independent. Internet’s altruism helps E-Commerce.

- **Snapping middleman:** E-Commerce enjoys the benefit of bypassing middlemen and reaching the end customer directly through Internet. In B2C E-Commerce business firms establish a direct contact with their customers by eliminating middlemen. It helps to increase the sales of the organization without any interventions. This results in cheaper price for consumers and higher profit margins for the companies.

Augmented reality

AR is a 3-dimensional experience of witnessing the virtual items by augmenting the real objects with the virtual ones. The AR technology allows customer see themselves and visualize how they would look like in a particular outfit. Customers don't have to wear it literally instead. Augmented reality (AR) and virtual reality (VR) keep changing customer experiences and motivate shoppers to buy as they get more enhanced buying experience.

Interior design and home decor sites were some of the early adopters of this technology, seeing the benefits of consumers interacting with products virtually. They allow consumers to virtually place furniture in their home and envision what the end result will look like via their mobile phones.
CDs and softwares. It is not suitable for dealing with the new or unexpected. Traditional commerce always takes advantage when it is perishables and touch and feel products.

- Competition and Corporate vulnerability: Access to Global Market is an beneficial on one hand but it also come with a competition. Open Internet has paved way to all business firms to operate in the global market. Many businesses have been already facing international competition from web-enabled business opponents. The competitors may access product details, catalogs, and other information about a business through its website and makes it vulnerable. They might then indulge in web harvesting. Web harvesting is the illegal activity of extracting business intelligence from competitor’s web pages.

- Security: Security remains to be a problem for E-Commerce. Customers might be reluctant to give their credit card number to the website. As lot of cyber frauds takes place in E-Commerce transactions, people generally afraid to provide their personal information. Legal issues arise when the customer’s data falls in the hands of strangers. Fraudulent activities in traditional commerce is comparatively less as there is personal interaction between the buyer and the seller.

- Customer loyalty: Business cannot survive long without loyal customers. The customers would like to buy from a website where they are able to get the best deal. They cannot be loyal to a particular seller. In traditional commerce, shopkeeper would interact with the consumer “face-to-face” and gain their loyalty too. In E-Commerce, the interaction between the business and the consumer is “screen-to-face”. The customers would feel that they do not have received sufficient personal attention. Since there is no personal touch in E-Business, companies could not win over their loyalty easily.

- Shortage of skilled employees: Though most of the process in E-Commerce is automated, some sectors like packaging and delivery, needs manual interventions. There could be problems related to shipping delays which would need technically qualified staff with an aptitude to resolve. E-Commerce has difficulty in recruiting, training and retaining talented people. There is a great shortage of skilled employees. Traditional organizational structures and poor work cultures in some places inhibit the growth of E-Commerce.

- Size and value of transactions: The delivery cost of a pen surpasses the cost of pen itself. E-Commerce is most often conducted using credit card for payments, and as a result very small and very large transactions tend not to be conducted online.

For a successful implementation of E-Commerce, an organization must requires the well-designed website, adequate computer hardware and software, effective telecommunication system, technically qualified and responsive workforce and business service infrastructure.
Steps to Start an E-Business

The following are the initial steps involved in the process to start an online business and start selling items instantly:

- **Business structure and Registration**

  Operating an E-Commerce or E-Business does not exclude from requiring certain business licenses and permits. The company must be registered before starting the trade. Registration includes business name, trade name, type of company. (e.g., Private Ltd, Public Ltd, Partnership or Sole Proprietor, LLP - limited liability partnership etc.) The company must be registered to get the bank account opened in the company name and obtaining GST registration documents easily. Any one is allowed to enroll in an online platform and start selling immediately, but there will be no limited liability protection provided to litigation. Thus, if one need to sustain and grow it is best to start with an LLP or a company. http://www.mca.gov.in/
● **Tax Registration**
Taxation is unavoidable in any country. A company must have registered with the tax department of the concerned nation. In India, registration with GST and other tax norms is necessary to begin selling online, it does not matter whether we are starting our own online business website or selling on others’ portal. https://services.gst.gov.in, https://ctd.tn.gov.in/home

● **Business Bank Account**
Bank account facilitate payment systems. Once the company or LLP is registered successfully, the next step is to apply for a bank account in the name of the online venture. GST certificate is necessary to open a bank account for a business firm.

● **Payment Gateway**
The next important step is to implement a payment gateway integrated with E-Commerce websites to allow customers to make their payments through credit card, debit card, Internet banking, etc. With digital payment gateway, the customers can make the payment online which automatically gets transferred to business’s bank account.

● **Shipment Solution**
Once the above steps are accomplished and start receiving the order, the next step is to set up the logistics section. Logistics is a major part of the E-Commerce. Third party logistics companies may help us to deliver sold products to the customers at their mentioned destination.

● **Identifying suppliers**
Global market space comes along with competition in selling products online. So finding the best quality and best prices for the products we sell is very important. We should shop around until we find a supplier we find a suitable supplier.

● **Marketing**
Marketing plays a significant role in any business. Using Internet and social media effectively will take out product worldwide. Marketing could be started as early as it could be. Catchy captions and logos attract more new customers. It’s a good idea to set up social media profiles and writing content for blogs from very first day because we do not want to wait when it is ready to serve.

● **Right technologies**
Updating our technical knowledge will give hand in E-Commerce. Technology makes so much of our work easier. So before we start our E-Commerce business, we should be familiar with some of the basic entities like customer relationship management, accounting, project management, email and marketing etc. The deeper we learn, the greater we grow.
E-Commerce can be described as the process of buying or selling products, services or information via Internet.

FinTech Financial technology is a collective term for technologically advanced financial innovations. In simple words Fintech is a new finance industry that uses technology to improve financial activity.

The dotcom bubble was a rapid rise in U.S. equity market of Internet-based companies during 1990s.

Web 1.0 (Web of Content) is the early web that contained text, images and hyperlinks and allowed users only to search for information and read it. There was a very little in the way of user interaction or content generation.

Web 2.0 (Web of Communication) is a read-write web that allowed users to interact with each other.

Web 3.0 (Web of Context) is termed as the semantic web or executable web with dynamic applications, interactive services, and “machine-to-machine” interaction.

<table>
<thead>
<tr>
<th><strong>Affiliate</strong></th>
<th>Business who promotes the products of another business for a commission.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Blog</strong></td>
<td>An online platform for writing articles about a topic.</td>
</tr>
<tr>
<td><strong>Brick and mortar</strong></td>
<td>The term that refers to a business that has a physical store; opposite of online store.</td>
</tr>
<tr>
<td><strong>Dotcom</strong></td>
<td>Common name for Internet based companies.</td>
</tr>
<tr>
<td><strong>Mobile commerce</strong></td>
<td>Businesses that are conducted through the Internet using mobile phones or other wireless hand-held devices.</td>
</tr>
<tr>
<td><strong>Nascent stage</strong></td>
<td>Initial stage of growth.</td>
</tr>
<tr>
<td><strong>Off-shoring</strong></td>
<td>Company’s work is given to overseas (another country) company</td>
</tr>
<tr>
<td><strong>Out-sourcing</strong></td>
<td>Hiring third party service providers to handle business on behalf.</td>
</tr>
<tr>
<td><strong>Social media</strong></td>
<td>In terms of E-Commerce, a platform for advertising products to targeted consumers e.g. Facebook, twitter.</td>
</tr>
<tr>
<td><strong>Tangible form</strong></td>
<td>Physical goods we receive.</td>
</tr>
<tr>
<td><strong>Teleputer</strong></td>
<td>Fusion of television, computer and telecom networking technologies.</td>
</tr>
<tr>
<td><strong>Wordpress</strong></td>
<td>A free, open source online blogging platform.</td>
</tr>
</tbody>
</table>
Part I

Objective Questions

1. A company can be called E-Business if
   a) it has many branches across the world.
   b) it conduct business electronically over the Internet.
   c) it sells commodities to a foreign country.
   d) it has many employees.

2. Which of the following is not a tangible good?
   a) Mobile
   b) Mobile Apps
   c) Medicine
   d) Flower bouquet

3. SME stands for
   a) Small and medium sized enterprises
   b) Simple and medium enterprises
   c) Sound messaging enterprises
   d) Short messaging enterprises

4. The dotcom phenomenon deals with _______
   a) Textile industries
   b) Mobile phone companies
   c) Internet based companies
   d) All the above

5. Which of the following is not correctly matched
   c) The Third Wave of Electronic Commerce: 2010 – Present

6. Assertion (A): The websites of first wave dotcom companies were only in English
   Reason (R): The dotcom companies of first wave are mostly American companies.
   a) Both (A) and (R) are correct and (R) is the correct explanation of (A)
   b) Both (A) and (R) are correct, but (R) is not the correct explanation of (A)
   c) (A) is true and (R) is false
   d) (A) is false and (R) is true

7. Off-shoring means
   a) Work outsourced to a branch of its own company
   b) Work outsourced to new employees
   c) Work outsourced to a third party locally
   d) Work outsourced to a third party outside its own country

8. G2G systems are classified into
   a) Internal facing and external facing
   b) Internet facing and Extranet facing
   c) Internal flag and external flag
   d) Internet flag and Extranet flag

9. ______ host the e-books on their websites.
   a) Bulk-buying sites
   b) Community sites
   c) Digital publishing sites
   d) Licensing sites
10. Which of the following is not a characteristics of E-Commerce
   a) Products cannot be inspected physically before purchase.
   b) Goods are delivered instantly.
   c) Resource focus supply side
   d) Scope of business is global.

**Part - II**

**Short Answers**

1. Define E-Commerce.
2. Distinguish between E-Business and E-Commerce
3. Differentiate tangible goods and electronic goods with example of your own.
4. What is dotcom bubble and dotcom burst?
5. Write a short note on out-sourcing.

**Part - III**

**Explain in Brief Answer**

1. Describe how E-Commerce is related to socio-technological changes.
2. Write a short note on the third wave of E-Commerce.
4. Write a note on name-your-price websites.
5. Write a note on physical product dispute of E-Commerce.

**Part - IV**

**Explain in detail**

1. Write about the development and growth of Electronic Commerce.
2. List all the E-Commerce business models and explain any four briefly.
3. Explain any five E-Commerce revenue models.
4. How would you differentiate a traditional commerce and E-Commerce?
5. What are the advantages and disadvantages of E-Commerce to a consumer?

**STUDENT ACTIVITIES**

- Draw a timeline describing various developments in E-Commerce.
- List the business around your society and sort it according to business modules.
- Interview a consumer who recently bought a product online and write his experience.
As the volume and variety of transactions expands the volume of money expand. Using cash for each of large transactions is neither feasible nor practically possible. Security and transportation problems arise in cases where large amounts of cash transactions are involved.

Banks would support in such cases by offering other payment methods. The demise of cash and cheques could not be sudden. Though old habits hardly die, people do not hesitate adapting new things.

**Definition**

An Electronic payment system is a financial arrangement that consists an intermediary to facilitate transfer of money-substitute between a payer and
Chapter 16 Electronic Payment Systems

234

a receiver. Sometimes it is also called liquidation, clearing system or clearing service. It ensures the transfer of value from one subject of the economy to another and plays an important role in modern monetary systems.

Modern payment systems may be physical or electronic and each has its own procedures and protocols that guide the financial institution with payment mechanisms and legal systems. Standardization has allowed some of these systems to grow to globally.

The term electronic payment refers to a payment made from one bank account to another bank account using electronic methods forgoing the direct intervention of bank employees.

Payment system is an essential part of a company’s financial operations. But it becomes complex, when many different payment systems are used. Further challenges come from the continuous introduction of newer payment systems such as paytm, UPI, bitcoin and various mobile payment options. As a result there are more than 750 payment systems throughout the world. See Figure 16.1

16.2 Classification of Electronic Payment methods

Many electronic payment methods have been developed with the advancements in the Internet technologies. Based on the value of money transactions, processing time, processing requirements, security issues and usability electronic Payment systems are generally classified into two types. They are

- Micro electronic Payment Systems
- Macro electronic Payment Systems

16.2.1 Micro electronic Payment Systems

It is an on-line payment system designed to allow efficient and frequent payments of small amounts. In order to keep transaction costs very low, the communication and computational costs are minimized here. Unlike macro electronic payments, which use expensive public key cryptography, micro electronic payment are relaxed by using light weight cryptographic primitives and off-line payment verifications.

As the security of micro electronic payment systems is comparatively low it could be tampered but, the cost of fraud is much higher than the possible value to be gained by fraud itself. So the security in micro electronic payment methods is considered to be adequate. The majority of micro electronic payment systems were designed to pay for simple goods on the Internet. e.g., subscriptions of online games, read journals, listen to a song or watch a movie online etc.
In general, the parties involved in the micro on-line payments are Customer, Service Provider and Payment processor. The Micro electronic payment transactions can be explained in the following way.

**Step 1** Customer proves his authentication and the payment processor issues micro payments.

**Step 2:** Customer pays the micro payments to the online service provider and gets the requested goods or services form them.

**Step 3:** Service provider deposits micro payments received from the customer to the payment processor and gets the money.

The micro electronic payments systems work on the basis of simple cryptographic algorithms. Based on the algorithm used, it is classified into the following categories.

- Hash chain based micro electronic payment systems.
- Hash collisions and hash sequences based micro electronic payment systems.
- Shared secret keys based micro electronic payment systems.
- Probability based micro electronic payment systems.

**16.2.2 Macro electronic payment systems**

Macro electronic payment systems support payments of higher value. The security requirements are more rigorous in macro payment systems because of huge money transactions. Banks will impose a minimum transaction overhead on macro payment systems. These transactional overheads for the usage of computationally expensive cryptographic operations prevent these payment systems to be used for the payment of small amounts. Some of the popular macro on-line payment systems are mentioned below

- Card based payment systems
- Electronic account transfer
- Electronic cash payment systems
- Mobile payment systems and internet payment systems

**16.3 Card Based Payments Systems**

Payment cards are plastic cards that enable cashless payments. They are simple embossed plastic card that authenticates the card holder on behalf of card issuing company, which allows the user to make use of various financial services. More than 90% of online payments are card based payments, at the same time other e-payment methods are also gaining importance now-a-days.

Based on the transaction settlement method there are three widely used card based payment systems. They are

1. Credit card based payment systems (pay later)
2. Debit card based payment systems (pay now)
3. Stored value card based payment systems (pay before)

**16.3.1 Credit Card**

Credit card is an electronic payment system normally used for retail transactions. A credit card enables the bearer to buy goods or services from a vendor, based on the cardholder’s promise to the card issuer to payback the value later with an agreed interest. Every credit card account
has a purchase limit set by the issuing bank or the firm. A credit card is different from a debit card where the credit card issuer lends money to customer instead of deducting it from customer’s bank account instantly.

The term credit card was first mentioned in 1887 in the sci-fi novel “Looking Backward” by Edward Bellamy. The modern credit cards concept was born in the U.S.A, in the 1920s, when private companies began to issue cards to enable their customers to purchase goods on credit within their own premises.

Advantages of credit card
- Most credit cards are accepted worldwide.
- It is not necessary to pay physical money at the time of purchase. The customer gets an extra period to pay the purchase.
- Depending on the card, there is no need to pay annuity.
- Allows purchases over the Internet in installments.
- Some issuers allows “round up” the purchase price and pay the difference in cash to make the transactions easy.

Key players in operations of credit card
1. Bearer: The holder of the credit card account who is responsible for payment of invoices in full (transactor) or a portion of the balance (revolver) the rest accrues interest and carried forward.
2. Merchant: Storekeeper or vendor who sell or providing service, receiving payment made by its customers through the credit card.
3. Acquirer: Merchant’s bank that is responsible for receiving payment on behalf of merchant send authorization requests to the issuing bank through the appropriate channels.
4. Credit Card Network: It acts as the intermediate between the banks. The Company responsible for communicating the transaction between the acquirer and the credit card issuer. These entities operate the networks that process credit card payments worldwide and levy interchange fees. E.g. Visa, MasterCard, Rupay.
1. **Publisher**: Emblem of the issuing bank (along with the sub category or scheme if any)

2. **Credit card number**: The modern credit card number has 16-digit unique identification number.
   - The first digit of the credit card number is Major Industry Identifier (MII). It identifies the issuer category. e.g. 1 – Airlines, 4 – Banks
   - The next 5 digits uniquely identifies the issuing organization.
   - The first 6 digits together called as Issuer Identifier number (IIN) or Bank Identification number (BIN)

5. **Issuer**: Bearer’s bank, that issue the credit card, set limit of purchases, decides the approval of transactions, issue invoices for payment, charges the holders in case of default and offer card-linked products such as insurance, additional cards and rewards plan. See Figure 16.2

**Anatomy of a credit card**

All Payment cards (including debit card) are usually plastic cards of size 85.60 mm width × 53.98 mm height, rounded corners with a radius of 2.88 mm to 3.48 mm and thickness of 0.76 mm. These standards dimensions are maintained universally in accordance with ISO/IEC 7810#ID-1. See Figure 16.3
10. Signature: It is cardholder’s signature at the back of the card, used as an attempt to identify cardholder’s identity. It also holds the last 4 digits of card number.

11. CVC/CVV: Card Verification code/value is a 3 digit code usually printed to the left of signature pane validates the card. CVC2 is used in contact less transactions.

Apart from the these mentioned each credit card may also holds issuer’s disclaimer, address and phone number.

16.3.2 Debit Card
Debit Card is an electronic payment card where the transaction amount is deducted directly from the card holder’s bank account upon authorization. Generally, debit cards function as ATM cards and act as a substitute for cash. The way of using debit cards and credit cards is generally the same but unlike credit cards, payments using a debit card are immediately transferred from the cardholder’s designated bank account, instead of them paying the money back at a later with added interest. In modern era the use of debit cards has become so widespread.

The debit card and credit card are identical in their physical properties. It is difficult to differentiate two by their appearance unless they have the term credit or debit imprinted.

Currently there are three ways of processing debit card transactions:
1. EFTPOS (also known as online debit or PIN debit)
2. Offline debit (also known as signature debit)
3. Electronic Purse Card System
16.3.3 Stored value cards

Stored value card is a type of debit card that is pre-loaded with certain amount(value), with which a payment is made. It is a card that has default monetary value onto it. The card may be disposed when the value is used, or recharged to use it again. The major advantage of stored value card is that customers don’t need to have a bank account to get prepaid cards. See Figure 16.4

![Figure 16.4 Stored value card](image)

Like a credit card or debit card it is a plastic and has a magnetic strip on its back. The magnetic strip stores the monetary value of the card. Stored value cards may not have the card holder’s name always. It is also indistinguishable from a regular credit or debit card in appearance. What look like a credit card or debit card act like a credit or debit card. It is used to make purchases offline and online in the same way as in credit card or debit card.

There are two varieties for stored value card.

1. Closed loop (single purpose)

In closed loop cards, money is metaphorically stored on the card in the form of binary-coded data. Closed loop cards are issued by a specific merchant or merchant group and can only be used to make purchases from specific place. e.g. chennai metro rail travel card.

2. Open loop (multipurpose)

Open loop cards can be used to make debit transaction at variety of retailers. It is also called as prepaid-debit cards. It can be used anywhere the branded cards are accepted. e.g. Visa gift cards.

In some countries it is legal for anyone to enter or leave the country with money that is stored on cards, unlike carrying cash in high amounts which is believed a form of money laundering.

16.3.4 Smart card

The modern version of card based payment is smart cards. Smart cards along with the regular features of any card based payment system holds a EMV chip. This chip is similar to well-known sim card in appearance but differ in its functionalities. The advantage of Smart cards is that it can provide identification,

![Figure 16.5 Contact Smart card & POS](image)
Apart from card based payment systems there are many alternative electronic payment systems. With the advent of computers, network technologies and electronic communications a large number of alternative electronic payment systems have emerged. These include ECS (Electronic Clearing Services), EFT (Electronic funds transfers), Real Time Gross Settlement system (RTGS) etc. These Electronic Payment systems are used in lieu of tendering cash in domestic and international transactions.

16.4.1 Electronic Clearing Services (ECS)

Electronic Clearing Service can be defined as repeated transfer of funds from one bank account to multiple bank accounts or vice versa using computer and Internet technology. The payer instructs the bank to debit from his bank account and credit it to one or more payee bank account provided amounts and dates of the payments earlier. This system provides the convenience of paperless payments.
Advantages of this system are bulk payments, guaranteed payments and no need to remember payment dates. It can be used by institutions for making payments such as disbursing of salary, pension or dividend interest among shareholders. Similarly, individual bank customers also can make small value repetitive payments such as paying EMI of a loan, electricity bills, telephone bills, insurance premium, as well as SIP investments. See Figure 16.7

ECS can be used for both credit and debit purposes i.e. for making bulk payments or bulk collection of amounts.

- ECS credit: ECS credit is used for making bulk payment of amounts. In this mode, a single account is debited and multiple accounts are credited. This type of transactions are Push transactions. Example: if a company has to pay salary to its 100 employees it can use ECS credit system than crediting every employees’ account separately.

- ECS debit: ECS debit is an inverse of ECS credit. It is used for bulk collection of amounts. In this mode, multiple accounts are debited and then a single account is credited. This type of transactions are Pull transactions. Example: The insurance premium of bulk number of customers is debited from customer’s bank account on their.
fulfills his obligations to the buyer or whether he would deliver the goods or perform a service of a quality consistent with the order.

- Irrevocable - a correctly processed transaction cannot be reversed and its money cannot get refunded (the so-called settlement finality).

### 16.5 Electronic Cash Payment Systems

Electronic cash (E-Cash) is a currency that flows in the form of data. It converts the cash value into a series of encrypted sequence numbers, and uses these serial numbers to represent the market value of various currencies in reality.

#### 16.5.1 Cryptocurrency

People have always valued unique and irreplaceable things. A unique thing always has a demand and acclaims a price. A cryptocurrency is a unique virtual (digital) asset designed to work as a medium of exchange using cryptographic algorithm. This algorithm secures the transactions by recording it in blockchain and controls the creation of additional units of the currency. Cryptocurrency is also called as cryptocurrencies, e-cash, alternative currencies or virtual currencies and are classified as a subset of digital currencies.

Cryptocurrency can be defined as distributed accounting system based on cryptography, storing information about the state of ownership in conventional units. The state of ownership of a cryptocurrency is related to individual system blocks called “portfolios”. Only the holder of the corresponding private key would have control over a given portfolio and it is impossible to issue the same unit twice.
The function of cryptocurrency is based on technologies such as Mining, Blockchain, Directed Acyclic Graph, Distributed register (ledger), etc. The information about the transaction is usually not encrypted and is available in clear text.

In 1989, David Chaum an American cryptographer invented the first form of Cryptocurrency called “DigiCash” in the Netherlands. David Chaum, was offered with 180 million dollars by Microsoft for his DigiCash. But things changed and his company went bankrupt in 1998.

Bitcoin

The term “cryptocurrency” began to be used after the appearance of the Bitcoin. Bitcoin is the most popular and the first decentralized cryptocurrency. Bitcoin payment system, was developed in 2009 by an unknown person or a group under the pseudonym “SatosiNakamoto”. The SHA-256, a cryptographic hash function, has been used as a working algorithm. Later forks like: Namecoin, Litecoin, Bitcoin-gold and many others appeared. See Figure 16.8

Bitcoin is the most popular cryptocurrency, but there are many other cryptocurrencies, which are referred to as “altcoins”. Currently, more than 1300 cryptocurrencies are listed over 200 special cryptocurrency stock exchanges. Most (not all) are based on different types of blockchain technology.

Many cryptocurrencies operate on the basis of the same source code, in which the authors make only a few minor changes in parameters like time, date, distribution of blocks, number of coins, etc. These currencies are called as fork. In fork, both cryptocurrencies can share a common transaction history in blockchain until the split.

Altcoins

Altcoins is the collective name for all cryptocurrencies that appeared after Bitcoin. The early Altcoins Litecoin and Namecoin appeared in 2011. Their miners sought to overcome a number of problems inherent in Bitcoin (for example, Litecoin has a higher transaction rate) or use blockchain technology in other areas (Namecoin was developed to build alternative root DNS servers).

Many altcoins are inherently very similar to Bitcoin in characteristics and structure. But some cryptocurrencies
have significant differences. About 400 altcoins were considered as “dead”, as their value became zero.

Until July 2013, the software of all cryptocurrencies, except Ripple, was based on the open source code of the Bitcoin system. Since July 2013, cryptocurrency platforms began to appear to support various infrastructures like stock trading, shops, instant messengers, and so on. These cryptoplatforms includes BitShares, Mastercoin, Nxt.

From 2014, the 2nd generation of cryptocurrency appeared, such as Monero, Ethereum and Nxt. These crypto-coins have advanced features such as hidden addresses and smart contracts.

**Mining**

The cryptocurrency units are created by the solution of cryptographic tasks called mining. The miners not only generate new monetary units, but also initiate new transactions to the blockchain. As a reward, they will receive new BitCoins.

In terms of trade, the creation of cryptocurrencies may be related to the ICO (Initial Coin Offer) procedure, i.e. the ICO, aimed at gathering the initial capital necessary for the further development of the system. The initial value of cryptographic currency is just the cost of consumed electricity. The secondary value is determined by the demand for the cryptocurrency.
Blockchain

Blockchains are an open distributed book that records transactions of cryptocurrencies between any two parties in an efficient and verifiable manner. It is a continuously growing list of records, called blocks, which are linked to each other and protected using encryption algorithm. Each block typically contains a hash pointer as a link to a previous block. It records data about every transaction with its date and time. Once recorded, the data in any given block cannot be altered without the alteration of all subsequent blocks. Blockchains are by default resistant to data modification without the approval of a trusted authority. The validity of the coins of each cryptocurrency is also provided by a blockchain. See Figure 16.9

Since blockchains are safely designed with high fault tolerance it is best suited to distributed computing system. Decentralized structure of blockchain solves the problem of double spending.

16.5.2 Electronic wallets

Electronic wallets (e-wallets) or electronic purses allow users to make electronic transactions quickly and securely over the Internet through smartphones or computers. The electronic wallet functions almost the same as a physical wallet in term that it holds our money. Electronic wallets were first recognized as a method for storing money in electronic form, and became popular because it provides a convenient way for online shopping.

With the development of advanced Internet, the use of electronic wallets turned out as an efficient transaction tool. This is evidenced by the many E-Commerce websites that use electronic wallets as a transaction tool. There are several electronic wallet services that are now widely used. e.g. PayPal, SBI Buddy. See Figure 16.10

16.6 Mobile Banking and Internet Banking

As smartphones have already usurped the place of digital camera and voice recorders, soon it will double up as virtual debit cards. It enables to send or receive money instantly without any plastic cards.

16.6.1 Mobile Banking

Mobile banking is another form of net banking. The term mobile banking (also called m-banking) refers to the services provided by the bank to the customer to conduct banking transactions with the aid of mobile phones. These transactions include balance checking, account transfers, payments, purchases, etc. Transactions can be done at anytime and anywhere. See Figure 16.11
16.6.2 Internet banking

Internet banking is a collective term for E-banking, online banking, virtual banking (operates only on the Internet with no physical branches), direct banks, web banking and remote banking.

Internet banking allows customers of a financial institution to conduct various financial transactions on a secure website operated by the banking institutions. This is a very fast and convenient way of performing any banking transactions. It enables customers of a bank to conduct a wide range of financial transactions through its website. In fact, it is like a branch exclusively operating of an individual customer. The online banking system will typically connect to the core
banking system operated by customers themselves (Self-service banking).

**Advantages:**

- The advantages of Internet banking are that the payments are made at the convenience of the account holder and are secured by user name and password. i.e. with Internet access it can be used from anywhere in the world and at any time.
- Any standard browser (e.g. Google Chrome) is adequate. Internet banking does not need installing any additional software.

> Out of 7.7 billion world population roughly 3.2 billion have the Internet access. There by more than 50% of world population are accessed to Internet banking.

The following are the steps to transfer fund using net banking.

**Step 1:** Login to net banking account using unique user name and password provided by the bank earlier.

**Step 2:** Add the beneficiary as a payee to enable transfer of fund. The following details like Account Number, Name, IFSC about the beneficiary are to be filled in the ‘Add New Payee’ section.

**Step 3:** Once the beneficiary is added, choose RTGS / NEFT / IMPS as mode of Fund Transfer.

**Step 4:** Select the account to transfer money from, select the payee, enter the amount to be transferred and add remarks (optional).

**Step 5:** Click on submit.

**Step 6:** Enter the OTP received to mobile number linked to the corresponding account to complete the transaction.

Modern Electronic funds transfers are secured by a personal identification number (PIN), one-time password (OTP) etc. An automated clearing house (ACH) processes the payment then. See Figure 16.12

![Figure 16.12 Home page of SBI Internet banking](image-url)
Virtual payment address (VPA) also called as UPI-ID, is a unique ID similar to email id (e.g. name@bankname) enable us to send and receive money from multiple banks and prepaid payment issuers. Bank or the financial institution allows the customer to generate VPA using phone number associated with Aadhaar number and bank account number. VPA replaces bank account details thereby completely hides critical information.

The MPIN (Mobile banking Personal Identification number) is required to confirm each payment. UPI allows operating multiple bank accounts in a single mobile application. Some UPI application also allows customers to initiate the transaction using only Aadhaar number in absence VPA.

UPI is also available as an Unstructured Supplementary Service Data (USSD) service. Users who don’t have Internet can dial *99# and get UPI services within India. The financial services like transferring fund, payment request and non-financial services like changing MPIN and balance check are currently available through the USSD.

Unified Payments Interface (UPI) is a real-time payment system developed by National Payments Corporation of India (NCPI) to facilitate inter-bank transactions. It is simple, secure and instant payment facility. This interface is regulated by the Reserve Bank of India and used for transferring funds instantly between two bank accounts through mobile (platform) devices. http://www.npci.org.in/

Unlike traditional e-wallets, which take a specified amount of money from user and store it in its own account, UPI withdraws and deposits funds directly from the bank account whenever a transaction is requested. It also provides the “peer to peer” collect request which can be scheduled and paid as per requirement and convenience.

UPI is developed on the basis of Immediate Payment Service (IMPS). To initiate a transaction, UPI applications use two types of address - global and local.

- Global address includes bank account numbers and IFSC.
- Local address is a virtual payment address.
Advantages

- Immediate money transfers through mobile device round the clock 24 x 7.
- Can use single mobile application for accessing multiple bank accounts.
- Single Click Authentication for transferring of fund.
- It is not required to enter the details such as Card no, Account number, IFSC etc. for every transaction.
- Electronic payments will become much easier without requiring a digital wallet or credit or debit card.

16.8 Cash on delivery

Cash on delivery (COD) also called as collection on delivery, describes a mode of payment in which the payment is made only on receipt of goods rather in advance. Originally, the term applies only to cash payment, but since other forms of payment have become more common, the word “cash” has sometimes been replaced by the word “collect” to transactions with checks, credit cards or debit cards.

COD is often used as an additional payment option in E-Commerce. It offers the recipient the advantage of paying only when commodity is handed over that is likely similar to traditional system. If the goods are not paid, they are returned to the retailer.
Payments are the financial instruments used globally to transfer value in the form of money or its substitutes and are constantly changing due to new technology and Government regulations.

Payment system can also be divided into two types, namely the cash payment system and the non-cash payment system based on the instruments used. In the cash payment system, the instruments used are in the form of currency (paper money and coins) while in the non-cash payment system the instruments used are card-based payment, Cheques or electronic money.

A Credit card plays a major role in electronic payment system worldwide.

ECS is treated as a electronic cheques by the bank. The advantages and disadvantages of the physical cheque is also extended to ECS. In electronic clearing services, bank process the instructions from the customer to debit his account and pay another automatically without much human interference.

(POS) Point of Sale Terminal- It enables customers to make payment for purchase of goods and services by means of credit and debit cards. To facilitate customer convenience some banks also cash withdrawal using debit cards at POS terminals.

### Points to Remember

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BIN</td>
<td>Bank Identification Number. The first six-digits of credit card number to uniquely identify financial institutions.</td>
</tr>
<tr>
<td>Brick and mortar</td>
<td>The term that refers to a business that has a physical store; opposite of online store.</td>
</tr>
<tr>
<td>(CVC2/CVV2)</td>
<td>Card Verification Code and Card Verification Value: A three digit code printed on the cardholder signature panel allows e-payments when the card is not physically accessible.</td>
</tr>
<tr>
<td>Credit card network / processor</td>
<td>Company responsible for communicating the transaction between the acquirer and the credit card issuer. E.g. MasterCard, Visa, Rupay</td>
</tr>
<tr>
<td>Double spend</td>
<td>A type of fraud where same cryptocurrency is spent in more than one transactions.</td>
</tr>
<tr>
<td>E-wallets</td>
<td>Electronic purses allow users to make electronic transactions quickly and securely</td>
</tr>
<tr>
<td>Gift cards</td>
<td>A magnetic stripe or chip card that holds the value of money to offer as a gift by a E-business</td>
</tr>
<tr>
<td>Internet banking</td>
<td>Is the activity of buying or selling of commodities through online services or over the Internet</td>
</tr>
<tr>
<td>PIN</td>
<td>Personal Identification Number. A static number that is assigned to consumers to secure card based payments.</td>
</tr>
<tr>
<td>Point of sale (POS)</td>
<td>Merchant’s electronic device that enables the e-payments. It reads the card information from EMV or magnetic strip</td>
</tr>
</tbody>
</table>
Part - I
Choose the correct answer

1. Based on the monetary value electronic payment system can be classified into
   a) Micro and Macro
   b) Micro and Nano
   c) Maximum and Minimum
   d) Maximum and Macro

2. Which of the following is not a category of micropayment?
   a) Buying a movie ticket
   b) Subscription to e journals
   c) Buying a laptop
   d) Paying for smartphone app

3. Assertion (A): Micro electronic payment systems support higher value payments.
   Reason (R): Expensive cryptographic operations are included in macro payments
   a) Both (A) and (R) are correct and (R) is the correct explanation of (A)
   b) Both (A) and (R) are correct, but (R) is not the correct explanation of (A)
   c) (A) is true and (R) is false
   d) (A) is false and (R) is true

4. Which of the following is correctly matched
   a) Credit Cards - pay before
   b) Debit Cards - pay now
   c) Stored Value Card - pay later
   d) Smart card – pay anytime

5. ECS stands for
   a) Electronic Clearing Services
   b) Electronic Cloning Services
   c) Electronic Clearing Station
   d) Electronic Cloning Station

6. Which of the following is not a Altcoin
   a) Litecoin
   b) Namecoin
   c) Ethereum
   d) Bitcoin

7. Which of the following is true about Virtual payment address (VPA)
   a) Customers can use their e-mail id as VPA
   b) VPA does not include numbers
   c) VPA is a unique ID
   d) Multiple bank accounts cannot have single VPA

8. Pick the odd one in the credit card transaction
   a) card holder
   b) merchant
   c) marketing manager
   d) acquirer

9. Which of the following is true about debit card
   i. debit cards cannot be used in ATMs
   ii. debit cards cannot be used in online transactions
   iii. debit cards do not need bank accounts
   iv. debit cards and credit cards are identical in physical properties
   a) i, ii, iii
   b) ii, iii, iv
   c) iii alone
   d) iv alone
10. Match the following

<table>
<thead>
<tr>
<th>List A</th>
<th>List B</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1) First Digit</td>
<td>B1) Account number</td>
</tr>
<tr>
<td>A2) 9th to 15th Digit</td>
<td>B2) MII Code</td>
</tr>
<tr>
<td>A3) First 6 Digits</td>
<td>B3) BIN Code</td>
</tr>
<tr>
<td>A4) Last Digit</td>
<td>B4) Check digit</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>A1</th>
<th>A2</th>
<th>A3</th>
<th>A4</th>
</tr>
</thead>
<tbody>
<tr>
<td>a)</td>
<td>B4</td>
<td>B3</td>
<td>B2</td>
</tr>
<tr>
<td>b)</td>
<td>B2</td>
<td>B1</td>
<td>B3</td>
</tr>
<tr>
<td>c)</td>
<td>B2</td>
<td>B3</td>
<td>B4</td>
</tr>
<tr>
<td>d)</td>
<td>B2</td>
<td>B4</td>
<td>B3</td>
</tr>
</tbody>
</table>

Part - II
Short Answers
1. Define electronic payment system
2. Distinguish micro electronic payment and macro electronic payment
3. List the types of micro electronic payments based on its algorithm
4. Explain the concept of e-wallet
5. What is a fork in cryptocurrency?

Part - III
Explain in Brief Answer
1. Define micro electronic payment and its role in E-Commerce.
2. Compare and contrast the credit card and debit card.
3. Explain briefly Anatomy of a credit card.
4. Briefly explain the stored value card and its types.
5. Write a note on mining in cryptocurrency.

Part - IV
Explain in detail
1. What is credit card? Explain the key players of a credit card payment system and bring out the merits of it.
2. Briefly explain Electronic Account transfer and its types.
3. Write a note on
   a. Internet banking
   b. Mobile banking
4. What is cryptocurrency? Explain the same.
5. Explain in detail: Unified payments interface

STUDENT ACTIVITIES
Presentation about various payment systems
- Choose any presentation tool (e.g. Open office impress)
- Create a slide describing a payment method.
- List the futures of the particular payment method.
- List the advantages and disadvantages of the same.
- Repeat the steps for other payment methods.
E-Commerce Security Systems

LEARNING OBJECTIVES

- To know basics of E-Commerce Security Systems
- To understand various types of E-Commerce threats
- To learn about dimensions of E-Commerce security
- To know about security technologies in E-Commerce transaction

17.1 E-Commerce Security

With the rapid development of the Internet, online transactions have increasingly become a new business model. E-Commerce transactions based on network resources have been accepted by the public. While enjoying the convenience brought by online transactions, the security of transactions has attracted much attention. The inherent openness and resource sharing of the network have seriously threatened the security of online transactions. To an E-Business security threats not only result in loss of revenue but also in reputation.

Definition

Security has become the critical factor and core issue in any emerging E-business. Solving the security problems in transactions is the basis for ensuring the smooth development of E-business.

17.2 Types of E-Commerce Threats

E-Commerce security is a set of protocols that safely guide E-Commerce transactions through the Internet.

Since E-Commerce is based on information technology and computer networks, it inevitably faces a series of security issues compared with traditional businesses. E-Commerce security threats can be accidental (caused by a human error) or intentional.

Foreign or domestic, internal or external, group or individual, business rivals or disgruntled employees, terrorists or hackers anyone with the capability, technology, opportunity, and intent to do harm can be a potential threat to E-Commerce. Though every business has pitfalls E-Commerce business would face the following specific threats.
Viruses cause harm to the computers thereby harms the efficient and smooth functioning of E-Commerce. Some viruses destroy all the information stored in a computer and cause huge loss of revenue and time. The emergence of computer viruses and their variants has rapidly increased over the past decade. The Internet has turned to be the best medium for the spread of viruses. Many new viruses directly use the Internet as their mode of transmission causing huge economic losses to E-businesses.

1. Information leakage: The leakage of trade secrets in E-Commerce mainly includes two aspects: (a) the content of the transaction between the vendor and customer is stolen by the third party; (b) the documents provided by the merchant to the customer or vice versa are illegally used by the another. This intercepting and stealing of online documents is called information leakage.

2. Tampering: E-Commerce has the problem of the authenticity and integrity of business information. When hackers grasp the data transmitted on the network, it can be falsified in the middle through various technical means, and then sent to the destination, thereby destroying the authenticity and integrity of the data.

3. Payment frauds: Payment frauds have subsets like Friendly fraud (when customer demands false reclaim or refund), Clean fraud (when a stolen credit card is used to make a purchase) Triangulation fraud (fake online shops offering cheapest price and collect credit card data) etc.

4. Malicious code threats: Within an E-Commerce site, there are multiple vulnerable areas that can serve as an intrusion point for a hacker to gain payment and user information. Using malware, Cross Site Scripting or SQL Injection, an attacker will extract the credit card information and sell the acquired data on black markets. Fraud is then committed to extract the greatest value possible through E-Commerce transactions or ATM withdrawals, etc.

5. Distributed Denial of Service (DDoS) Attacks: It is a process of taking down an E-Commerce site by sending continuous overwhelming request to its server. This attack will be conducted from numerous unidentified computers using botnet. This attack will slow down and make the server inoperative. DDoS attacks is also called as network flooding.

6. Cyber Squatting: Cybersquatting is the illegal practice of registering an Internet
of E-Commerce activities has become the core research field of E-Commerce. The following are some of the security elements involved in E-Commerce.

- **Authenticity**: conforming genuineness of data shared.
- **Availability**: prevention against data delay or removal.
- **Completeness**: unification of all business information.
- **Confidentiality**: protecting data against unauthorized disclosure.
- **Effectiveness**: effective handling of hardware, software and data.
- **Integrity**: prevention of the data being unaltered or modified.
- **Non-repudiation**: prevention against violation agreement after the deal.
- **Privacy**: prevention of customers’ personal data being used by others.
- **Reliability**: providing a reliable identification of the individuals or businesses.
- **Review ability**: capability of monitoring activities to audit and track the operations.

### Dimensions of E-Commerce security

As the security issue is the most worrying issue for E-Business, ensuring the security domain name that might be wanted by another person in an intention to sell it later for a profit. It involves the registering of popular trademarks and trade names as domain names before the particular company do. Cyber squatters also involve in trading on the reputation and goodwill of such third parties by inducing a customer to believe that it is an official web page.

In September 2015, the domain google.com was bought for 12 American dollars by a former Google employee which he later sold it for 6006.13 American dollars.

7. **Typopiracy**: Typopiracy is a variant of Cyber Squatting. Some fake websites try to take advantage of users’ common typographical errors in typing a website address and direct users to a different website. Such people try to take advantage of some popular websites to generate accidental traffic for their websites. e.g. www.goggle.com, www.faceblook.com

Hacking refers to unauthorized intrusion into a computer or a network. That is to say breaking security to gain access to a website illegally and intercept confidential information. They would then misuse such information to their advantage or modify and even destroy its contents to harm the competitors.

### Ransomware: Ransomware is a type of malware that usually encrypt all the files in a target’s computer and threatens to publish the critical data unless a ransom (money) is paid.
Chapter 17  E-Commerce Security Systems

17.4  Security technologies in E-Commerce transaction

Since a large amount of confidential information are involved in E-Commerce activities it must be transmitted through the safe and secured network. Sophisticated security technologies are required to ensure the security of E-Commerce transactions. At present, the security technologies in E-Commerce transactions are roughly classified into

- Encryption technology
- Authentication technology
- Authentication protocols

17.4.1 Encryption technology

Encryption technology is an effective information security protection. It is defined as converting a Plaintext into meaningless Ciphertext using encryption algorithm thus ensuring the confidentiality of the data. The encryption or decryption process use a key to encrypt or decrypt the data. At present, two encryption technologies are widely used. They are symmetric key encryption system and an asymmetric key encryption system.

Symmetric key encryption

The Data Encryption Standard (DES) is a Symmetric key data encryption method. It was introduced in America in the year 1976, by Federal Information Processing Standard (FIPS).

DES is the typical block algorithm that takes a string of bits of cleartext (plaintext) with a fixed length and, through a series of complicated operations, transforms it into another encrypted text of the same length. DES also uses a key to customize the transformation, so that, in theory, the algorithm can only be deciphered by people who know the exact key that has been used for encryption. The DES key is apparently 64 bits, but in fact the algorithm uses only 56. The other eight bits are only used to verify the parity and then it is discarded.

Today, it is considered that DES is not safe for many applications, mainly because of its relatively smaller key size (56-bit). But the key length can be easily increased by multiple use of the DES, described as Triple-DES, also known as TDES, 3DES or DESede.

![Figure 17.1 Data Encryption and Decryption process](image)
Asymmetric or Public key encryption
Asymmetric encryption also called as RSA (Rivest-Shamir-Adleman) algorithm. It uses public-key authentication and digital signatures. Until 1970s, there were only symmetric cryptosystems in which transmitter and receiver must have the same key. This raises the problem of key exchange and key management. Unlike a symmetric encryption, the communicating parties need not know other’s private-key in asymmetric encryption. Each user generates their own key pair, which consists of a private key and a public key. A public-key encryption method is a method for converting a plaintext with a public key into a ciphertext from which the plaintext can be retrieved with a private key.

17.4.2 Authentication Technology
The main role of security certification is to ensure Authentication, Integrity and Non-repudiation. This can be achieved through digital signatures and digital certificates.

<table>
<thead>
<tr>
<th>Symmetric Key Encryption</th>
<th>Asymmetric Key Encryption</th>
</tr>
</thead>
<tbody>
<tr>
<td>Same key is used for both encryption and decryption</td>
<td>Different keys are used for encryption and decryption</td>
</tr>
<tr>
<td>Speed of encryption or decryption is very fast</td>
<td>Speed of encryption or decryption is comparatively slow</td>
</tr>
<tr>
<td>Plain text and cipher text are of same size</td>
<td>The size of cipher text is always greater than plain text</td>
</tr>
<tr>
<td>Algorithms like DES, AES, RC4 uses symmetric key encryption</td>
<td>Algorithms like RSA, ECC, DSA use asymmetric key encryption</td>
</tr>
<tr>
<td>Provides confidentiality</td>
<td>Provides confidentiality, authenticity and non-repudiation</td>
</tr>
<tr>
<td>The number of key used grows exponentially with the number of users</td>
<td>The number of key used grows linearly with the number of users</td>
</tr>
</tbody>
</table>
In 1976, Whitfield Diffie and Martin e. Hellman, devised an algorithm called public key encryption. The algorithm can be understood using color game. This how could “A” and “B” get a secret key without letting “C” finding it out. The trick is based on 2 facts

- It is easy to mix 2 colors together to get 3rd color
- Given a mixed color it’s hard to reverse it in order to find the exact original colors

1. First A and B agree publicly on a starting color (yellow)
2. Now A select a random colour (red) mix it with yellow and send new color (yellow+red=orange) to B.
3. Similarly B selects a random colour (blue) mix it with yellow and send new colour (yellow+blue=green) to A.
4. Hacker “C” may have two new colours (orange) and (green) but not the A’s (red) or B’s (blue) private colours.
5. After interchanging colors, A adds his own private (red) to B’s mixture (green) and arrive at a third secret colour(black).
6. Also B adds his own private (blue) to A’s mixture (orange) and arrive at a same third secret color (black).
7. C is unable to have the exact color (black), since C needs one of the private color to do so.

**Digital certificates**

A digital certificate (also known as public key certificate) is an electronic document used to prove the ownership of a public key. This certificate includes the information about the sender’s identity, digital signature and a public key.

Digital certificates function is similar to the functions of identification cards such as passports and driving licenses. Digital certificates are issued by recognized Certification Authorities (CA). When someone requests a digital certificate, the authority verifies the identity of the requester, and if the requester fulfills all requirements, the authority issues it. When the sender uses a certificate to sign a document digitally, receiver can trust the digital signature because he trusts that CA has done their part verifying the sender’s identity.

---

Figure 17.2 Digital Certificates
Common digital certificate systems are X.509 and PGP.

- Pretty Good Privacy (PGP): Phil Zimmermann developed PGP in 1991. It is a decentralized encryption program that provides cryptographic privacy and authentication for data communication. PGP encryption uses a serial combination of hashing, data compression, symmetric-key cryptography and asymmetric-key cryptography and works on the concept of “web of trust”.

- The X.509 system is a centralized system in which the authenticity of the key is guaranteed by the hierarchy of certification authorities formally certifying the key relationship with the identity of its owner. Due to its clear responsibility, it is easier to implant in the law, X.509 is currently world wide accepted certification technology.

**Digital signature**

A digital signature is a mechanism that is used to verify that a particular digital document, message or transaction is authentic.

It provides a receiver the guarantee that the message was actually generated by the sender. It also confirms that the

<table>
<thead>
<tr>
<th>Digital signature</th>
<th>Digital certificate</th>
</tr>
</thead>
<tbody>
<tr>
<td>A digital signature is a mechanism that is used to verify that a particular digital document, message or transaction is authentic.</td>
<td>A digital certificate is a computer file which officially approves the relation between the holder of the certificate and a particular public key.</td>
</tr>
<tr>
<td>Digital signatures are used to verify the trustworthiness of the data being sent</td>
<td>Digital certificates are used to verify the trustworthiness of the sender.</td>
</tr>
<tr>
<td>Digital signature is to ensure that a data remain secure from the point it was issued and it was not modified by a third party.</td>
<td>Digital certificate binds a digital signature to an entity</td>
</tr>
<tr>
<td>It provides authentication, non-repudiation and integrity</td>
<td>It provides authentication and security.</td>
</tr>
<tr>
<td>A digital signature is created using a Digital Signature Standard (DSS). It uses a SHA-1 or SHA-2 algorithm for encrypting and decrypting the message.</td>
<td>A digital certificate works on the principles of public key cryptography standards (PKCS). It creates certificate in the X.509 or PGP format.</td>
</tr>
<tr>
<td>The document is encrypted at the sending end and decrypted at the receiving end using asymmetric keys.</td>
<td>A digital certificate consist of certificate's owner name and public key, expiration date, a Certificate Authority’s name, a Certificate Authority’s digital signature</td>
</tr>
</tbody>
</table>
information originated from the signer and has not been altered by a cracker in the middle. Digital signatures can provide the added assurances of evidence to the origin, identity and status, as well as acknowledging the consent of the sender.

Digital signatures use a standard, worldwide accepted format, called Public Key Infrastructure (PKI), to provide the highest levels of security and universal acceptance. In many countries, digital signatures have the same legal significance as the traditional forms of signed documents. Digital signatures are widely used for avoiding forging or tampering of important documents such as financial documents or credit card data.

A security token is a hardware component that are used to identify and authenticate users.

17.4.3 Authentication protocols
At present, there are two kinds of security authentication protocols widely used in E-Commerce, namely Secure Electronic Transaction (SET) and Secure Sockets Layer (SSL).

Secure Electronic Transaction
Secure Electronic Transaction (SET) is a security protocol for electronic payments with credit cards, in particular via the Internet. SET was developed in 1996 by VISA and MasterCard, with the participation of GTE, IBM, Microsoft and Netscape.

The implementation of SET is based on the use of digital signatures and the encryption of transmitted data with asymmetric and symmetric encryption algorithms. SET also use dual signatures to ensure the privacy.

The SET purchase involves three major participants: the customer, the seller and the payment gateway. Here the customer shares the order information with the seller but not with the payment gateway. Also the customer shares the payment information only with the payment gateway but not with the seller. So, with the SET, the credit card number may not be known to the seller and will not be stored in seller’s files also could not be recovered by a hacker.

The SET protocol guarantees the security of online shopping using credit cards on the open network. It has the advantages of ensuring the integrity of transaction data and the non-repudiation of transactions. Therefore, it has become the internationally recognized standard for credit card online transaction.

SET system incorporates the following key features:
● Using public key encryption and private key encryption ensure data confidentiality.
● Use information digest technology to ensure the integrity of information.
● Dual signature technology to ensure the identity of both parties in the transaction.
Today, all browsers in the market support SSL, and most of the secure communications are proceeded through this protocol. SSL works completely hidden for the user, who does not have to intervene in the protocol. The only thing the user has to do is make sure the URL starts with https:// instead of http:// where the “s” obviously means secured. It is also preceded by a green padlock.

**Secure Sockets Layers**

The most common Cryptographic protocol is Secure Sockets Layers (SSL). SSL is a hybrid encryption protocol for securing transactions over the Internet. The SSL standard was developed by Netscape in collaboration with MasterCard, Bank of America, MCI and Silicon Graphics. It is based on a public key cryptography process to ensure the security of data transmission over the internet. Its principle is to establish a secure communication channel (encrypted) between a client and a server after an authentication step.

The SSL system acts as an additional layer, to ensure the security of data, located between the application layer and the transport layer in TCP. For example, a user using an internet browser to connect to an SSL secured E-Commerce site will send encrypted data without any more necessary manipulations. Secure Sockets Layers (SSL) was renamed as Transport Layer Security (TLS) in 2001. But still it is popularly known under the name SSL. TLS differs from SSL in the generation of symmetric keys.

3D Secure

“3-D Secure is a secure payment protocol on the Internet. It was developed by Visa to increase the level of transaction security, and it has been adapted by MasterCard. It gives a better authentication of the holder of the payment card, during purchases made on websites. The basic concept of this (XML-based) protocol is to link the financial authorization process with an online authentication system. This authentication model comprise 3 domains (hence the name 3D) which are:

1. The Acquirer Domain
2. The Issuer Domain
3. The interoperability Domain
The operating principle of SSL using public key encryption could be easily understood with the following scenario “Kumar orders a mobile phone from an online store (abc.com).”

1. Kumar connects to abc.com website through a secure connection, from his computer browser.
2. The abc.com website sends Kumar an digital certificate and a public key (P). This digital certificate issued by a certification authority (CA) proves the identity of abc.com.
3. Kumar’s browser checks the certificate. It (browser) then agrees with the remote server on a symmetric cryptographic system to use. Then it randomly choose a key for this algorithm (session key K).
4. Kumar’s browser sends P (K) to abc.com. Using its secret key S, the abc.com server calculates S (P (K)) = K. Thus, Kumar’s browser and abc.com server are in possession of the same key.
5. Kumar enters his credit card number and other data. They constitute the “information”. The browser sends these “information” to abc.com, encrypted using the key K. It also sends a summary of this “information”, using a mathematical function called hash function.
6. With the K key, the abc.com server can decrypt the “information”. It also calculates the summary of information, and compares with the summary sent by Kumar’s browser. If they coincide, it is assumed that the data has been correctly transmitted.

POINTS TO REMEMBER

- Phishing: Phishing is acquiring critical data like login credentials through telephone, sms, e-mail or any social media by the crackers disguising as authentic.
- Authentication: Information of the entity sending the document is often included in the document, but the information may be inaccurate. A digital signature can be used to authenticate the source of a document.
- Integrity: In many scenarios, the sender and receiver of the document will require confidence that the document has not been tampered with during the transfer. If the document was digitally signed, any modification of the document will invalidate the signature.
- Non-repudiation: Repudiation refers to any act of relinquishing responsibility for a message. Non-repudiation ensures that the signer who digitally signed the document cannot deny having signed it. The digitally signed documents strengthen
its recipient integrity claims. Therefore, the recipient can strongly insist on the
signature of the sender so as not to be easily denied at a later time.

- The difference between a digital signature and digital certificate is that a digital
certificate binds a digital signature to an entity; whereas a digital signature ensures
that a data remain secure from the point it was sent. In other words: digital
certificates are used to verify the trustworthiness of the sender, while digital
signatures are used to verify the trustworthiness of the data being sent.

- The certificate authority maintains a database of public keys called repository so
that it can verify the user with digital signatures. Expired certificates are usually
deleted from the database by the certificate authority.

- Brute-force attacks is the simplest attack method for breaking any encryption; that
is, trying all the possible keys one by one.

---

| Glossary |
|------------------|-------------------------------------------------|
| **3-D Secure**   | An additional security layer for online credit and debit card transactions. |
| **Ciphertext**   | It is the encrypted data usually the output of an encryption algorithm |
| **Cracker**      | A person who breaks computer network’s security maliciously to gain access to critical data. |
| **Cryptanalysis**| Analyzing a suspecting document for hidden data or ciphertext |
| **Cyber Squatting** | Is the illegal practice of registering an Internet domain name that might be wanted by another person in an intention to sell it later for a profit |
| **Decipher**     | A standard algorithm for decrypting data |
| **Domain name**  | The website address of an online store, e.g. www.amazon.com |
| **Encryption**   | A method of scrambling data using an algorithm to protect / hide from unauthorized access. |
| **Friendly Fraud** | Is an intentional falsely claim of a customer that they really didn’t buy (after receiving the goods) |
| **Hacking**      | Unauthorized intrusion into a computer or a network. That is to say breaking security to gain access to a website illegally and intercept confidential information |
| **Message digest (MD)** | Is a representation of data in a form of single string of digits using one-way hashing formula. |
| **One-Time Password (OTP)** | A dynamic password that is valid for one login session or transaction provides a potential security for a e-payment transaction. |
| **PIN (Personal Identification Number)** | A static number that is assigned to consumers to secure card based payments. |
| **Plaintext/cleartext** | It is the unencrypted information also called as input chip |
| **Traffic**      | An indicator that marks the number of visitors for a particular site. |
Part - I
Choose the correct answer

1. In E-Commerce, when a stolen credit card is used to make a purchase it is termed as
   a) Friendly fraud
   b) Clean fraud
   c) Triangulation fraud
   d) Cyber squatting

2. Which of the following is not a security element involved in E-Commerce?
   a) Authenticity
   b) Confidentiality
   c) Fishing
   d) Privacy

3. Asymmetric encryption is also called as
   a) Secure Electronic Transaction
   b) Certification Authority
   c) RSA algorithm
   d) Payment Information

4. The security authentication technology does not include
   i) Digital Signatures
   ii) Digital Time Stamps
   iii) Digital Technology
   iv) Digital Certificates
   a) i, ii & iv    b) ii & iii
   c) i, ii & iii   d) all the above

5. PGP stands for
   a) Pretty Good Privacy
   b) Pretty Good Person
   c) Private Good Privacy
   d) Private Good Person

6. _____ protocol is used for securing credit cards transactions via the Internet
   a) Secure Electronic Transaction (SET)
   b) Credit Card Verification
   c) Symmetric Key Encryption
   d) Public Key Encryption

7. Secure Electronic Transaction (SET) was developed in
   a) 1999
   b) 1996
   c) 1969
   d) 1997

8. The websites secured by Secure Socket Layer protocols can be identified using
   a) html://
   b) http://
   c) htmls://
   d) https://

9. 3-D Secure, a protocol was developed by
   a) Visa
   b) Master
   c) Rupay
   d) PayTM
10. Which of the following is true about Ransomware
   a) Ransomware is not a subset of malware
   b) Ransomware deletes the file instantly
   c) Typopiracy is a form of ransomware
   d) Hackers demand ransom from the victim

Part - II
Short Answers
1. Write about information leakage in E-Commerce.
2. Write a short note on typopiracy.
3. Define non-repudiation.
4. List the different types of security technologies in E-Commerce
5. Write about digital signature.

Part - III
Explain in Brief Answer
1. Write a note on certification authorities (CA)
2. List some E-Commerce Security Threats?
3. Differentiate asymmetric and symmetric algorithms.
4. Write a note on PGP.
5. Explain 3D secure payment protocols

Part - IV
Explain in detail
1. Write about dimensions of E-Commerce Security.
2. Explain encryption technology.
3. Differentiate digital signatures and digital certificates.
4. Define Secure Electronic Transaction (SET) and its features.
5. Briefly explain SSL.

STUDENT ACTIVITY

Identifying the security protocols used in the particular payment gateway.

- Create a chart for a payment process.
- Describe the security technology used in that payment method.
- Repeat the process for few other payment process.
18.1 Introduction to EDI

The Electronic Data Interchange (EDI) is the exchange of business documents between one trade partner and another electronically. It is transferred through a dedicated channel or through the Internet in a predefined format without much human intervention.

It is used to transfer documents such as delivery notes, invoices, purchase orders, advance ship notice, functional acknowledgements etc. These documents are transferred directly from the computer of the issuing company to that of the receiving company, with great time saving and avoiding many errors of traditional “on paper” communications.

Before the popularization of Internet-based E-Commerce, it was a major E-Commerce model. EDI includes data exchange between buyers and sellers, trade partners, and also internal data exchange within departments of a company. There are many internationally accepted EDI standard e.g. EDIFACT, XML, ANSI ASC X12, etc. See Figure 18.1

EDI is “Paperless Trade” and EFT (Electronic Transfer) is “Paperless Payment”
Chapter 18 Electronic Data Interchange - EDI

In the late 1960s, shipping lines, railroads, airlines, and truck companies of the USA were exchanging electronic messages for their businesses. These messages were in different formats, and this resulted in problems in the transfer of goods. In 1968, these companies grouped together and formed the Transportation Data Coordinating Committee (TDCC) to develop EDI standard formats.

In 1975, the first EDI standards were released by TDCC, of which Ed Guilbert was a major contributor. In 1977, a group of supermarket companies and their business partners began drafting and using an EDI project. The TDCC was renamed as Electronic Data Interchange Association (EDIA) in 1978. Later in that year, the EDIA was undertaken by the American National Standards Institute and becomes the ANSI X12 committee. Since then, this committee has been responsible for the publication of EDI standards.

Later in 1985, UN created the EDIFACT to assist with the global reach of technology in E-Commerce. EDIFACT is the most widely used EDI.
Direct EDI/Point-to-Point

It is also called as Point-to-Point EDI. It establishes a direct connection between various business stakeholders and partners individually. This type of EDI suits to larger businesses with a lot of day to day business transactions.

EDI via VAN

EDI via VAN (Value Added Network) is where EDI documents are transferred with the support of third party network service providers. Many businesses prefer this network model to protect them from the updating ongoing complexities of network technologies. See Figure 18.2

A value-added network is a company, that is based on its own network, offering EDI services to other businesses. A value-added network acts as an intermediary between trading partners. The principle operations of value-added networks are the allocation of access rights and providing high data security.

18.2 EDI Types

The types of EDI were constructed based on how EDI communication connections and the conversion were organized. Thus based on the medium used for transmitting EDI documents the following are the major EDI types.

- Direct EDI
- EDI via VAN
- EDI via FTP/VPN, SFTP, FTPS
- Web EDI
- Mobile EDI

The first EDI messages was sent in 1965 from the Holland-American steamship line to Trans-Atlantic shipping company using telex messages. The computer had sent a full page of information in roughly 2 minutes. These messages were then written on the magnetic tapes that could be loaded onto another computer.
**EDI via FTP/VPN, SFTP, FTPS**

When protocols like FTP/VPN, SFTP and FTPS are used for exchange of EDI based documents through the Internet or Intranet it is called as EDI via FTP/VPN, SFTP, FTPS.

**Web EDI**

Web based EDI conducts EDI using an web browser via the Internet. Here the businesses are allowed to use any browser to transfer data to their business partners. Web based EDI is easy and convenient for small and medium organizations.

**Mobile EDI**

When smartphones or other such handheld devices are used to transfer EDI documents it is called as mobile EDI. Mobile EDI applications considerably increase the speed of EDI transactions.

18.3 **Advantages of EDI**

EDI was developed to solve the problems inherent in paper-based transaction processing and in other forms of electronic communication. Implementing EDI system offers a company greater control over its supply chain and allow it to trade more effectively. It also increases productivity and promotes operational efficiency. The following are the other advantages of EDI.

- Improving service to end users
- Increasing productivity
- Minimizing errors
- Slashing response times
- Automation of operations
- Cutting costs
- Integrating all business and trading partners

- Providing information on process status
- Optimizing financial ratios

18.4 **EDI Layers**

Electronic data interchange architecture specifies four different layers namely

1. Semantic layer
2. Standards translation layer
3. Transport layer
4. Physical layer

These EDI layers describes how data flows from one computer to another. See Figure 18.3

<table>
<thead>
<tr>
<th>EDI semantic layer</th>
<th>Application level services</th>
</tr>
</thead>
<tbody>
<tr>
<td>EDIFACT business form standards</td>
<td></td>
</tr>
<tr>
<td>ANSI X 12 business form standards</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>EDI standard layer</th>
<th>EDI transport layer</th>
<th>Physical layer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electronic mail</td>
<td>X.435, MIME</td>
<td>Dial-up line, internet, I-way</td>
</tr>
<tr>
<td>Point to point</td>
<td>FTP, TELNET</td>
<td></td>
</tr>
<tr>
<td>World Wide Web</td>
<td>HTTP</td>
<td></td>
</tr>
</tbody>
</table>

**Figure: 18.3 EDI Layers**

18.5 **EDI Components**

There are four major components of EDI. They are

1. Standard document format
2. Translator and Mapper
3. Communication software
4. Communication network

18.6 **EDI Standards**

The standard is the most critical part of the entire EDI. Since EDI is the data transmission and information exchange in the form of an agreed message format, it is important to develop a unified EDI standard. The EDI standard
is mainly divided into the following aspects: basic standards, code standards, message standards, document standards, management standards, application standards, communication standards and security standards.

The first industry-specific EDI standard was the TDCC published by the Transportation Data coordinating Committee in 1975. Then other industries started developing unique standards based on their individual needs. E.g. WINS in the warehousing industry.

Since the application of EDI has become more mature, the target of trading operations is often not limited to a single industry. In 1979, the American National Standards Institute Accredited Standard Committee (ANSI ASC) developed a wider range of EDI standard called ANSI X12.

On the other hand, the European region has also developed an integrated EDI standard. Known as GTDI (Guideline for Trade Data Interchange).

ANSI X12 and GTDI have become the two regional EDI standards in North America and Europe respectively.

After the development of the two major regional EDI standards and a few years after trial, the two standards began to integrate and conduct research and development of common EDI standards. Subsequently, the United Nations Economic Commission for Europe (UN/ECE/WP.4) hosted the task of the development of international EDI standards. In 1986, UN/EDIFACT is officially proposed. The most widely used EDI message standards are the United Nations EDIFACT and the ANSI X12.

### 18.7 UN/EDIFACT

United Nations / Electronic Data Interchange for Administration, Commerce and Transport (UN / EDIFACT) is an international EDI standard developed under the supervision of the United Nations. In 1987, the UN / EDIFACT syntax rules were approved as ISO: ISO9735 standard by the International Organization for Standardization. See Figure 18.4

EDIFACT includes a set of internationally agreed standards, catalogs and guidelines for electronic exchange of structured data between independent computer systems.

![Image](https://example.com/edifact.png)

**Figure: 18.4 UN/EDIFACT**

It is a cross-industry, standard data format of electronic data for commercial transactions. Maintenance and further development of this standard goes through the United Nations Center for Trade Facilitation and Electronic Business (UN/CEFACT), which is affiliated to the UN Economic Commission for Europe (UNECE).

**EDIFACT directories**

The versions of EDIFACT are also called as directories. These EDIFACT directories
will be revised twice a year; on 1st April and 1st October to include new or update existing EDIFACT messages. EDIFACT directories have names like D.18B (D stands for Directory, 18 is the year and A/B indicates the month of release)

**EDIFACT subsets**

Due to the complexity, branch-specific subsets of EDIFACT have developed. These subsets of EDIFACT include only the functions relevant to specific user groups.

**Example:**

- CEFIC - Chemical industry
- EDIFURN - furniture industry
- EDIGAS - gas business

**EDIFACT Structure**

EDIFACT is a hierarchical structure where the top level is referred to as an interchange, and lower levels contain multiple messages. The messages consist of segments, which in turn consist of composites. The final iteration is a data element. See Figure 18.5 and 18.6

**Segment Tables**

Segment table lists the message tags. It contains the tags, tag names, requirements designator and repetitation field. The requirement designator may be mandatory (M) or conditional (C). The (M) denotes that the segment must appear at least once. The (C) denotes that the segment may be used if needed. e.g. C10 indicates repetitions of a segment or group between 0 and 10.

![Figure 18.5 Sample EDI Application](image)
Figure: 18.6 UN/EDIFACT Message structure

- **Highest Level**
  - Interchange
    - Piece of data between segments UNB/UNZ
  - Functional Groups
    - Piece of data between segments UNG/UNE
  - Messages
    - Piece of data between segments UNH/UNT
  - Segment Groups
    - Block of related data
  - Segments
    - Mixture of simple and composite elements
  - Composite Elements
    - Group of related simple elements
  - Simple data Elements
    - Piece of single data
  - Lowest Level
EDI Interchange
Interchange is also called as envelope. The top level of EDIFACT structure is Interchange. An interchange may contain multiple messages. It starts with UNB and ends with UNZ.

EDIFACT message
The basic standardization concept of EDIFACT is that there are uniform message types called United Nations Standard Message (UNSM). In so-called subsets, the message types can be specified deeper in their characteristics depending on the sector. The message types, all of which always have exactly one nickname consisting of six uppercase English alphabets. The message begins with UNH and ends with UNT.

- Service messages
  To confirm / reject a message, CONTRL and APERAK messages are sent.
  - CONTRL - Syntax Check and Confirmation of Arrival of Message
  - APERAK - Technical error messages and acknowledgment

- Data exchange
  - CREMUL - multiple credit advice
  - DELFOR - Delivery forecast
  - IFTMBC - Booking confirmation

EDIFACT Segment
It is the subset of message. A segment is a three-character alphanumeric code. These segments are listed in segment tables. Segments may contain one, or several related user data elements.

EDIFACT Elements
The elements are the piece of actual data. These data elements may be either simple or composite.

An excerpt from an EDIFACT message might be:

```
DTM + 11: 200 606 200 730: 203'
```

This whole line is called a segment. The meaning of each code is as follows:

- DTM is the segment identifier and it indicates that the following data is date / time information.
- 11 is a data element. In this example, a qualifier describes what kind of event is meant. The code 11 means: time of dispatch / delivery of goods.
- 200606200730 is another element. Here it represents the date in the format CCYYMMDDHHHMMM.
- 203 is also an element. 203 is an identifier for the date format.

In this example, 203 means that the date is in the format CCYYMMDDHHHMMM (as of D.18B, CC – century, YY – Year, MM- Month, DD – Date, HH – Hour, MM – Minute)

EDI Separators
EDIFACT has the following punctuation marks that are used as standard separators.

<table>
<thead>
<tr>
<th>Character</th>
<th>Uses</th>
</tr>
</thead>
<tbody>
<tr>
<td>’</td>
<td>segment terminator</td>
</tr>
<tr>
<td>+</td>
<td>segment tag and data element separator</td>
</tr>
<tr>
<td>:</td>
<td>component data element separator</td>
</tr>
<tr>
<td>?</td>
<td>release character</td>
</tr>
<tr>
<td>.</td>
<td>decimal point</td>
</tr>
</tbody>
</table>
Example:

UNA:+.?:
UNB+IATB:1+6XPPC:ZZ+LHPPC:ZZ+940101:0950+1'
UNH+1+PAORES:93:1:IA'
MSG+1:45'
IFT+3+XYZCOMPANY AVAILABILITY'
ERC+A7V:1:AMD'
IFT+3+NO MORE FLIGHTS'
ODI'
TVL+240493:1000::1220+FRA+JFK+DL+400+C'
PDI++C:3+Y:3+F:1'
APD+74C:0::6+++++++6X'
TVL+240493:1740::2030+JFK+MIA+DL+081+C'
PDI++C:4'
APD+EM2:0:1630::6++++++++DA'
UNT+13+1'
UNZ+1+1'

POINTS TO REMEMBER

- According to the National Institute of Standards and Technology, EDI is “the computer-to-computer interchange of strictly formatted messages that represent documents other than monetary instruments.”
- EDI is “Paperless Trade” and EFT (Electronic Transfer) is “Paperless Payment”
- Ed Guilbert, is called as the father of EDI
- In 1985, UN created the EDIFACT to assist with the global reach of technology in E-Commerce.
- Direct EDI is also called as Point-to-Point EDI
- Every EDI message consist of six uppercase English Alphabets
### Glossary

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advance ship notice</td>
<td>A notification of pending deliveries</td>
</tr>
<tr>
<td>FTP</td>
<td>A standard network protocol used for the transfer of computer files between a client and server on a computer network.</td>
</tr>
<tr>
<td>Interchange</td>
<td>The top level message of EDI hierarchical structure</td>
</tr>
<tr>
<td>Invoice</td>
<td>A commercial document issued by a seller to a buyer containing product name, quantity and price.</td>
</tr>
<tr>
<td>Purchase order</td>
<td>A commercial and first official document issued by a buyer to a seller indicating types, quantities, and agreed prices for products or services.</td>
</tr>
<tr>
<td>Segment</td>
<td>Segments may contain one, or several related user data elements.</td>
</tr>
<tr>
<td>Separators</td>
<td>Punctuation marks that are used to separate segments or elements.</td>
</tr>
<tr>
<td>TDCC</td>
<td>Transportation Data Communication Committee - The first industry-specific EDI standard.</td>
</tr>
<tr>
<td>Telex</td>
<td>A type of teleprinter</td>
</tr>
<tr>
<td>VAN</td>
<td>Value Added Network, a third party network service provider</td>
</tr>
</tbody>
</table>

---

**Choose the correct answer**

1. EDI stands for
   - a) Electronic Details Information
   - b) Electronic Data Information
   - c) Electronic Data Interchange
   - d) Electronic Details Interchange

2. Which of the following is an internationally recognized standard format for trade, transportation, insurance, banking and customs?
   - a) TSLFACT
   - b) SETFACT
   - c) FTPFACT
   - d) EDIFACT

3. Which is the first industry-specific EDI standard?
   - a) TDCC
   - b) VISA
   - c) Master
   - d) ANSI

4. UNSM stands for?
   - a) Universal Natural Standard message
   - b) Universal Notations for Simple message
   - c) United Nations Standard message
   - d) United Nations Service message
5. Which of the following is a type of EDI?
   a) Direct EDI
   b) Indirect EDI
   c) Collective EDI
   d) Unique EDI

6. Who is called as the father of EDI?
   a) Charles Babbage
   b) Ed Guilbert
   c) Pascal
   d) None of the above

7. EDI interchanges starts with _____ and ends with _____
   a) UNA, UNZ
   b) UNB, UNZ
   c) UNA, UNT
   d) UNB, UNT

8. EDIFACT stands for
   a) EDI for Admissible Commercial Transport
   b) EDI for Advisory Committee and Transport
   c) EDI for Administration, Commerce and Transport
   d) EDI for Admissible Commerce and Trade

9. The versions of EDIFACT are also called as
   a) Message types
   b) Subsets
   c) Directories
   d) Folders

10. Number of characters in an single EDIFACT messages
    a) 5       b) 6       c) 4       d) 3

Part - II
Short Answers
1. Define EDI.
2. List few types of business documents that are transmitted through EDI.
3. What are the 4 major components of EDI?
4. What is meant by directories in EDIFACT?
5. Write a note on EDIFACT subsets.

Part - III
Explain in Brief Answer
1. Write a short note on EDI.
2. List the various layers of EDI.
3. Write a note on UN/EDIFACT.
4. Write a note on EDIFACT message.
5. Write about EDIFACT separators

Part - IV
Explain in detail
1. Briefly explain various types of EDI.
2. What are the advantages of EDI?
3. Write about structure of EDIFACT.

STUDENT ACTIVITY

Prepare a chart explaining various types of EDI standards. (e.g. web EDI)
AIM
To create a new document using the default given options.

1. Open Pagemaker 7.0 and create a new document layout which includes the following setup options:
   - Page size – A4.
   - Number of Pages – 4.
   - Margins 1.25 inches - top, and .75 inches - all other sides.

2. Type the following text:
   HAPPINESS
   Happiness is often confused with fun, good living, and riches. Sometimes fun is equated with happiness. Fun is what we experience while doing an activity, whereas happiness is a residual and long-lasting feeling. The path to happiness is long and full of challenges. Happiness requires life-long pursuit.

3. Set the heading ‘HAPPINESS’ in 18 points, Arial font, bold and alignment centre.

4. Format the paragraph as follows:
   (a) Font – Arial
   (b) Font size – 12
   (c) Alignment – Justified
   (d) Leading – 20

5. Save the document as ‘happiness’.
Procedure
1. Start the PageMaker using the following commands.
   Start -> All Programs -> Adobe -> PageMaker 7.0 -> Adobe PageMaker 7.0. The Adobe PageMaker window will be opened as shown in Figure.
2. Choose File > New in the menu bar. (or) Press Ctrl + N in the keyboard. This opens the Document Setup dialog box.

- Click the Page Size drop down list box and select A4 size.
- In the Number of pages text box, type 4.
- Set the values in the Margins sections as follows:
  - Inside – 0.75 inches
  - Outside – 0.75 inches
  - Top – 1.25 inches
  - Bottom – 0.75 inches

![Document Setup dialog box for setting page size, pages, and margins.](image-url)
3. Click on OK. Now a new document called Untitled – 1 will appear on the screen as shown in Figure.

4. Click on the Text tool and create a text block. Then type the following text in the text block.

    HAPPINESS

    Happiness is often confused with fun, good living, and riches. Sometimes fun is equated with happiness. Fun is what we experience while doing an activity, whereas happiness is a residual and long-lasting feeling. The path to happiness is long and full of challenges. Happiness requires life-long pursuit.
5. Select the word ‘HAPPINESS’ with Text tool. Using Character Control Palette, change the font to Arial, font size to 18, and Leading 22. Then click on Bold button. Then press Shift + Ctrl + C for centre alignment.
7. To save the document as ‘happiness’
   (a) Press Ctrl + S (or) Choose File > Save in the menu bar. Save publication dialogue box appears. Type ‘happiness’ in the File name text box and press Save button.

Output

HAPPINESS

Happiness is often confused with fun, good living, and riches. Sometimes fun is equated with happiness. Fun is what we experience while doing an activity, whereas happiness is a residual and long-lasting feeling. The path to happiness is long and full of challenges. Happiness requires life-long pursuit.

Conclusion

The expected output is achieved.
Create a Student Notice Board using PageMaker.

**Procedure**

1. Start the PageMaker using the following commands.
   
   Start -> All Programs -> Adobe -> PageMaker 7.0 -> Adobe PageMaker 7.0. The Adobe PageMaker window will be opened.

2. Choose File > New in the menu bar (or) Press Ctrl + N in the keyboard.
   
   This opens the Document Setup dialog box.

3. Click on OK button.
   
   Now a new document called Untitled – 1 will appear on the screen.

4. Create a box with dimension 100 mm x 100 mm using the Rectangle tool. Fill it with cyan colour and change the percentage value of tint to 25%. The resulting box is as shown in Figure.
5. Similarly create another box with dimension 100 mm x 15 mm. Fill it with black colour and place it on the top portion of the cyan filled box as shown in figure.
6. With the text tool click and drag the mouse from the left corner to the right corner of the black filled box and type the following words “Student Notice Board”. The colour of the text and the colour of the box will be same black colour. As soon as you finish typing press Ctrl + A in the keyboard which will select the entire text. Using Character Control palette change the font size to 20 points and click on the Bold button. Then click on the Reverse button which will change the colour of the text to white and press Shift + Ctrl + C for centre alignment. The result is as shown in Figure.

![Output Image]

**Conclusion**

The expected output is achieved.
Create the following Visiting Card using PageMaker.

```
S. Barath Kumar

Vision TECH

5, Annai Avenue, Trichy - 17
Ph : 0431 - 2780000
```

**Procedure**

1. Start the PageMaker using the following commands.
   
   Start -> All Programs -> Adobe -> Pagemaker 7.0 -> Adobe PageMaker 7.0. The Adobe PageMaker window will be opened as shown in Figure 1.1.
2. Choose File > New in the menu bar (or) Press Ctrl + N in the keyboard. This opens the Document Setup dialog box.
3. Click on OK. 
Now a new document called Untitled – 1 will appear on the screen as shown in Figure.

4. Now you can change Measuring Units from Inches to Millimeters. 
Choose File > Preferences > general (or ) Press Ctrl + K. Now Preferences dialogue box appears. 
Change the unit of Measurements and Vertical ruler to Millimeters.
5. Select the Rectangle Tool from the Tool box and draw a rectangle.
6. Using Control Palette, the width and height value of the rectangle has to be set to 95 mm and 55 mm respectively.
7. Select the Text Tool in the Tool box. Then drag from the left corner of the rectangle box to the right corner to specify the boundary of the text that is to be typed.

8. Type the Name of the person and select it using Text tool. Choose suitable Font and Font Size from the Control Palette. Then move it a little bit towards right side.
9. Repeat the step 7. Then type the Company name and select it using Text tool. Choose suitable Font and Font Size from the Control Palette. Then move it a little bit towards right side.

Select the First character using the Text tool and increase the font size.
10. Repeat the step 7. Then type the Company Address and select it using Text tool. Choose suitable Font and Font Size from the Control Palette. Then move it towards right side.

Output

Conclusion
The expected output is achieved.
Procedure

1. Start the PageMaker using the following commands.
   Start -> All Programs -> Adobe -> Pagemaker 7.0 -> Adobe PageMaker 7.0.
2. Choose File > New in the menu bar (or) Press Ctrl + N in the keyboard.
   This opens the Document Setup dialog box.
3. Click on OK.
   Now a new document called Untitled – 1 will appear on the screen.
4. Now you can change Measuring Units from Inches to Millimeters.
   Choose File > Preferences > general (or ) Press Ctrl + K. Now Preferences dialogue box appears.
   Change the unit of Measurements and Vertical ruler to Millimeters.
5. Select the Rectangle Tool from the Tool box and draw a rectangle.

6. Using Control Palette, the width and height value of the rectangle has to be set to 100 mm and 40 mm respectively.

7. Choose Element > Rounded corners from the menu bar.

8. Choose the required shape from the rounded corners dialog box. Now the rectangle appears with the rounded corners.

9. Select the Text Tool in the Tool box and create a text block within the rectangle.

10. Type **Name** : and press a Tab key and then press Enter key.

   Type **STD** : and press a Tab key and then press Enter key.

   Type **Section** : and press a Tab key and then press Enter key.

   Type **School** : and press a Tab key and then press Enter key.

   Type **Subject** : and press a Tab key.

11. Select all the text using Text tool.

12. Choose Type > Indents / Tabs (or) press Ctrl + I.

13. Set a right tab at the value 90 mm and choose the dotted line style from the leader option and then press Apply button.
14. Now the required label is created.

Output

Name: .........................................................
STD: ............................................................
Section: ....................................................... 
School: .........................................................
Subject: .........................................................

Conclusion
The expected output is achieved.
### AIM

To execute following DDL [Data definition Language] and DML [Data manipulating Language] MySQL queries

1. CREATE - to create a database and its objects like (table, index, views, store procedure, function, and triggers)
2. ALTER - alters the structure of the existing database.
3. DROP - delete objects from the database.
4. SELECT - retrieve data from a database.
5. INSERT - insert data into a table.
6. UPDATE - updates existing data within a table.
7. DELETE - Delete all records from a database table.

### Procedure

1. Open MySQL command prompt from XAMPP Control panel.
2. To login in to your Database using User name and password.
3. Execute and get the output of given DDL MySQL queries.

### SYNTAX:

Based on the below syntax queries are built and executed.

* CREATE DATABASE testDB;
* CREATE TABLE table_name (column1datatype,column2datatype,column3datatype, .... );
* ALTER TABLE `table_name` ADD COLUMN `column_name` `data_type`;
* DROP DATABASE databasename;
* SELECT * FROM TABLE NAME
* INSERT INTO table_name( field1, field2,...fieldN ) VALUES ( value1, value2,...valueN );
* UPDATE table_name SET field1 = new-value1, field2 = new-value2 [WHERE Clause]
* DROP TABLE table_name ;
**PROGRAM:**
CREATE DATABASE SchoolDB;

CREATE TABLE student(
    studentID int,
    LastName varchar(255),
    FirstName varchar(255),
    Address varchar(255),
    City varchar(255)
);

ALTER TABLE `members` ADD COLUMN `credit_card_number` VARCHAR(25);

DROP DATABASE SchoolDB

SELECT * FROM student

INSERT INTO student (studentID, LastName, FirstName, Address, City) VALUES
(“002”, “Ram”, “Kumar”, “ROJA NAGAR”, “CHENNAI”);

SELECT * FROM student

UPDATE student SET LastName = ‘SRI’ WHERE studentID = 003;

SELECT * FROM student

DROP TABLE student;

SELECT * FROM student
### OUTPUT

Database created

Table created:

<table>
<thead>
<tr>
<th>studentID</th>
<th>LastName</th>
<th>FirstName</th>
<th>Address</th>
<th>City</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table Altered

Database dropped

<table>
<thead>
<tr>
<th>StudentID</th>
<th>LastName</th>
<th>FirstName</th>
<th>Address</th>
<th>City</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

One row inserted.

<table>
<thead>
<tr>
<th>StudentID</th>
<th>LastName</th>
<th>FirstName</th>
<th>Address</th>
<th>City</th>
</tr>
</thead>
<tbody>
<tr>
<td>101</td>
<td>C</td>
<td>Priya</td>
<td>1, new street</td>
<td>Trichy</td>
</tr>
<tr>
<td>202</td>
<td>S</td>
<td>Ramu</td>
<td>5, North garden St</td>
<td>Madurai</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>StudentID</th>
<th>LastName</th>
<th>FirstName</th>
<th>Address</th>
<th>City</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>StudentID</th>
<th>LastName</th>
<th>FirstName</th>
<th>Address</th>
<th>City</th>
</tr>
</thead>
<tbody>
<tr>
<td>002</td>
<td>Ram</td>
<td>Kumar</td>
<td>ROJA NAGAR</td>
<td>CHENNAI</td>
</tr>
<tr>
<td>003</td>
<td>R</td>
<td>Krishna</td>
<td>Park Street</td>
<td>Coimbatore</td>
</tr>
</tbody>
</table>

Table dropped.

Table not found.
Procedure
1. Start Xampp server (Apache)
2. Goto virtual path folder (C:\xampp\htdocs)
3. Create test.php file and type the program
4. Execute the program on your Web browser using by this URL link (http://localhost/test.php)

PROGRAM
<html>
<body>
<?php
 echo “Welcome to Our School”;
 $color = “blue”;
 echo “My car is “ . $color . “<br>”;
 echo “My dress is “ . $COLOR . “<br>”;
 echo “My box is “ . $coLOR . “<br>”;
 // test whether a number is greater than 30, 20 or 10 using ternary operator
 function trinary_Test($n){
}}
$r = \text{n} > 30$
? “greater than 30”
: ($n > 20$
? “greater than 20”
: ($n > 10$
? “greater than 10”
: “Input a number atleast greater than 10!”));

`echo $n.” $r
;`

}\}

trinary Test(32);
trinary Test(21);
trinary Test(12);
trinary Test(4);
?>
</body>
</html>

**OUTPUT**

Welcome to Our School

My car is blue
My dress is
My box is

32 : greater than 30
21 : greater than 20
12 : greater than 10
4 : Input a number atleast greater than 10!
**PHP–Create & Execute Variables**

**AIM**
To create and execute a PHP Variables Example program

**Procedure**
1. Start Xampp server (Apache)
2. Goto virtual path folder (C:\xampp\htdocs)
3. Create Variable.php file and type the program
4. Execute the program on your Web browser using by this URL link (http://localhost/Variable.php)

**PROGRAM**
```php
<html>
<body>
<?php
$a = 25; // Numerical variable
$b = “Hello”; // String variable
$c = 5.7; // Float variable
echo “Number is : “ . $a . ”<br/>”;
echo “String is : “ . $b . ”<br/>”;
echo “Float value : “ . $c . ”
$txt = “INDIA”;
echo “I love $txt!”;
$x = 2;
$y = 2;
```
echo $x + $y;
function demo() {
    echo «<p>Variable x inside function is: $x</p>»;
}
demo();

echo «<p>Variable x outside function is: $x</p>»;
function myTest() {
    static $a = 0;
    echo $a;
    $a++;
}

myTest();

$> <br>
</body>
<html>

OUTPUT

Number is : 25
String is : Hello
Float value : 5.7
I LOVE INDIA
4
0
1
2
Variable x inside function is:
Variable x outside function is: 2
Create & Execute ECHO and PRINT statements

**AIM**

To create and execute ECHO and PRINT statements in PHP program.

**Procedure**

1. Start Xampp server (Apache)
2. Goto virtual path folder (C:\xampp\htdocs)
3. Create echo-print.php file and type the program
4. Execute the program on your Web browser using by this URL link (http://localhost/echo-print.php)

**PROGRAM**

```php
<html>
<body>
<?php
    //Use Echo
    echo “Welcome to Tamilnadu<br>”;
    // Use ‘print’ to print on console
    print “Welcome to our School!<br>**********”;
    $txt1 = “Learn PHP”;
    $txt2 = “Daily”;
    $x = 5;
    $y = 4;

```
echo "<h2>" . $txt1 . "</h2>";
echo "Study PHP " . $txt2 . "<br>";
echo $x + $y;
$txt3 = "Hello";
$txt4 = "Welcome";
$x = 7;
$y = 3;

print "<h2>" . $txt3 . "</h2>";
print "Hi " . $txt4 . "<br>";
print $x + $y;
?>
</body>
</html>

**OUTPUT**

Welcome to Tamilnadu
Welcome to our School!
***********

**Learn PHP**
Study PHP Daily
9

**HELLO**
Hi Welcome
10
String Functions

**AIM**
To create and execute String Functions in PHP

**Procedure**
1. Start Xampp server (Apache)
2. Goto virtual path folder (C:\xampp\htdocs)
3. Create function.php file and type the program
4. Execute the program on your Web browser using by this URL link

(http://localhost/ function.php)
<html>
<body>
<?php
// Displays the length of the string
echo strlen(“Hello world!”);
// Counting number of words in a String
echo str_word_count(“Good Morning All”);
// Reversing a string
echo strrev(“welcome”);
// calculates position of strong
echo strpos("Hello world!", "world");

// replacing the text
echo str_replace("Hi", "Hello", "Hi Everyone");
define("GREETING", "Good Morning!!!");

echo GREETING;

// changes the color of the first character of a word
$text = 'PHP Tutorial';
$text = preg_replace('/(\b[a-z])/i', '<span style="color:red;">\1</span>', $text);
echo $text;
?>

</body>
</html>

**OUTPUT**

<table>
<thead>
<tr>
<th>12</th>
<th>3</th>
<th>emoclew</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>Hello Everyone</td>
<td>Good Morning!!!</td>
</tr>
<tr>
<td></td>
<td>PHP Tutorial</td>
<td></td>
</tr>
</tbody>
</table>
Converting Word to Digit

**AIM**
Write a PHP program to convert word to digit.

**Procedure**
1. Start Xampp server (Apache)
2. Goto virtual path folder (C:\xampp\htdocs)
3. Create convert.php file and type the program
4. Execute the program on your Web browser using by this URL link

(http://localhost/convert.php)

```php
function word_digit($word) {
    $warr = explode(';', $word);
    $result = "";
    foreach ($warr as $value) {
        switch (trim($value)) {
            case 'zero':
                $result .= '0';
                break;
            case 'one':
                $result .= '1';
                break;
            case 'two':
                $result .= '2';
                break;
            default:
                $result .= trim($value);
                break;
        }
    }
    return $result;
}
```

Converting Word to Digit
```php
$result .= '2';
break;
case 'three':
    $result .= '3';
break;
case 'four':
    $result .= '4';
break;
case 'five':
    $result .= '5';
break;
case 'six':
    $result .= '6';
break;
case 'seven':
    $result .= '7';
break;
case 'eight':
    $result .= '8';
break;
case 'nine':
    $result .= '9';
break;
}
}
return $result;
}

echoword_digit("zero;three;five;six;eight;one")."\n";
echoword_digit("seven;zero;one")."\n";
?>
</body>
</html>

**OUTPUT**
035681
701
REFERENCES

1. COMPUTER NETWORKS FIFTH EDITION ANDREW S. TANENBAUM Vrije Universiteit Amsterdam, The Netherlands DAVID J. WETHERALL University of Washington Seattle, WA

2. DATA AND COMPUTER COMMUNICATIONS Eighth Edition William Stallings


6. DNS Security: Defending the Domain Name System by Allan Liska and Geoffrey Stowe


9. LAN wiring (3rd ed. By Trulove and James, McGraw-Hill Professional


INTERNET RESOURCES

1. https://whois.icann.org/en
2. https://www.iana.org/
5. https://www.tutorialspoint.com/computer_fundamentals/computer_networking.htm
7. https://www.tutorialsweb.com
8. https://opensource.com
Higher Secondary Class XII
Computer Applications - Theory & Practicals
List of Authors and Reviewers

**ADVISER & EXPERT**

**DR. P. KUMAR,**
Joint Director (Syllabus)
State Council of Education Research and Training Tamilnadu
Chennai 600 006

**Domain Experts**

Mrs. P. Bagyalakshmi,
Prof & Head, Dept of computer Applications,
Queen Mary’s College,
Chennai.

Mr. Amuthan,
Professor & Associate Dean (Autonomy & Accreditation),
Dept. of Computer Science & Engineering,
PillaiTechavady, Pudhucherry.

**Reviewers**

Mr. Saravanan,
Vice principal,
Apollo Arts & Science College.
Chennai.

Mr. M. Murali,
Technology Consultant,
Cognizent Technology,
Thuraippakam, Chennai.

**Content Writers**

Mrs. Subashini,
Professor & HOD, Dept of Information Technology,
Sathyabama Institute of Science & Technology,
Chennai.

Mrs. A. Arthi
Associate Professor, Dept. of Information Technology
R. M. K Engineering Collage, Kavaraipet, Thiruvallur.

Mrs. Sandhya Alagarsamy,
Assistant Professor,
Dept. of Information Technology,
Jeeppiaar SRR Engineering College, Chennai.

**Academic Co-ordinator**

U. Aarthi,
B.T. Assistant,
Govt. Girls Higher Secondary School,
Madurantakam,
Kanchipuram

**Book Design (Layout Designing and Illustration)**

Arokiam Felix
BlackBird Designs & Prints
Chennai

**Wrapper Design**

Kathir Arumugam

**Coordination**

Ramesh Munisamy

This book has been printed on 80 G.S.M.
Elegant Maplitho paper.
Printed by offset at: